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Chapter 1: Introduction 
 

Knowledge Tools is part of the Unicenter® Service Desk suite of products from 
CA that offers a complete customer relationship management solution. 
Unicenter Service Desk Knowledge Tools (Knowledge Tools) is a powerful 
knowledge management solution that offers multiple knowledge models, 
tailoring the right solution to the customer effectively and efficiently. It 
enables rapid searches of a dynamic knowledge base to quickly resolve 
customer issues. 

Knowledge Tools Modules 
Knowledge Tools comprises the following modules: 

Knowledge 

The Knowledge tool consists of the following components: 

 Natural Language Search (NLS) permits the use of natural language, 
such as "How do I install a network printer?" to query the knowledge 
base for relevant solutions. It instantly pinpoints candidate solutions, 
ranking them in order of relevance. Since NLS learns from every 
solution captured, it continuously and automatically refines the 
knowledge base.  

 Keyword Search lets you perform a search on words contained in the 
Title, Summary, Problem, and Resolution fields of knowledge 
documents. 

Note: Keyword Search is included as part of the Unicenter Service Desk 
product. To access the full functionality of Knowledge Tools, which focuses 
on managing the entire knowledge lifecycle, you must have a Knowledge 
Tools license. 
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Knowledge Tools Roles 
 

Knowledge Tree Designer 

The Knowledge Tree Designer tool employs rule-based modeling 
functionality that helps the analyst develop and deploy business policies 
and intelligence by mapping any reasoning process into a knowledge tree 
structure. The knowledge tree is perfectly suited to guiding users through 
a logical process such as changing a toner cartridge in a printer or 
changing a hard drive in a server. 

Knowledge Categories 

The Knowledge Categories allow analysts and knowledge engineers to 
manage the content for all of the problem-solving models in the knowledge 
base. They provide a mechanism for building and editing knowledge 
underlying the retrieval tools. Because they include the ability to assign 
ownership of a particular knowledge solution to an expert, they ensure 
that the solution for a given problem is kept current and accurate.  

HTML Editor 

Use the HTML Editor to define the layout and static content of a knowledge 
document template, to define the layout and content of the Resolution 
section of a knowledge document, or to define the layout and content of a 
node in a knowledge tree document. 

Knowledge Report Card 

The Knowledge Report Card provides feedback to analysts, knowledge 
engineers, knowledge managers, supervisors, category owners, and 
system administrators about which knowledge documents are most 
effective. The information provided can be used in a variety of ways to 
improve the processes of creating knowledge documents and providing the 
best support to customers. 

 

Knowledge Tools Roles 
Knowledge Tools is designed for a wide variety of users, from system 
administrators and knowledge managers, who maintain the product to 
customers, who use the system to find solutions to their problems. Although 
one person can fill multiple roles, there are six basic user roles in Knowledge 
Tools: 

Guest 

Guests use an interface that allows access to the Advance Search, Submit 
Knowledge, and Logout links in the main window, and to published 
knowledge documents and knowledge tree documents that have been 
assigned "Grant Public Read Permission."  
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Audience 
 

Customer/Employee 

Customers/Employees have the same permissions as guests.  They can 
also use the Bookmarks tab ("My Bookmarks") and access other 
documents in the knowledge base for which they have permissions. 

Analyst 

Analysts have the same permissions as customers, plus access to 
Preferences, as well as access to the Knowledge Categories link in the 
Search Tools window. In Knowledge Categories, analysts can manage 
documents in the knowledge base for which they have permissions. 

Knowledge Engineer 

Knowledge Engineers have the same permissions as analysts, but can also 
manage categories in the knowledge base for which they have 
permissions. 

Knowledge Manager 

Knowledge Managers have the same permissions as knowledge engineers, 
but can also perform mass deletes of categories or documents and run 
reports. The Knowledge Manager has limited access to the Administration 
tab, where he can access Knowledge Categories and manage search 
terms. 

Administrator 

Administrators have access to all product features, including the full 
functionality of Knowledge Categories. The Administration tab is available 
exclusively to system administrators, and includes knowledge 
management features such as managing the approval process, document 
settings, search and survey settings, knowledge report card settings, and 
more. 

 

Audience 
This guide is intended for the person having overall responsibility for the 
administration of the Knowledge Tools installation (system administrator). It is 
also intended for analysts, knowledge engineers, and knowledge managers, 
who are responsible for managing the documents in the knowledge base. 
Responsibilities for each type of user are described in Knowledge Tools Roles. 
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What You Need to Know 
 

What You Need to Know 
To benefit fully from this guide, you need a working knowledge of the 
operating system and the Windows environment on your installation. You must 
also be familiar with the operation of your web server and be able to perform 
basic administrative tasks.  

 

Getting Help 
Knowledge Tools provides online help that you can access via the Help menu 
of any component. It provides help on the various windows you encounter, in 
addition to step-by-step procedures to help you perform many tasks. 

For further technical assistance with this product, refer to Contact Technical 
Support (see page iii) for information on contacting CA Technical Support. 
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Chapter 2: Managing Your Knowledge 
Base 
 

Managing the knowledge base is the primary task for Knowledge Tools 
analysts and knowledge engineers. Depending upon the structure of your 
organization, one analyst might perform the knowledge engineer and 
administrator functions. The analyst responsible for the knowledge base uses 
the following tools: 

Knowledge Categories 

Knowledge Categories manage the content of the knowledge base, 
including the category structure, knowledge documents and knowledge 
tree documents. 

Migration Tool 

The Migration Tool upgrades a previous version of a Unicenter Service 
Desk Knowledge Tools database to the current version (for example, from 
version 6.0 to 6.5).  

This chapter gives an overview of the knowledge base tasks that you can 
perform using the Knowledge Categories component of Knowledge Tools. 

 

Accessing Knowledge Categories 
To access Knowledge Categories: 

1. Log in to Knowledge Tools as an analyst, knowledge engineer, knowledge 
manager, or administrator. 

2. From the Knowledge tab, choose View, Knowledge Categories. 

OR 

From the Admin tree, choose Knowledge, Knowledge Categories. 
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Working With Categories 
 

Working With Categories 
Knowledge Engineers typically manage categories; however, knowledge 
managers and administrators can also perform this function.  

The left pane of the Knowledge Categories window lists categories and folders 
that organize the knowledge documents and knowledge tree documents in the 
knowledge base. Each document resides in a primary category and may also 
be linked to other related categories. 

You can perform several category functions when creating or managing a 
document in the Document Editor. The Categories tab specifies the primary 
category for the document, links to other categories that are related, and links 
to other related documents. When you build the category structure, you are 
creating the hierarchical structure with which Knowledge Tools users will 
navigate to relevant documents. The primary category is usually the category 
in which the document was created, but any category can be specified as the 
primary category. The primary category is the category from which the 
document inherits its permissions. By working with categories on the 
Categories tab, you can control the categories in which a document appears, 
and which category it inherits permissions from (if applicable). 

When you select a category in left pane, a list of documents in that category 
displays in the right pane (the Document List pane): 
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Working With Categories 
 

You can create documents in the selected category using the Categories menu 
as discussed in Creating Knowledge Documents and Creating Knowledge Tree 
Documents. 

Note: In the Search Tools window, the right pane displays a list of documents 
in the selected category and in all the child categories of the selected 
category. In Knowledge Categories, the Document List only displays 
documents located in the selected category. 

You can perform the following tasks in Knowledge Categories: 

 Find categories and documents with the Advanced Search/Filter 

 Create a knowledge document within a category 

 Create a knowledge tree document within a category 

 Add or modify a category, and delete one or more categories 

 Cut, copy, or paste a category 

 Refresh the Document List  

 Edit document properties in the document list 

 Use preferences to select document attributes that appear in the document 
list 

You can perform these tasks using the commands on the File and View menus, 
or the shortcut menu that displays when you right-click a category. 

 

Creating Categories 

To create a new category: 

1. Choose File, New Category. 

OR 

Right-click on the Categories pane and select New Category from the 
popup menu. 

The Create New Category screen displays. 

2. Enter the Title and Description for the new category. 

3. Use the Keywords text box to specify keywords (separated by commas) for 
the category. When a user performs a category search, these keywords 
are used to match the relevant categories. 

4. Click Save. 

The new category is created.  
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Selecting Permissions for the Category 

You can define specific permissions for the new category or choose for it to 
inherit permissions from its parent category. The default option (Inherit 
Permissions from Parent Category) sets the new category with the same 
permission levels as its parent. If you choose the Specify Category Permissions 
option, you can determine the groups that have read, read/write, or no access 
to that category.  

Note: Occasionally, a user may have permissions for a document, but not for 
the category in which it resides. When the document is opened from 
Knowledge Categories, the Categories and Permissions tabs are disabled. Also, 
because the user would have no permissions for the document, it would not be 
found using a filtered search or within the category tree. 

Editing Categories 

To edit a category: 

1. Highlight the category you want to edit. 

2. Choose File, Edit Category. 

OR 

Right-click on the Categories pane and select Edit Category from the 
popup menu. 

The Update Category screen displays. 

 

3. Make the desired edits and click Save. 

The category changes are stored. 
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Finding Documents 
 

Deleting Categories 

Only knowledge managers and system administrators have access to the 
Delete category function. 

To delete a category: 

1. Highlight the category you want to delete. 

2. Choose File, Delete Category. 

The Delete Category dialog displays. 

 

3. Choose Include Subcategories to delete all subcategories of the selected 
category. 

4. Choose Include Documents to delete all documents contained in the 
selected category. 

5. Click OK. 

A confirmation dialog displays. 

6. Click OK to delete the category or click Cancel to abort the deletion. 
 

Finding Documents 
An important feature of Knowledge Categories is its ability to allow you to 
search the knowledge base for the documents that would be of interest to you. 
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Work with the Document List 
 

Filter Documents 

Another very useful tool is the Filter pane of the Knowledge Categories 
window. By entering your own search criteria in the fields of the Filter pane, 
you can limit the number of documents that appear in the Document List to 
only those that you want to see, and then sort them, if you desire.  

To filter documents: 

1. Enter the desired search criteria in the fields of the Filter pane and click 
Search. 

The Document List populates with the relevant documents.  

2. To open a document, click on the document heading hyperlink or right-
click on the document and choose View.  

 

Work with the Document List 
The right pane of the Knowledge Categories window, called the Knowledge 
Document List pane, lists the documents for the category or folder selected in 
the Category pane. You can modify the information you see in this pane and 
use this pane to work with knowledge documents.  

You can perform the following tasks when working with existing documents in 
the Document List pane:  

 View lists of documents, each represented by a document heading and 
selected document properties  

 View filtered documents  

 Scroll through the documents easily with navigation controls  

 Refresh the document list  

 Open a document  

 Delete a selected document 

 Edit document attributes in the document list 

For more information about how to perform these tasks, see Working with 
Documents.  
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Chapter 3: Working with Documents 
 

Using Knowledge Categories functionality, you can create documents that are 
accessed by your clients.  

 

Creating Knowledge Documents 

 

Analysts and administrators can create knowledge documents based on 
knowledge that has been submitted by outside users through the Submit 
Knowledge feature or by knowledge that they may have obtained from the 
service analysts who support the product.  

Documents can be created from either the Knowledge tab, or from the 
Knowledge Categories screen. You create knowledge documents by navigating 
within the Category pane to the desired location and choosing New Knowledge 
Document from the File menu or from the pop-up menu that appears when 
you right-click on a category. When you do this, the Create New Document 
window appears, prompting you for all the information needed to create a new 
document.  

On the Content tab, you enter the primary information for the document 
including the Title, Summary, Problem, Resolution, and optionally, Notes. After 
you are satisfied with the content of the entry, you can check for spelling 
errors by clicking the Spell Check button.  

Working with Documents  21  
 



Creating Knowledge Documents 
 

Note: The Resolution field can be edited using the HTML Editor (see page 45). 

Misspelled words are highlighted and a list of suggested replacements is 
provided. You may choose to replace the word with one of the suggested 
words or ignore the suggestions and retain the original word. Users with the 
role of Knowledge Engineer or higher have access to the Add button, allowing 
them to add words to a site-specific lexicon (dictionary). This dictionary can 
contain commonly used words at the site so that spell checking does not treat 
these defined terms as spelling errors.  

You can add words to the userdct.tlx lexicon, which is added to the 
<NX_ROOT>/site/mods/lexicons directory after Service Desk has been 
configured. You can also add words to the lexicon in batch mode. This is useful 
if you need to add a large number of words. Any text editor can be used to 
create a file containing the words that are acceptable for this site. The file 
must have one alphanumeric word per line without any additional lines or text. 
To add the word list to the lexicon, run the pdm_lexutil utility against the file. 
The utility updates the desired lexicons and the words are immediately 
available for spell checking. Usage information for the utility is available by 
typing pdm_lexutil-h from the command prompt, as illustrated by the 
following:  

c:\> pdm_lexutil -h  
Utility to modify Service Desk lexicons  
Usage: pdm_lexutil -a (to add words ) | -d (to delete words )  
[ -f <file/lexicon containing list of words to be added/deleted> ]  
[ -l <lexicon name> ] (defaults to userdict.tlx)  
[ -h | ? ] (shows this usage information)  
[ <wordlist> ] (word(s) to be added deleted)  

Once you save the document by clicking Create, the remaining tabs become 
enabled so that you can define other aspects of the document. Also, the 
buttons in the window change to include the Publish button so you can publish 
the document immediately.  

The sample document has been assigned an ID, is now in the “Create 
Knowledge Document” stage of the workflow and has a status of “Draft”. The 
next step is to add attributes and other information.  

 

Adding Attributes 

On the Attributes tab, several fields are pre-filled. You can assign a new 
subject expert and/or owner to the document, along with the date the 
document is to become available in the knowledge base, and the date on 
which you want it to expire.  
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Color Palette 

The Color Palette opens when you do any of the following: 

 Click the  Font Color button in the HTML Editor 

 Click the  Background Color button in the HTML Editor 

 Click the Background, FG Color, or Border button on the Table Properties 
dialog or the Cell Properties dialog 

Use the Color Palette to select a color for the component whose attributes you 
are currently defining. To select a color, click it in the Color Palette. When you 
select a color, the Color Palette closes and the HTML Editor refreshes to reflect 
your selection. 

 

Managing Comments 

On the Comments tab, you can add comments for the document. Customers 
and analysts can also enter comments in the Comment box that appears when 
a document is opened. The Comments tab also allows you to delete comments 
that are logged for the document.  

 

Managing Categories 

Using the Categories tab, you can link or associate the document with multiple 
categories (in addition to the primary category) and/or other documents. This 
allows a document to be classified under many different applicable categories 
and can result in a more successful search. You can also specify the primary 
category.  

 

Viewing History 

Use the History tab to view all events affecting the current document. For each 
event, the details of the event and the date and time at which the event 
occurred are listed. A filter is included on the History tab, which allows you to 
specify criteria for the type of events you want to display. 
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Forwarding and Publishing a Document 
 

Forwarding and Publishing a Document 
When you finish adding information to a document, save it to the knowledge 
base, then publish or forward it to the next owner (depending on the next step 
defined in the workflow template for the document). Note that a system 
administrator can publish a document at any step in the workflow process. See 
the “Understanding Workflow” chapter for more information about the 
workflow process. 

Managing Attachments 
Use the Attachments tab to manage file and URL attachments in the current 
document. In documents created using the default Built-In Knowledge 
Document or Built-In Knowledge Tree template, links to attachments display 
under the "Attachments" heading. 

Note: Only the Attachment tab displays for published documents. For 
unpublished documents, the Attachment tab displays Repositories, Files, and 
Attachments panes. 

This tab contains the following fields: 

Repositories 

Displays a tree structure that contains the repositories and folders defined 
for the attachment library. Click _ _  to expand a repository; click _ to 
open folders in the repository. To view the contents of a folder in the Files 
list, click the folder or folder name. 

Files 

Displays a list of the files uploaded to the folder selected in the 
Repositories list. 

Attachments  

Search for attachments using any of the fields provided. The Status field 
refers to the disposition of the attachment. The list displays the list of 
retrieved attachment files and URLs. To view the attached file or the 
destination of a URL, click it in the Attachments list. You can right-click an 
individual attachment to display a context menu that allows you to:  

 View Details - Opens the View Attachments window. The field 
Attached To, at the bottom of this window, shows the documents this 
file/URL is attached to. This is provided as a link - to either the 
Documents Link List (KT), or to a record link, like a Request or Issue 
(SD). 

 Edit Details - Opens the Edit Attachment window, allowing you to edit 
the Name and Description for the attachment, and view other specific 
details. 
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Creating Knowledge Tree Documents 
 

 View Content - Allows you to view the file contents. 

This window can be displayed by Administrators from the Administration 
tab, by selecting Attachments Library, Attachments. 

This tab contains the following button: 

Add URL Link 

Adds the URL defined in the Add URL Link box to the current document. 
 

Creating Knowledge Tree Documents 
To create a knowledge tree document, navigate the Category Pane to the 
location where you want the knowledge tree document to reside, then choose 
Create Knowledge Tree Document from the Categories menu, or from the File 
menu on the Knowledge tab. The Knowledge Tree Document Editor window 
opens: 

 

Complete the fields on the Knowledge Tree Document Editor Content tab, then 
save the changes to enable the Design Tree button. Click the Design Tree 
button to open the Knowledge Tree Designer window. This is the visual tool 
used to design your knowledge tree. See the “Creating Knowledge Trees” 
chapter for information about designing knowledge trees. 

When you finish, save and forward or publish the knowledge tree document as 
described in the previous section. 
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Modifying Documents 
A knowledge document that has not yet been published is modified through 
the normal workflow process. By default, the creator of the document modifies 
the document using the Document Editor, until he publishes the document. In 
a custom workflow process, the owners for the tasks in the workflow or 
anyone with full (read/write) permissions can modify the document. 

When a knowledge document or knowledge tree document is published, you 
are normally not permitted to modify the document. The document must be 
unpublished first, and then modifications can be made. 

A published document can be modified if the administrative setting on the 
Workflow Settings page has been set, and if the user has the permissions to 
do so (if you are part of a group that has write access to the document). In 
this case, when opened from the Document List, the Document Editor window 
is invoked, permitting you to change the information on any tab. Click Save to 
save your changes. 

 

Windows 
 

The HTML Editor includes a number of windows and dialogs to help you design 
the layout and static content of document templates and create documents. 
Windows and dialogs open when you click a button in the toolbar or on 
another window or dialog or when you select a command from a menu or 
shortcut menu. 

Images Library 

The Images Library opens when you click From Library on the Insert Image 
window. 

Use the Attachment Selection window to select a .bmp, .gif, .jpg, or .png file 
to insert in a document template. 

This window contains the following fields: 

Repositories 

Displays a tree structure that contains the repositories and folders defined 

for the attachment library. Click    to expand a repository; click  to 
open folders in the repository. To view the contents of a folder in the Files 
list, click the folder or folder name. 
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Files 

Displays a list of the files uploaded to the folder selected in the 
Repositories list. When you select the file to insert, the Attachment 
Selection window closes and the file's URL displays in the Image URL box 
on the Insert Image window. 

Cell Properties dialog 

The Cell Properties dialog opens when you put the cursor in a table cell and 
select Cell Properties from the Table menu in the HTML Editor. 

Use the Cell Properties dialog to define attributes that affect the layout and 
style of the current table cell. 

This dialog contains the following fields: 

Width 

Defines the width of the selected cell. Enter a whole number in the box, 
then select a unit of measurement (for example, Pixels) from the list. 

Text Align 

Specifies the horizontal alignment of data and text in the selected table or 
cell. Select one of the following values: 

Left 

Aligns text and data to the left. 

Center 

Aligns text and data to the center. 

Right 

Aligns text and data to the right. 

Justify 

Aligns text to both the left and right. 

Default: Left. 

Height 

Defines the height of the selected table or cell. Enter a whole number in 
the box, then select a unit of measurement (for example, Pixels) from the 
list. 

Vertical Align 

Specifies the vertical alignment of data and text in the table or cell. Select 
one of the following values: 

Top 

Aligns text and data to the top. 
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Middle 

Aligns text and data to the center. 

Bottom 

Aligns text and data to the bottom. 

Baseline 

Aligns text so that the first line in each cell of a row rests on a baseline 
common to all cells in that row. The baseline is the imaginary line on 
which a line of text rests. 

Default: Top. 

Background 

Opens the Color Palette so you can select a color to apply to the 
background of the selected table or cell. When you select a color, the 
button refreshes to display it. Click  to reset the control so that no color 
is selected. 

Default: No color selected. 

Image URL 

Defines the location of an image to use as the background for the selected 
table or cell. You can use .bmp, .gif, .jpg, or .png images. 

Example: \\c:\images\trees.png 

FG Color 

Opens the Color Palette so you can select a color to apply to items in the 
foreground of the selected table or cell (for example, text and data). When 
you select a color, the button refreshes to display it. Click  to reset the 
control so that no color is selected. 

Default: No color selected. 

Border 

Opens the Color Palette so you can select a color to apply to the borders of 
the selected table or cell. When you select a color, the button refreshes to 
display it. Click  to reset the control so that no color is selected. 

Default: No color selected. 

Border Style 

Specifies the style used to draw a border around the selected table or cell. 
Select one of the following options: 

None 

Renders the selection with no border. 

Dotted 
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Renders the selection with a dotted border. Define a width (in pixels) 
for the border in the box provided. 

Example:  

Dashed 

Renders the selection with a dashed border. Define a width (in pixels) 
for the border in the box provided. 

Example:  

Solid 

Renders the selection with a solid border. Define a width (in pixels) for 
the border in the box provided. 

Example:  

Double 

Renders the selection with a double solid border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Groove 

Renders the selection with a 3D grooved border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Ridge 

Renders the selection with a 3D ridged border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Inset 

Renders the selection with a 3D inset border. Define a width (in pixels) 
for the border in the box provided. 

Example:  

Outset 

Renders the selection with a 3D outset border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Default: None. 
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This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Saves the changes and closes the window or dialog. 
 

Create a Change Order Link window 

The Create a Change Order Link window opens when you select New Change 
Order Link from the Insert menu in the HTML Editor. 

Use the Create a Change Order Link window to insert a link in the document or 
template that creates a change order when a user clicks it. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Link Text 

Defines the text of the change order link. When a user clicks the link at 
runtime, the Create New Change window opens so the user can define a 
new change order. 

Create Change Order Options 

Specifies whether to create a blank change order or use a specific 
template to create it. Select one of the following options: 

An Empty Change Order 

Specifies that the product should create a blank change order. 

Change Order Using the Template 

Specifies that the product should create a change order based on 
values set in the specified template. Click  to open the Change Order 
Template Search window so you can locate and select the appropriate 
template. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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Create a Ticket Link window 

The Create a Ticket Link window opens when you select New Ticket Link from 
the Insert menu in the HTML Editor. 

Use the Create a Ticket Link window to insert a link in the document or 
template that creates an issue or request when a user clicks it. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Link Text 

Defines the text of the ticket link. When a user clicks the link at runtime, a 
Create New window opens so you can define a new issue or request. 

Create Request Options 

Specifies whether to create a request based on the current document's 
properties and whether to use a specific template for the request when a 
user whose preferred ticket type is request clicks the link. Select one of 
the following options: 

The Document Values 

Specifies that the product should create requests based on the values 
set in the current document. 

The Template 

Specifies that the product should create requests based on the 
specified template. Click  to open the Request Template Search 
window so you can locate and select the appropriate template. 

Create Issue Options 

Specifies whether to create an issue based on the current document's 
properties and whether to base the issue on a specific template when a 
user whose preferred ticket type is issue clicks the link. Select one of the 
following options: 

The Document Values 

Specifies that the product should create issues based on the values set 
in the current document. 

The Template 

Specifies that the product should create issues based on the specified 
template. Click  to open the Issue Template Search window so you 
can locate and select the appropriate template. 

Working with Documents  31  
 



Windows 
 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 

 

Explorer User Prompt dialog (merge cells) 

The Explorer User Prompt dialog opens when you put the cursor in a table cell 
and select Merge Cell from the Table menu in the HTML Editor. Use the dialog 
to define the number of cells to combine. 

This dialog contains the following field: 

How many columns would you like to merge? 

Defines how many columns to combine. 

Example: If you enter 3, the selected column is combined with the two 
columns immediately to its right. The resulting column occupies the same 
amount of space as the original columns. 

Default: 2. 

This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Closes the dialog and opens a second Explorer User Prompt dialog so you 
can define the number of rows to combine. 

Explorer User Prompt dialog (merge rows) 

The Explorer User Prompt dialog opens after you do all of the following: 

 Put the cursor in a table cell and select Merge Cell from the Table menu in 
the HTML Editor 

 Enter a number of columns to merge in the field provided on the Explorer 
User Prompt dialog 

 Click OK 

Use the dialog to define the number of rows to combine. 
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This dialog contains the following field: 

How many rows would you like to merge? 

Defines how many rows to combine. 

Example: If you enter 3, the selected row is combined with the two rows 
immediately below it. The resulting row occupies the same amount of 
space as the original rows. 

Default: 2. 

This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Closes the dialog and merges the defined columns and rows. 
 

Insert Document Link window 

The Insert Document Link window opens when you select Document Link from 
the Insert menu in the HTML Editor. 

Use the insert Document Link window to select a document from the 
knowledge base to link to the document you are editing. When you link a 
document, its title displays in the document or template you are editing. 

This window contains the following fields: 

Categories 

Lists the category and subcategory hierarchy currently defined in the 
knowledge base. Click  or  as necessary to expand or collapse branches 
of the tree. When you select a category from the list, its associated 
documents display in the Documents list. 

To link a category to a document, right-click the row and select Link 
Category from the shortcut menu. 

Documents 

Displays the ID and title of each document in the category selected from 
the Categories list. To link a document in the list with the current 
document, click its ID. 
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Insert/Modify Link dialog 

The Insert/Modify Link dialog opens when you select URL Link from the Insert 
menu in the HTML Editor. 

Use the Insert/Modify Link dialog to define a URL to insert as a hyperlink at 
the current cursor position or to change an existing hyperlink in the document 
or template you are editing. 

 To associate the URL with text in the document or template, select the text 
before you open the Insert/Modify Link dialog. 

 To insert the URL itself as a hyperlink in the document or template, place 
the cursor at the appropriate position before you open the Insert/Modify 
Link dialog. 

You can also define a tool tip for the link and specify a target window in which 
the linked information will open at runtime. 

This dialog contains the following fields: 

URL 

Defines the Web address to link. 

Example: http://www.ca.com. 

Title (tooltip) 

Defines descriptive text that browsers may display as a tool tip when a 
user points to the link. 

Target 

Specifies the frame in which to open the linked information. Select one of 
the following values: 

None (use implicit) 

The linked information opens in the default frame (usually the frame in 
which the link resides). 

New Window (_blank) 

The linked information opens in a new, unnamed frame. 

Same Frame (_self) 

The linked information opens in the same frame as the link (that is, 
the linked information replaces the information containing the link). 

Top Frame (_top) 

The linked information opens in the full, original frame. If the frame 
containing the link has no parent, selecting Top Frame (_top) has the 
same effect as selecting Same Frame (_self). 
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Other 

Displays a secondary field to the right of the Target list so you can 
enter the name of the frame in which the linked information should 
open. The linked information opens in the named frame. 

Default: None (use implicit). 

This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Saves the changes and closes the window or dialog. 
 

Insert Image dialog 

The Insert Image dialog opens when you select Image from the Insert menu in 
the HTML Editor. 

Use the Insert Image dialog to define the URL of a graphic to add to the 
document or template or to select a graphic from the Attachment Library. You 
can also use the Insert Image dialog to specify image properties such as 
alignment, size, and the amount of blank space around the image. 

This dialog contains the following fields: 

Image URL 

Defines the location at which the image to insert resides. You can use 
.bmp, .gif, .jpg, or .png images. 

Example: \\c:\images\trees.png 

Alternate Text 

Defines a text string to display if the web browser cannot display images. 

Alignment 

Specifies the alignment of the image in the document or template. Select 
one of the following values: 

Not set 

Uses the web browser's default alignment to display the item. 

Left 

Aligns the item to the left, with adjacent text flowing to the right of the 
item. 

Right 

Aligns the item to the right, with adjacent text flowing to the left of the 
item. 
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Texttop 

Aligns the top of the item with the top of the tallest character in the 
current line of text. 

Absmiddle 

Aligns the middle of the item with the middle of the characters in the 
current line of text. 

Baseline 

Aligns the bottom of the item with the baseline of the current line of 
text. 

Absbottom 

Aligns the bottom of the item with the bottom of the lowest character 
(for example, a lowercase q) in the current line of text. 

Bottom 

Aligns text in the same paragraph at the bottom of the item. 

Middle 

Aligns text in the same paragraph at the center of the item. 

Top 

Aligns text in the same paragraph at the top of the item. 

Note: Alignment may differ slightly depending upon the web browser 
used, regardless of the Alignment box setting. 

Border Thickness 

Defines the width (in pixels) of the border around the image. 

Horizontal 

Defines the amount of blank space (in pixels) to leave to the left and right 
of the image. 

Vertical 

Defines the amount of blank space (in pixels) to leave above and below 
the image. 

Image Preview 

Displays the currently selected image file when you click Preview. 

This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 
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From Library 

Opens the Attachment Selection window so you can select a .bmp, .gif, 
.jpg, or .png file to insert from the Attachment Library. 

OK 

Saves the changes and closes the window or dialog. 

Preview 

Displays the image file defined in the Image URL box in the Image Preview 
box. 

 

Insert Table dialog 

The Insert Table dialog opens when you select Insert Table from the Table 
menu in the HTML Editor. 

Use the Insert Table dialog to define attributes of a table to add at the current 
cursor position in the document or template. 

This dialog contains the following fields: 

Rows 

Defines the number of horizontal rows with which to create the table. 

Default: 2. 

Cols 

Defines the number of vertical columns with which to create the table. 

Default: 4. 

Width 

Defines the total width of the table. Enter a whole number in the box, then 
select a unit of measurement (for example, Pixels) from the list. 

Default: 100 Percent. 

Alignment 

Specifies the horizontal position of the table in the document or template. 
The Alignment setting does not affect the data in the table cells. Select 
one of the following values: 

Not set 

Uses the web browser's default alignment to display the item. 

Left 

Aligns the item to the left, with adjacent text flowing to the right of the 
item. 
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Right 

Aligns the item to the right, with adjacent text flowing to the left of the 
item. 

Texttop 

Aligns the top of the item with the top of the tallest character in the 
current line of text. 

Absmiddle 

Aligns the middle of the item with the middle of the characters in the 
current line of text. 

Baseline 

Aligns the bottom of the item with the baseline of the current line of 
text. 

Absbottom 

Aligns the bottom of the item with the bottom of the lowest character 
(for example, a lowercase q) in the current line of text. 

Bottom 

Aligns text in the same paragraph at the bottom of the item. 

Middle 

Aligns text in the same paragraph at the center of the item. 

Top 

Aligns text in the same paragraph at the top of the item. 

Note: Alignment may differ slightly depending upon the web browser 
used, regardless of the Alignment box setting. 

Border Thickness 

Defines the width (in pixels) of the frame around the table and the rules 
between cells. For a table with no frame or rules, set this value to 0. 

Default: 1. 

Cell Spacing 

Defines how much space (in pixels) browsers should leave between the 
table and surrounding items. This value also defines the amount of space 
to leave between cells in the table. 

Default: 1. 

Cell Padding 

Defines how much space (in pixels) browsers should leave between the 
borders of a cell and its contents. 

Default: 1. 
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This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Saves the changes and closes the window or dialog. 

Table Properties dialog 

The Table Properties dialog opens when you put the cursor in a table cell and 
select Table Properties from the Table menu in the HTML Editor. 

Use the Table Properties dialog to define attributes that affect the layout and 
style of the entire table. 

This dialog contains the following fields: 

Caption 

Defines a brief description of the table. By default, the caption displays 
above the table at runtime. 

Summary 

Defines a text summary of the table's purpose, content, and layout to 
provide accessibility in nonvisual web browsers. 

Float 

Specifies the horizontal placement of the table relative to the left or right 
margins of the containing element, allowing text to wrap around the table 
when the table does not use the entire width of a page. Select one of the 
following values: 

None 

Positions the table according to the default alignment (typically to the 
left) but does not wrap text around the table. 

Left 

Positions the table to the left margin. When the table does not use the 
entire width of a page, text wraps to the right of the table. 

Right 

Positions the table to the right margin. When the table does not use 
the entire width of a page, text wraps to the left of the table. 

Default: None. 
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Width 

Defines the total width of the table. Enter a whole number in the box, then 
select a unit of measurement (for example, Pixels) from the list. 

Default: 100 Percent. 

Text Align 

Specifies the horizontal alignment of data and text in the selected table or 
cell. Select one of the following values: 

Left 

Aligns text and data to the left. 

Center 

Aligns text and data to the center. 

Right 

Aligns text and data to the right. 

Justify 

Aligns text to both the left and right. 

Default: Left. 

Height 

Defines the height of the selected table or cell. Enter a whole number in 
the box, then select a unit of measurement (for example, Pixels) from the 
list. 

Vertical Align 

Specifies the vertical alignment of data and text in the table or cell. Select 
one of the following values: 

Top 

Aligns text and data to the top. 

Middle 

Aligns text and data to the center. 

Bottom 

Aligns text and data to the bottom. 

Baseline 

Aligns text so that the first line in each cell of a row rests on a baseline 
common to all cells in that row. The baseline is the imaginary line on 
which a line of text rests. 

Default: Top. 
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Spacing 

Defines how much space (in pixels) browsers should leave between the 
table and surrounding items. This value also defines the amount of space 
to leave between cells in the table. 

Default: 1. 

Padding 

Defines how much space (in pixels) browsers should leave between the 
borders of a cell and its contents. 

Default: 1. 

Borders 

Defines the width (in pixels) of the frame around the table and the rules 
between cells. For a table with no frame or rules, set this value to 0. 

Default: 1. 

Frames 

Specifies the sides of the table on which to draw rules. Select one of the 
following options: 

No Sides 

Renders the table with no frame. 

The Top Side Only 

Renders the table with a rule across the top edge. 

The Bottom Side Only 

Renders the table with a rule across the bottom edge. 

The Top and Bottom Sides Only 

Renders the table with rules across the top and bottom edges. 

The Right and Left Sides Only 

Renders the table with rules on the left and right edges. 

The Left-hand Side Only 

Renders the table with a rule on the left edge only. 

The Right-hand Side Only 

Renders the table with a rule on the right edge only. 

All Four Sides 

Renders the table with a frame surrounding it. 

Default: No Sides. 
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Rules 

Specifies whether to draw rules between columns and rows in the table. 
Select one of the following options: 

No Rules 

Renders the table with no rules separating its cells. 

Rules will Appear Between Rows Only 

Renders the table with a horizontal rule separating each row. 

Rules will Appear Between Columns Only 

Renders the table with a vertical rule separating each column. 

Rules will Appear Between All Rows and Columns 

Renders the table with horizontal and vertical rules separating each 
cell. 

Default: No Rules. 

Background 

Opens the Color Palette so you can select a color to apply to the 
background of the selected table or cell. When you select a color, the 
button refreshes to display it. Click  to reset the control so that no color 
is selected. 

Default: No color selected. 

Image URL 

Defines the location of an image to use as the background for the selected 
table or cell. You can use .bmp, .gif, .jpg, or .png images. 

Example: \\c:\images\trees.png 

FG Color 

Opens the Color Palette so you can select a color to apply to items in the 
foreground of the selected table or cell (for example, text and data). When 
you select a color, the button refreshes to display it. Click  to reset the 
control so that no color is selected. 

Default: No color selected. 

Border 

Opens the Color Palette so you can select a color to apply to the borders of 
the selected table or cell. When you select a color, the button refreshes to 
display it. Click  to reset the control so that no color is selected. 

Default: No color selected. 

Border Style 

Specifies the style used to draw a border around the selected table or cell. 
Select one of the following options: 
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None 

Renders the selection with no border. 

Dotted 

Renders the selection with a dotted border. Define a width (in pixels) 
for the border in the box provided. 

Example:  

Dashed 

Renders the selection with a dashed border. Define a width (in pixels) 
for the border in the box provided. 

Example:  

Solid 

Renders the selection with a solid border. Define a width (in pixels) for 
the border in the box provided. 

Example:  

Double 

Renders the selection with a double solid border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Groove 

Renders the selection with a 3D grooved border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Ridge 

Renders the selection with a 3D ridged border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Inset 

Renders the selection with a 3D inset border. Define a width (in pixels) 
for the border in the box provided. 

Example:  

Outset 

Renders the selection with a 3D outset border. Define a width (in 
pixels) for the border in the box provided. 

Example:  

Default: None. 
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Collapsed Borders 

Checking this box removes the cell and table borders from the table. 

Default: Not selected. 

This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Saves the changes and closes the window or dialog. 
 

Previewing Documents 
To see how a document will appear to an end user, click the User View button 
in the Document Editor window . The User View window is opened, and the 
document displays in the format set by its document template: 

 

This is how the document will be displayed to an end user, based on the 
document template. From this screen, you can also edit and print the 
document, as well as record a comment and submit responses to a solution 
survey. 
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The HTML Editor opens when you do any of the following: 

 Click Edit Detail on either of the following windows: 

– Create New Document Template 

– Update Document Template 

 Click Edit Resolution on either of the following: 

– Create New Document 

– Update Knowledge Document 

 Click Edit xxx (HTML) in any of the following DT Builder panes: 

– Conclusion Text (HTML) 

– Query Text (HTML) 

– Tree Description (HTML) 

Use the HTML Editor to define the layout and static content of a knowledge 
document template, to define the layout and content of the Resolution section 
of a knowledge document, or to define the layout and content of a node in a 
knowledge tree document. When you finish editing, click OK to close the HTML 
Editor and return to the originating window so you can preview or save your 
work. 

This window contains the following tabs: 

Design 

Displays content in WYSIWYG (what you see is what you get) fashion so 
changes made using the toolbar buttons and menu commands are 
immediately visible in the editor. 

Source 

Displays content as HTML code that you can edit directly. This gives you 
more precise control over the appearance of the content, and lets you 
make specific changes that may not be possible on the Design tab. 

The menu bar at the top of the HTML Editor contains the following menus: 

 Edit (see page 48) 

 Format (see page 48) 

 Insert (see page 49) 

 Table (see page 50) 
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The HTML Editor also includes a shortcut menu (see page Error! Bookmark 
not defined.) that opens when you right-click in the editing area of the 
Design tab. 

The HTML Editor toolbar contains the following controls: 

 Font 

Specifies a font (for example, Arial or Courier) to apply to selected text. 

Default: Times New Roman. 

 Size 

Specifies a font size from 1 (the smallest) to 7 (the largest) to apply to 
selected text. 

Default: 3 (12 pt). 

 Paragraph 

Specifies a paragraph style (for example, Heading1 or Normal) to apply to 
selected text. 

Default: Normal. 

 Bold 

Renders the selected text in a bold weight font. 

 Italic 

Renders the selected text in an italic font. 

 Underline 

Renders the selected text with a line beneath it. 

 Strikethrough 

Renders the selected text with a line through it. 

 Font Color 

Opens the Color Palette so you can select a color to apply to selected text. 

 Background Color 

Opens the Color Palette so you can select a color to apply to the 
background of the document or template. 

 Justify Left 

Aligns the selected text to the left. 

 Justify Center 

Centers the selected text. 
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 Justify Right 

Aligns the selected text to the right. 

 Ordered List 

Formats the selected text as an ordered (that is, sequentially numbered) 
list. 

 Bulleted List 

Formats the selected text as an unordered (that is, bulleted) list. 

 Decrease Indent 

Moves the selected text one tab level to the left. 

 Increase Indent 

Moves the selected text one tab level to the right. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Saves the changes and closes the window or dialog. 
 

Menus 
 

The menu bar at the top of the HTML Editor contains the following menus: 

 Edit 

 Format 

 Insert 

 Table 

The HTML Editor also includes a shortcut menu that opens when you right-click 
in the editing area of the Design tab. 
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Edit menu 

Use the commands on the Edit menu in the HTML Editor to copy or move a 
selection in the Design or Source tab or to undo or redo your last action. 

Important: Do not add any HTML tags above the Body tag, because it will 
cause a runtime error. 

This menu contains one or more of the following commands: 

Cut 

Removes the selected text or image from the document or template and 
puts it on the Clipboard. 

Copy 

Puts a copy of the selected text or image on the Clipboard. Copying does 
not remove the selection from the document or template. 

Paste 

Puts text or an image copied or cut to the Clipboard at the current cursor 
location in the document or template. 

Undo 

Reverses the previous action. 

Redo 

Reverses the previous Undo action. The Redo command only works if your 
previous action was to select the Undo command. 

 
 

Format menu 

Use the commands on the Format menu in the HTML Editor to apply specific 
formatting to the text selected in the Design tab. 

This menu contains one or more of the following commands: 

Subscript 

Renders the selected text slightly below the current baseline. 

Superscript 

Renders the selected text slightly above the current baseline. 

Justify Left 

Aligns the selected text to the left. 
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Justify Center 

Centers the selected text. 

Justify Right 

Aligns the selected text to the right. 

Justify Full 

Aligns the selected text to the right and left. 

Direction Left to Right 

Defines the base direction of selected text as left-to-right. 

Direction Right to Left 

Defines the base direction of selected text as right-to-left. 
 

Insert menu 

Use the commands on the Insert menu in the HTML Editor to insert links, 
images, horizontal rules, and so on into the document or template. 

Important: Do not add any HTML tags above the Body tag, because it will 
cause a runtime error. 

This menu contains one or more of the following commands: 

New Line 

Adds a line to the document or template and places the cursor in it. 

Horizontal Rule 

Inserts a horizontal rule at the current cursor position. 

URL Link 

Opens the Insert/Modify Link dialog so you can associate a linked URL with 
selected text. If you do not select text, the HTML Editor inserts the actual 
URL you specify at the current cursor position. 

Image 

Opens the Insert Image dialog so you can add a .gif, .jpg, or .png graphic 
at the current cursor position. 

Document Link 

Opens the Insert Document Link window so you can associate a linked 
document with selected text. If you do not select text, the HTML Editor 
inserts a link to the selected document at the current cursor position. 
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New Ticket Link 

Opens the Create a Ticket Link window so you can insert a link in the 
document or template that creates an issue or request when a user clicks 
it. 

New Change Order Link 

Opens the Create a Change Order Link window so you can insert a link in 
the document or template that creates a change order when a user clicks 
it. 

 

Table menu 

Use the commands on the Table menu in the HTML Editor to create and 
manage the rows, columns, and cells in a table in the document or template. 

This menu contains one or more of the following commands: 

Insert Table 

Opens the Insert Table dialog so you can define the attributes of a table to 
insert at the current cursor position. 

Table Properties 

Opens the Table Properties dialog so you can define attributes that affect 
the entire table. 

Insert Row Above 

Inserts a new row above the currently selected row in a table. The new 
row has the same attributes as the selected row. 

Insert Row Below 

Inserts a new row below the currently selected row in a table. The new 
row has the same attributes as the selected row. 

Delete Row 

Deletes the currently selected row and its content from the table. 

Split Row 

Divides the selected row into two rows at the current cursor position. 

Insert Column Above 

Inserts a new column to the left of the currently selected column in a 
table. The new column has the same attributes as the selected column. 

Insert Column Below 

Inserts a new column to the right of the currently selected column in a 
table. The new column has the same attributes as the selected column. 
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Delete Column 

Deletes the currently selected column and its content from the table. 

Split Column 

Divides the selected column into two columns at the current cursor 
position. 

Insert Cell Above 

Inserts a new cell to the left of the currently selected cell in a table and 
moves subsequent existing cells in the same row to the right. 

Insert Cell Below 

Inserts a new cell to the right of the currently selected cell in a table and 
moves subsequent existing cells in the same row to the right. 

Delete Cell 

Deletes the currently selected cell and its content from the table and 
moves subsequent existing cells in the same row to the left. 

Split Cell 

Divides the selected cell into two cells at the current cursor position. 

Merge Cell 

Opens Explorer User Prompt dialogs so you can specify the number of cells 
and rows to merge. 

Cell Properties 

Opens the Cell Properties dialog so you can define attributes that affect 
the currently selected cell in a table. 

 

HTML Editor shortcut menu 

The HTML Editor shortcut menu opens when you right-click an element in the 
HTML Editor and the editor is in WYSIWYG mode. The commands displayed 
depend on the element you select. 

Important: Do not add any HTML tags above the Body tag, because it will 
cause a runtime error. 

This menu contains one or more of the following commands: 

Undo 

Reverses the previous action. 

Cut 

Removes the selected text or image from the document or template and 
puts it on the Clipboard. 
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Copy 

Puts a copy of the selected text or image on the Clipboard. Copying does 
not remove the selection from the document or template. 

Paste 

Puts text or an image copied or cut to the Clipboard at the current cursor 
location in the document or template. 

Delete 

Deletes the selected element from the Design tab in the HTML Editor. 

Select All 

Selects all elements on the Design tab in the HTML Editor. 
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Chapter 5: Document Tree Builder 
 

The Document Tree Builder (DT Builder) is a visual tool for designing and 
building knowledge tree documents for inclusion in a knowledge base. A 
knowledge tree is a representation of expert knowledge in a particular area. 
Each tree is constructed to guide the user through the process of resolving a 
problem, performing a procedure, or achieving a specified goal. 

You can use DT Builder to: 

 Add, delete, rename, copy, cut, and paste decision nodes in a hierarchical 
tree structure 

 Use plain text or the HTML Editor to design query nodes that pose 
questions, supply possible answers to questions, or serve as parent nodes 
for further subnodes in the tree 

 Use plain text or the HTML Editor to design conclusion nodes to supply the 
final answer to a query or to end a procedure 

 Link jump nodes to previously defined nodes in a procedure or query 

 Check for and correct errors in the decision tree logic 

 View node layout as it will display at runtime 
 

Windows 
The DT Builder includes a number of windows and dialogs to help you create 
and edit knowledge trees. Windows and dialogs open when you click a button 
on a pane or on another window or dialog or when you select a command from 
a menu or shortcut menu. 
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Menus 
The menu bar at the top of the right pane of the DT Builder window provides 
access to features with which you can build and edit knowledge trees. 

The menu bar contains the following menus: 

 Tree  

 Node Actions 

 Edit 

 Options 

 View 

 Window 

 Help 

In addition to the menus listed above, the Tree pane shortcut menu in the DT 
Builder opens when you right-click a branch in the tree. 

 

Tree menu 

The commands on the Tree menu let you check for errors, save changes to a 
knowledge tree, and close the DT Builder window. 

This menu contains one or more of the following commands: 

Save and Close 

Saves changes made to the knowledge tree since you last saved it and 
closes the DT Builder window. This command is also available on the 
toolbar. 

Save 

Saves changes made to the knowledge tree since you last saved it, but 
does not close the DT Builder window. This command is also available on 
the toolbar. 

Check Errors 

Checks the knowledge tree for errors, and (if errors exist) displays them in 
the Results of Error Check pane. This command is also available on the 
shortcut menu that opens when you right-click a node in the Tree pane. 

Exit 

Prompts you to save your changes, then closes the DT Builder window. 
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Node Actions menu 

The commands on the Node Actions menu let you add, rename, and delete 
nodes in the knowledge tree. 

This menu contains one or more of the following commands: 

Add Query 

Adds a query node to the query node currently selected in the Tree pane. 
You cannot add a query node to the primary node, a conclusion node, or a 
jump node. This command is also available on the toolbar and on the 
shortcut menu that opens when you right-click a node in the Tree pane. 

Add Conclusion 

Adds a conclusion node to the query node currently selected in the Tree 
pane. You cannot add a conclusion node to the primary node, a conclusion 
node, or a jump node. This command is also available on the toolbar and 
on the shortcut menu that opens when you right-click a node in the Tree 
pane. 

Add Jump 

Adds a jump node to the query node currently selected in the Tree pane. 
You cannot add a jump node to the primary node, a conclusion node, or a 
jump node. This command is also available on the toolbar and on the 
shortcut menu that opens when you right-click a node in the Tree pane. 

Rename 

Opens the Prompt window so you can change the name of the node 
currently selected in the Tree pane. You cannot rename the primary node. 
This command is also available on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Link Jump Node 

Links the currently selected jump node to the next node you select. You 
cannot link a jump node to the primary node or to another jump node. 
This command is also available on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Delete 

Deletes the currently selected node (and its subnodes) from the 
knowledge tree without putting them on the clipboard. When you delete a 
query node, the query and its responses are removed from the knowledge 
tree. You cannot delete the primary node. This command is also available 
on the toolbar and on the shortcut menu that opens when you right-click a 
node in the Tree pane. 

Note: By default, the DT Builder prompts you to confirm node deletion. 
Click OK to close the prompt and delete the node and its subnodes. 
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Edit menu 

The commands on the Edit menu let you copy, cut, and paste nodes in the 
knowledge tree. 

This menu contains one or more of the following commands: 

Copy 

Puts a copy of the currently selected node (and its subnodes) on the 
Clipboard. You cannot copy the primary node to the Clipboard. When you 
copy a query node, its responses are also copied. This command is also 
available on the toolbar and on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Copy Single Node 

Puts a copy of the currently selected node (but not its subnodes or 
responses) on the Clipboard. You cannot copy the primary node to the 
Clipboard. This command is also available on the shortcut menu that 
opens when you right-click a node in the Tree pane. 

Cut 

Removes the currently selected node (and its subnodes) from the Tree 
pane and puts it on the Clipboard. When you cut a query node, the query 
and its responses are removed from the knowledge tree. Use the Cut 
command to move a node and its subnodes from one branch of the 
knowledge tree to another. You cannot cut the primary node or the root 
node to the Clipboard. This command is also available on the toolbar and 
on the shortcut menu that opens when you right-click a node in the Tree 
pane. 

Paste 

Pastes a previously copied or cut node (and its subnodes) under the 
selected query node. You can only paste a node under a query node. This 
command is also available on the toolbar and on the shortcut menu that 
opens when you right-click a node in the Tree pane. 

Options menu 

The commands on the Options menu let you personalize your interaction with 
the DT Builder. 

This menu contains one or more of the following commands: 

Copy Response 

Specifies whether to use response text as the name of an associated node 
when you create it. 
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 Select this command to automatically use the text of a node as its 
name when you create it. When the command is active, a check mark 
displays to the left of the command name on the menu. 

 Clear this command to use the default name (Default Node Name) 
when you create a node. You can use the Rename command on the 
Node Actions menu to change the node's name. 

This command is also available on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Default: Selected. 

Prompt on Node Delete 

Specifies whether the DT Builder prompts you before deleting nodes. 

 Select this command to display a confirmation prompt before deleting 
nodes. When the command is active, a check mark displays to the left 
of the command name on the menu. 

 Clear this command if you do not want the DT Builder to prompt you 
to confirm node deletion. 

This command is also available on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Default: Selected. 
 

View menu 

The Results of Error Check pane opens at the bottom of the DT Builder window 
when you select Check Errors from the Tree menu and the DT Builder finds 
errors in the knowledge tree. Use the commands on the View menu, which are 
only available when the DT Builder finds errors, to open and close the Results 
of Error Check pane. 

This menu contains one or more of the following commands: 

Hide Errors 

Closes the Results of Error Check pane if it is displayed on the DT Builder 
window. 

Show Errors 

Opens the Results of Error Check pane when the DT Builder has found 
errors in the knowledge tree and the pane is not displayed on the DT 
Builder window. 
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Window menu 

The commands on the Window menu let you manage which windows and 
dialogs display on your screen. This menu contains one or more of the 
following commands: 

Close All Popups 

Closes all currently open Knowledge Tools windows except the main 
window. 

List All Windows 

Opens the Windows window, which lists all currently open Knowledge Tools 
windows. Click a window name to move focus to the selected window. 

View Main Page 

Moves focus to the main Knowledge Tools window. This command only 
displays on windows other than the main Knowledge Tools window. 

Help menu 

This menu contains one or more of the following commands: 

Knowledge Tools Help 

Opens a window that provides online help information about the main 
interface window. The Contents, Index, and Search tabs appear on the 
left, allowing you to navigate the help system. 

Help on This Window 

Opens a window that provides online help information about the currently 
active Knowledge Tools pane or window. 

Power User Tips 

Opens a window that provides help information such as keyboard shortcuts 
for expert Knowledge Tools users. 

Screen Reader Usage 

This Help menu item opens a window explaining how to use a Screen 
Reader with Knowledge Tools. 

Support for Knowledge Tools 

Opens the CA support web site for Knowledge Tools. 

Operations Info 

Typically, this Help menu command displays a window showing 
information about your  product installation, such as hours of operation 
and contact information. 

The information displayed on this window is contained in the file: 
$NX_ROOT/bopcfg/www/htmpl/web/analyst/about.htmpl. 
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If you want to customize this file for your installation, please copy it to: 
$NX_ROOT/site/mods/www/htmpl/web/analyst/about.htmpl-  

and then make the required changes. 

About Knowledge Tools 

Opens the About window, which provides information about this version of 
the product, third party notices, technical support information, and system 
information. Click Done to close the About window. 

 

Logout menu 

This menu contains the following command: 

Exit Knowledge Tools 

Ends the current Unicenter SD session and displays the Login window. 

Tree pane shortcut menu 

The Tree pane shortcut menu opens when you right-click a node in the Tree 
pane on the DT Builder window. 

This menu contains one or more of the following commands: 

Copy 

Puts a copy of the currently selected node (and its subnodes) on the 
Clipboard. You cannot copy the primary node to the Clipboard. When you 
copy a query node, its responses are also copied. 

Copy Single Node 

Puts a copy of the currently selected node (but not its subnodes or 
responses) on the Clipboard. You cannot copy the primary node to the 
Clipboard. 

Cut 

Removes the currently selected node (and its subnodes) from the Tree 
pane and puts it on the Clipboard. When you cut a query node, the query 
and its responses are removed from the knowledge tree. Use the Cut 
command to move a node and its subnodes from one branch of the 
knowledge tree to another. You cannot cut the primary node or the root 
node to the Clipboard. 

Paste 

Pastes a previously copied or cut node (and its subnodes) under the 
selected query node. You can only paste a node under a query node. 
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Add Query 

Adds a query node to the query node currently selected in the Tree pane. 
You cannot add a query node to the primary node, a conclusion node, or a 
jump node. 

Add Conclusion 

Adds a conclusion node to the query node currently selected in the Tree 
pane. You cannot add a conclusion node to the primary node, a conclusion 
node, or a jump node. 

Add Jump 

Adds a jump node to the query node currently selected in the Tree pane. 
You cannot add a jump node to the primary node, a conclusion node, or a 
jump node. 

Rename 

Opens the Prompt window so you can change the name of the node 
currently selected in the Tree pane. You cannot rename the primary node. 

Link Jump Node 

Links the currently selected jump node to the next node you select. You 
cannot link a jump node to the primary node or to another jump node. 

Delete 

Deletes the currently selected node (and its subnodes) from the 
knowledge tree without putting them on the clipboard. When you delete a 
query node, the query and its responses are removed from the knowledge 
tree. You cannot delete the primary node. 

Check Errors 

Checks the knowledge tree for errors, and (if errors exist) displays them in 
the Results of Error Check pane. 

Copy Response 

Specifies whether to use response text as the name of an associated node 
when you create it. 

 Select this command to automatically use the text of a node as its 
name when you create it. When the command is active, a check mark 
displays to the left of the command name on the menu. 

 Clear this command to use the default name (Default Node Name) 
when you create a node. You can use the Rename command on the 
Node Actions menu to change the node's name. 

This command is also available on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Default: Selected. 
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Prompt on Node Delete 

Specifies whether the DT Builder prompts you before deleting nodes. 

 Select this command to display a confirmation prompt before deleting 
nodes. When the command is active, a check mark displays to the left 
of the command name on the menu. 

 Clear this command if you do not want the DT Builder to prompt you 
to confirm node deletion. 

This command is also available on the shortcut menu that opens when you 
right-click a node in the Tree pane. 

Default: Selected. 

DT Builder window 

The DT Builder Tree Designer window opens when you do either of the 
following: 

 Click the Design Tree button on the Content tab of the Create New Tree 
Document window 

 Click the Design Tree button on the Content tab of the Update Tree 
Document window 

This window has the following main components: 

Tree Pane 

The left pane, or Tree pane, displays the nodes that comprise the 
knowledge tree. Each node represents a step in the process presented by 
the knowledge tree. A well-constructed knowledge tree guides the user 
along a systematic path to answering a question, resolving a problem, or 
completing a process. Click  or  as appropriate to open or close nodes in 
the Tree pane. When you click a node in the Tree pane, the associated 
information displays in the right pane. 

Note: The right pane is empty when you select a Jump node (denoted by 
). 

Menu Bar 

The menu bar at the top of the right pane of the DT Builder window 
provides access to features with which you can build and edit knowledge 
trees. 

Toolbar 

The toolbar, located just below the menu bar in the right pane of the DT 
Builder window, contains shortcuts for some of the features available from 
the menu bar. 
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Tree Description (HTML) 

When you select the primary node (denoted by ) in the Tree pane, the 
right pane contains the description that displays when a user clicks the 
Tree Description link while viewing the document in tree view. You can edit 
the description directly in the Tree Description (HTML) pane, or you can 
click Edit Tree Description (HTML) to open the HTML Editor so you can 
more precisely format the text. 

Query Text (HTML) Pane 

When you select a query node (denoted by ) in the Tree pane, the right 
pane contains the text defined in the knowledge tree for the selected 
node. The query text typically contains a question (the answer to which 
determines the next node in the tree) or a step in a procedure. The Query 
Text (HTML) pane also displays a field for each possible response (query, 
jump, or conclusion) to the question or instruction displayed in the Query 
Text (HTML) box. Each response corresponds to a subnode of the selected 
query node in the Tree pane.You can edit text directly in the Query Text 
(HTML) pane, or you can click Edit Query Text (HTML) to open the HTML 
Editor so you can more precisely format the text. 

Conclusion Text (HTML) Pane  

When you select a conclusion node (denoted by ) in the Tree pane, the 
right pane contains the text defined in the knowledge tree for the selected 
node. The conclusion text typically describes the resolution for a particular 
problem, the final step in a procedure, or a possible termination point in a 
query. You can edit text directly in the Conclusion Text (HTML) pane, or 
you can click Edit Conclusion Text (HTML) to open the HTML Editor so you 
can more precisely format the text. 

Results of Error Check Pane  

The Results of Error Check pane opens at the bottom of the DT Builder 
window when you select Check Errors from the Tree menu and the DT 
Builder finds errors in the knowledge tree. The error messages displayed 
help you locate and fix errors in the knowledge tree. When the DT Builder 
finds no errors in the tree, the pane does not open. Use the commands on 
the View menu, which are only available when the DT Builder finds errors, 
to open and close the Results of Error Check pane. 
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Tree Description (HTML) pane 

When you select the primary node (denoted by ) in the Tree pane, the right 
pane contains the description that displays when a user clicks the Tree 
Description link while viewing the document in tree view. You can edit the 
description directly in the Tree Description (HTML) pane, or you can click Edit 
Tree Description (HTML) to open the HTML Editor so you can more precisely 
format the text. 

You can use the following keyboard shortcuts when editing text in the pane: 

Ctrl+C 

Puts a copy of the currently selected text on the Clipboard. 

Ctrl+X 

Removes the currently selected text and puts it on the Clipboard. 

Ctrl+V 

Pastes previously copied or cut text at the current cursor position. 

Ctrl+Z 

Reverses the previous action. 

Ctrl+Y 

Reverses the previous Undo action. 

For more robust editing, click Edit Tree Description (HTML) to use the HTML 
Editor to define the layout and content of the text. 

This pane contains the following fields: 

Tree Description HTML 

Defines the tree description. 

Quick View 

Specifies to display content in the associated field as it will appear at 
runtime. 

HTML Source 

Specifies to display content in the associated field as editable HTML source 
code. Select this option to make simple changes directly to the HTML code. 

This pane contains the following button: 

Edit Tree Description (HTML) 

Opens the HTML Editor so you can use plain text or HTML elements to 
design a tree description for the knowledge tree document. 
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Query Text (HTML) pane 

When you select a query node (denoted by ) in the Tree pane, the right 
pane contains the text defined in the knowledge tree for the selected node. 
The query text typically contains a question (the answer to which determines 
the next node in the tree) or a step in a procedure. The Query Text (HTML) 
pane also displays a field for each possible response (query, jump, or 
conclusion) to the question or instruction displayed in the Query Text (HTML) 
box. Each response corresponds to a subnode of the selected query node in 
the Tree pane. You can edit text directly in the Query Text (HTML) pane, or 
you can click Edit Query Text (HTML) to open the HTML Editor so you can more 
precisely format the text. 

You can use the following keyboard shortcuts when editing text in the pane: 

Ctrl+C 

Puts a copy of the currently selected text on the Clipboard. 

Ctrl+X 

Removes the currently selected text and puts it on the Clipboard. 

Ctrl+V 

Pastes previously copied or cut text at the current cursor position. 

Ctrl+Z 

Reverses the previous action. 

Ctrl+Y 

Reverses the previous Undo action. 

For more robust editing, click Edit Query Text (HTML) to use the HTML Editor 
to define the layout and content of the text. 

This pane contains the following fields: 

Query Text (HTML) 

Defines the text of the question or step. 

Quick View 

Specifies to display content in the associated field as it will appear at 
runtime. 

HTML Source 

Specifies to display content in the associated field as editable HTML source 
code. Select this option to make simple changes directly to the HTML code. 
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Responses 

Defines a field for each possible response (query, jump, or conclusion) to 
the question or instruction displayed in the Query Text (HTML) box. Each 
response corresponds to a subnode of the query node selected in the Tree 
pane. 

 To edit the name of a response, enter your changes in the box 
provided. 

 To edit the text of a response, select the response node in the Tree 
pane and edit it in the Query Text (HTML) pane or the Conclusion Text 
(HTML) pane, as appropriate. 

This pane contains the following button: 

Edit Query Text (HTML) 

Opens the HTML Editor so you can use plain text or HTML elements to 
design a query for the knowledge tree document. 

Conclusion Text (HTML) pane 

When you select a conclusion node (denoted by ) in the Tree pane, the right 
pane contains the text defined in the knowledge tree for the selected node. 
The conclusion text typically describes the resolution for a particular problem, 
the final step in a procedure, or a possible termination point in a query. You 
can edit text directly in the Conclusion Text (HTML) pane, or you can click Edit 
Conclusion Text (HTML) to open the HTML Editor so you can more precisely 
format the text. 

You can use the following keyboard shortcuts when editing text in the pane: 

Ctrl+C 

Puts a copy of the currently selected text on the Clipboard. 

Ctrl+X 

Removes the currently selected text and puts it on the Clipboard. 

Ctrl+V 

Pastes previously copied or cut text at the current cursor position. 

Ctrl+Z 

Reverses the previous action. 

Ctrl+Y 

Reverses the previous Undo action. 

For more robust editing, click Edit Conclusion Text (HTML) to use the HTML 
Editor to define the layout and content of the text. 
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This pane contains the following fields: 

Conclusion Text (HTML) 

Defines the text of the resolution for a particular problem, the final step in 
a procedure, or a possible termination point in a query. 

Quick View 

Specifies to display content in the associated field as it will appear at 
runtime. 

HTML Source 

Specifies to display content in the associated field as editable HTML source 
code. Select this option to make simple changes directly to the HTML code. 

This pane contains the following button: 

Edit Conclusion Text (HTML) 

Opens the HTML Editor so you can use plain text or HTML elements to 
design a conclusion for a query in the knowledge tree document. 

 

Results of Error Check pane 

The Results of Error Check pane opens at the bottom of the DT Builder window 
when you select Check Errors from the Tree menu and the DT Builder finds 
errors in the knowledge tree. The error messages displayed help you locate 
and fix errors in the knowledge tree. When the DT Builder finds no errors in 
the tree, the pane does not open. Use the commands on the View menu, 
which are only available when the DT Builder finds errors, to open and close 
the Results of Error Check pane. 

For each error encountered, the Results of Error Check pane displays the name 
of the node that contains the error and a description of the error. For example, 
the following error indicates that no query text or conclusion text (depending 
on the node type) was specified for the Type of Use node: 

 

Use the commands on the View menu, which are only available if the DT 
Builder finds errors in the knowledge tree, to open and close the Results of 
Error Check pane. 
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Prompt window 

The Prompt window opens when you do either of the following: 

 Select a node from the Tree pane and select Rename from the Node 
Actions menu 

 Right-click a node in the Tree pane and select Rename from the shortcut 
menu 

 

Use the window to enter a new name for the selected node. 

This window contains the following field: 

Please Enter the New Node Name 

Defines the new name for the selected node. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Saves the changes and closes the window or dialog. 
 

Toolbar 

The toolbar, located just below the menu bar in the right pane of the DT 
Builder window, contains shortcuts for some of the features available from the 
menu bar. 

The following table details each toolbar button, its function, and the menu 
command with which it is associated. 

 

Toolbar Button Function Menu/Comma
nd 

 Saves changes made to the 
knowledge tree since you last 
saved it and closes the DT Builder 
window. 

Tree/Save and 
Close 
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Toolbar Button Function Menu/Comma
nd 

 Saves changes made to the 
knowledge tree since you last 
saved it, but does not close the DT 
Builder window. 

Tree/Save 

 Puts a copy of the currently 
selected node (and its subnodes) 
on the Clipboard. You cannot copy 
the primary node to the Clipboard. 
When you copy a query node, its 
responses are also copied. 

Edit/Copy 

 Removes the currently selected 
node (and its subnodes) from the 
Tree pane and puts it on the 
Clipboard. When you cut a query 
node, the query and its responses 
are removed from the knowledge 
tree. Use the Cut command to 
move a node and its subnodes from 
one branch of the knowledge tree 
to another. You cannot cut the 
primary node or the root node to 
the Clipboard. 

Edit/Cut 

 Pastes a previously copied or cut 
node (and its subnodes) under the 
selected query node. You can only 
paste a node under a query node. 

Edit/Paste 

 Adds a query node to the query 
node currently selected in the Tree 
pane. You cannot add a query node 
to the primary node, a conclusion 
node, or a jump node. 

Node 
Actions/Add 
Query 

 Adds a conclusion node to the 
query node currently selected in 
the Tree pane. You cannot add a 
conclusion node to the primary 
node, a conclusion node, or a jump 
node. 

Node 
Actions/Add 
Conclusion 

 Adds a jump node to the query 
node currently selected in the Tree 
pane. You cannot add a jump node 
to the primary node, a conclusion 
node, or a jump node. 

Node 
Actions/Add 
Jump 
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Toolbar Button Function Menu/Comma
nd 

 Deletes the currently selected node 
(and its subnodes) from the 
knowledge tree without putting 
them on the clipboard. When you 
delete a query node, the query and 
its responses are removed from the 
knowledge tree. You cannot delete 
the primary node. 

Node 
Actions/Delete 

Note: You can only add a query, conclusion, or jump node under a query 
node. 

 

Tree pane 

The left pane, or Tree pane, displays the nodes that comprise the knowledge 
tree. Each node represents a step in the process presented by the knowledge 
tree. A well-constructed knowledge tree guides the user along a systematic 
path to answering a question, resolving a problem, or completing a process. 
Click  or  as appropriate to open or close nodes in the Tree pane. When you 
click a node in the Tree pane, the associated information displays in the right 
pane. 

The following information displays in the right pane of the DT Builder window 
when you select a node in the Tree pane: 

 

Icon Node Type Right Pane Display 

 Primary Tree Description (HTML) 
pane 

 Query Query Text (HTML) pane

 Conclusion Conclusion Text (HTML) 
pane 

 Jump N/A 

You can right-click a node in the Tree pane to open a shortcut menu that 
contains a subset of commands from the Edit, Node Actions, Options, Tree, 
and View menus. 

Note: The right pane is empty when you select a Jump node (denoted by ). 
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Procedures 
The following topics provide procedures for using the DT Builder to create and 
edit knowledge trees. 

 

Access the DT Builder for a New Knowledge Tree Document 

To access the DT Builder so you can create a new knowledge tree, follow these 
steps: 

1. Right-click the category or subcategory in which to add the new document 
in the Category pane, then select Create Knowledge Tree Document from 
the shortcut menu. 

Note: You cannot create a document directly under the TOP category. If 
necessary, add a new category in which to create the document. 

The Create New Document window opens. 

2. Complete the fields on the Content tab as appropriate. 

3. Click Design Tree. 

The DT Builder opens. 
 

Access the DT Builder for an Existing Knowledge Tree Document 

To access the DT Builder so you can edit an existing knowledge tree, follow 
these steps: 

1. Select the category or subcategory in which the document resides from 
the Category pane on the Knowledge Categories tab. 

The Knowledge Document List pane refreshes to display the contents of 
the selected category or subcategory. 

2. Click the title of the knowledge tree document to edit in the Knowledge 
Document List pane. 

The selected document opens in the Update Knowledge Document window. 

If the document has been published, you may need to unpublish it before 
making changes. 

Click Design Tree on the Content tab. 

The DT Builder opens. 
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Add a Conclusion Node 

Use a conclusion node to describe the resolution for a particular problem, the 
final step in a procedure, or a possible termination point in a query. Conclusion 
nodes do not have subnodes. You would not typically nest a conclusion node 
immediately beneath the root node of a knowledge tree. 

Note: You can add up to seven subnodes to a query node. 

To add a conclusion node, follow these steps: 

1. Select the query node (denoted by )under which to add the conclusion 
node in the Tree pane. 

The Query Text (HTML) pane opens. 

2. Click  (Add Conclusion). 

The DT Builder adds a conclusion node below the selected node in the Tree 
pane and adds a response field in the Query Text (HTML) pane. 

3. Enter a response to the question or statement posed in the parent node in 
the new field in the Query Text (HTML) pane. 

4. (Optional) To rename the new node, right-click it in the Tree pane, then 
select Rename from the shortcut menu. The Prompt window opens. Enter 
a new name for the node and click OK to close the Prompt window. The 
Tree pane refreshes to show the new node name. 

5. Select the new conclusion node in the Tree pane. 

The Conclusion Text (HTML) pane opens. 

6. Do one of the following in the Conclusion Text (HTML) pane: 

 Enter the displayed text (that is, the information associated with the 
node) in the Conclusion Text (HTML) box. You can use plain text or 
enter HTML codes as appropriate. To preview the text as it will appear 
at runtime, select the Quick View option. 

 Click Edit Conclusion Text (HTML) to open the HTML Editor so you can 
design the information associated with the node in WYSIWYG (what 
you see is what you get) format. When you finish editing the 
information, click OK to save your work and close the HTML Editor. 

7. Click  (Save). 

The DT Builder saves your changes. 
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Add a Jump Node 

Use a jump node to link to previously defined nodes in the knowledge tree. For 
example, if the answer to the query posed in a parent node requires repetition 
of previous steps in a procedure. Jump nodes do not have subnodes. You 
would not typically nest a jump node immediately beneath the root node of a 
knowledge tree. 

Note: You can add up to seven subnodes to a query node. 

To add a jump node, follow these steps: 

1. Select the query node (denoted by ) under which to add the jump node 
in the Tree pane. 

The Query Text (HTML) pane opens. 

2. Click  (Add Jump). 

The DT Builder adds a jump node below the selected node in the Tree 
pane and adds a response field in the Query Text (HTML) pane. 

3. Enter a response to the question or statement posed in the parent node in 
the new field in the Query Text (HTML) pane. 

4. Right-click the new jump node in the Tree pane, then select Link Jump 
Node from the shortcut menu. 

5. Select the query or conclusion node to which to link the jump node in the 
Tree pane. 

The jump node's name in the Tree pane changes to include the name of 
the linked query or conclusion node. For example, if you linked a node 
called "Wednesday", the jump node name changes to "NODE: 
Wednesday." When a user selects the jump node in the knowledge tree at 
runtime, the linked query or conclusion node displays. 

6. Click  (Save). 

The DT Builder saves your changes. 
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Add a Query Node 

Use a query node to supply a possible answer to the question posed in its 
parent node and to serve as a parent node for further subnodes in the tree. 
The query text typically contains a question (the answer to which determines 
the next node in the tree) or a step in a procedure. Query nodes can have 
conclusion nodes, jump nodes, and other query nodes as subnodes. 

Note: You can add up to seven subnodes to a query node. 

To add a query node, follow these steps: 

1. Select the query node (denoted by ) under which to add the new query 
node in the Tree pane. 

The Query Text (HTML) pane opens. 

2. Click  (Add Query). 

The DT Builder adds a query node below the selected node in the Tree 
pane and adds a response field in the Query Text (HTML) pane. 

3. Enter a response to the question or statement posed in the parent node in 
the new field in the Query Text (HTML) pane. 

4. (Optional) To rename the new node, right-click it in the Tree pane, then 
select Rename from the shortcut menu. The Prompt window opens. Enter 
a new name for the node and click OK to close the Prompt window. The 
Tree pane refreshes to show the new node name. 

5. Select the new query node in the Tree pane. 

The Query Text (HTML) pane opens. 

6. Do one of the following in the Query Text (HTML) pane: 

 Enter the displayed text (that is, the information associated with the 
node) in the Query Text (HTML) box. You can use plain text or enter 
HTML codes as appropriate. To preview the text as it will appear at 
runtime, select the Quick View option. 

 Click Edit Query Text (HTML) to open the HTML Editor so you can 
design the information associated with the node in WYSIWYG (what 
you see is what you get) format. When you finish editing the 
information, click OK to save your work and close the HTML Editor. 

7. Click  (Save). 

The DT Builder saves your changes. 
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Add the Tree Description 

The tree description displays at runtime when a user clicks the Tree 
Description link while viewing a knowledge tree document in tree view. For 
example, if you design a knowledge tree to help a customer choose a credit 
card, you might define a tree description such as "Use this document to find 
the best credit card for you." 

To define the tree description for a knowledge tree document, follow these 
steps: 

1. Select the knowledge tree's primary node (denoted by ) in the Tree 
pane. 

The Tree Description (HTML) pane opens. 

Do one of the following in the Tree Description (HTML) pane: 

 Enter the displayed text (that is, the information for the tree 
description) in the Tree Description (HTML) box. You can use plain text 
or enter HTML codes as appropriate. To preview the text as it will 
appear at runtime, select the Quick View option. 

 Click Edit Tree Description (HTML) to open the HTML Editor so you can 
design the tree description in WYSIWYG (what you see is what you 
get) format. When you finish editing the information, click OK to save 
your work and close the HTML Editor. 

2. Click  (Save). 

The DT Builder saves your changes. 

Add the Displayed Text for a Node 

Use the Tree Description (HTML), Query Text (HTML), and Conclusion Text 
(HTML) panes to design the information displayed for a particular node. 
Displayed text presents the description of the knowledge tree, poses a 
question, or presents information to help the user navigate the knowledge 
tree. 

To add displayed text for a node, follow these steps: 

1. Select the primary node (denoted by ), query node (denoted by ), or 
conclusion node (denoted by ) for which to add displayed text in the 
Tree pane. 

Depending upon the node you selected, one of the following panes opens: 

74  Administrator Guide 
 



Procedures 
 

If you selected the primary node, the Tree Description (HTML) pane opens. 

 If you selected a query node, the Query Text (HTML) pane opens. 

 If you selected a conclusion node, the Conclusion Text (HTML) pane 
opens. 

2. Do one of the following in the Tree Description (HTML), Query Text 
(HTML), or Conclusion Text (HTML) pane: 

 Enter the displayed text (that is, the information associated with the 
node) in the field provided. You can use plain text or enter HTML codes 
as appropriate. To preview the text as it will appear at runtime, select 
the Quick View option. 

 Click the Edit xxx (HTML) button to open the HTML Editor so you can 
design the information associated with the node in WYSIWYG (what 
you see is what you get) format. When you finish editing the 
information, click OK to save your work and close the HTML Editor. 

3. Click  (Save). 

The DT Builder saves your changes. 
 

Add the Response Text for a Node 

When you add a node to an existing query node in the Tree pane, the DT 
Builder adds a response box for the added node in the right pane. Use the box 
to specify a response to the question or statement posed in the Query Text 
(HTML) pane. 

To add response text for a node, follow these steps: 

1. Select the query node (denoted by ) that contains the node for which to 
add response text in the Tree pane. 

The Query Text (HTML) pane opens. 

2. Locate the response box for which to specify text in the Query Text (HTML) 
pane, then enter a response to the question or statement posed by the 
parent node. 

Note: By default, the response text you enter replaces the node name in 
the Tree pane (that is, the DT Builder synchronizes the response text and 
the node name). To disable synchronization, select the Copy Response 
command from the Options menu to clear the check mark from it. 

3. Click  (Save). 

The DT Builder saves your changes. 
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Check a Knowledge Tree for Errors 

To check a knowledge tree for errors, follow these steps: 

1. Select Check Errors from the Tree menu. 

The DT Builder scans the knowledge tree for missing displayed text, 
responses, and links, then displays the results in the Errors pane at the 
bottom of the window. 

2. Select an error in the Errors pane to display its associated node. 

The DT Builder selects the node in the Tree pane and displays its definition 
in the right pane. 

3. Correct the indicated error. 

4. Click  (Save). 

The DT Builder saves your changes. 
 

Copy and Paste a Node and Its Subnodes 

To copy a node and its subnodes in the DT Builder window, follow these steps: 

1. Select the node to copy in the Tree pane. 

Note: You cannot copy the primary node. 

2. Click  (Copy). 

The DT Builder puts a copy of the selected node and its subnodes in 
memory. The node and its subnodes remain in memory until you cut or 
copy another item. 

Note: This action does not remove the selected node or its subnodes from 
the knowledge tree. To remove the selected node and its subnodes from 
the knowledge tree and put it in memory, use the Cut action instead. 

3. Select a node other than the primary node into which to paste the copied 
node and its subnodes. 

4. Click  (Paste). 

The DT Builder pastes the node and its subnodes into the selected node 
and refreshes the Tree pane to display the updated structure. 

5. Click  (Save). 

The DT Builder saves your changes. 
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Copy and Paste a Single Node 

To copy a node without its subnodes or responses, follow these steps: 

1. Select the node to copy in the Tree pane. 

Note: You cannot copy the primary node. 

2. Select Copy Single Node from the Edit menu. 

The DT Builder puts a copy of the selected node in memory. The node 
remains in memory until you cut or copy another item. 

Note: This action does not remove the selected node or its subnodes from 
the knowledge tree. To remove the selected node and its subnodes from 
the knowledge tree and put it in memory, use the Cut action instead. 

3. Select a node other than the primary node into which to past the copied 
node. 

4. Click  (Paste). 

The DT Builder pastes the node into the selected node and refreshes the 
Tree pane to display the updated structure. 

5. Click  (Save). 

The DT Builder saves your changes. 

Cut and Paste a Node and Its Subnodes 

To cut a node and its subnodes, follow these steps: 

1. Select the node to cut in the Tree pane. 

Note: You cannot cut the primary or root node. 

2. Click  (Cut). 

The DT Builder highlights the selected node and puts it and its subnodes in 
memory. The node and its subnodes remain in memory until you cut or 
copy another item. 

Note: This action removes the selected node and its subnodes from the 
knowledge tree. To put a copy of a node in memory without removing it 
from the knowledge tree, use the Copy action or the Copy Single Node 
action instead. 

3. Select a node other than the primary node into which to past the cut node 
and its subnodes. 

4. Click  (Paste). 

The DT Builder pastes the node and its subnodes into the selected node 
and refreshes the Tree pane to display the updated structure. 
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5. Click  (Save). 

The DT Builder saves your changes. 

Create a Knowledge Tree Document 

To create a knowledge tree document, follow these steps: 

1. Right-click the category or subcategory in which to add the new document 
in the Knowledge Categories pane on the Administration tab, then select 
Create Knowledge Tree Document from the shortcut menu. 

Note: You cannot create a document directly under the TOP category. If 
necessary, add a new category in which to create the document. 

The Create New Document window opens. 

2. Complete the fields on the Content tab as appropriate. 

3. (Optional) Click Spell Check to check spelling in the content you entered. 

4. Click Save. 

The Create New Document window closes and the Update Knowledge 
Document window opens. 

5. Click Design Tree. 

The DT Builder opens. The Tree pane displays the information you entered 
in the Title box in the Create New Document window as the primary node 
(denoted by ). An initial query node (denoted by ), labeled "Default 
Node Name" and called the root node, is nested below the primary node. 
The primary node is selected, and the Tree Description (HTML) pane 
displays on the right side of the DT Builder window. 

6. Add the tree description (see page Error! Bookmark not defined.) in the 
Tree Description (HTML) pane. 

7. Right-click the root node in the Tree pane, then select Rename from the 
shortcut menu. 

The Prompt window opens. 

8. Enter a new name for the root node in the Please Enter the New Node 
Name box, then click OK. 

The Prompt window closes and the Tree pane refreshes to reflect your 
changes. 

9. Select the root node in the Tree pane. 

The Query Text (HTML) pane opens. 

10. Add the displayed text (see page Error! Bookmark not defined.) for the 
node in the Query Text (HTML) pane. 

78  Administrator Guide 
 



Procedures 
 

11. Do one of the following: 

 Add a query node (see page Error! Bookmark not defined.). Use a 
query node to supply a possible answer to the question posed in its 
parent node and to serve as a parent node for further subnodes in the 
tree. The query text typically contains a question (the answer to which 
determines the next node in the tree) or a step in a procedure. Query 
nodes can have conclusion nodes, jump nodes, and other query nodes 
as subnodes. 

 Add a conclusion node (see page Error! Bookmark not defined.). 
Use a conclusion node to describe the resolution for a particular 
problem, the final step in a procedure, or a possible termination point 
in a query. Conclusion nodes do not have subnodes. You would not 
typically nest a conclusion node immediately beneath the root node of 
a knowledge tree. 

 Add a jump node (see page Error! Bookmark not defined.). Use a 
jump node to link to previously defined nodes in the knowledge tree. 
For example, if the answer to the query posed in a parent node 
requires repetition of previous steps in a procedure. Jump nodes do 
not have subnodes. You would not typically nest a jump node 
immediately beneath the root node of a knowledge tree. 

12. Add query, conclusion, and jump nodes as necessary until the knowledge 
tree is complete. 

13. (Optional) Check for errors (see page Error! Bookmark not defined.) in 
your tree design. 

14. Click . 

The DT Builder saves your changes and closes. 

15. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

16. Complete the fields on the remaining tabs on the Update Knowledge 
Document window as appropriate. 

17. Click Save when you finish editing the document. 

18. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 
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Delete a Node and Its Subnodes 

To delete a node and its subnodes, follow these steps: 

1. Select the node to delete in the Tree pane. 

Note: You cannot delete the primary node. 

2. Click  (Delete). 

The DT Builder prompts you to confirm deletion of the selected node and 
its subnodes. 

Note: By Default, the DT Builder prompts you to confirm node deletion. To 
disable confirmation, Select the Prompt on Node Delete command on the 
Options menu to remove the check mark from it. 

3. Click OK. 

The confirmation message closes and the DT Builder removes the selected 
node and its subnodes from the knowledge tree. If you selected the root 
node, the Delete action removes the root node's displayed text and all 
subnodes but does not remove the root node itself. 

 

Exit the DT Builder 

To exit the DT Builder, follow these steps: 

1. Select Exit from the Tree menu. 

The DT Builder prompts you to save any unsaved changes. 

2. Click Yes 

3. The product saves your changes, closes the prompt, and closes the DT 
Builder. 

Link a Jump Node 

After you add a jump node to a knowledge tree, you must link it to a 
destination query or conclusion node. To link a jump node, follow these steps: 

1. Right-click the jump node in the Tree pane, then select Link Jump Node 
from the shortcut menu. 

2. Select the query or conclusion node to which to link the jump node in the 
Tree pane. 

The jump node's name in the Tree pane changes to include the name of 
the linked query or conclusion node. For example, if you linked a node 
called "Wednesday", the jump node name changes to "NODE: 
Wednesday." When a user selects the jump node in the knowledge tree at 
runtime, the linked query or conclusion node displays. 
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3. Click  (Save). 

The DT Builder saves your changes. 
 

Paste a Node and Its Subnodes 

To paste a node that you previously cut or copied into memory, follow these 
steps: 

1. Select the query node (denoted by ) into which to paste the cut or 
copied node in the Tree pane. 

Note: You can only paste a node into a query node. You cannot paste into 
the primary node (denoted by ). 

2. Click  (Paste). 

The DT Builder pastes the node (and, if appropriate, its subnodes) to the 
selected node in the Tree pane. 

3. Click  (Save). 

The DT Builder saves your changes. 
 

Preview the Node Design 

You can preview a tree description, query node, or conclusion node as it will 
display to users at runtime. Use this feature to verify your node content and 
design. 

To preview a node, follow these steps: 

1. Click the node to preview in the Tree pane. 

Note: To preview the tree description, click the primary node (denoted by 
). 

The Tree Description (HTML) pane, Query Text (HTML) pane, or Conclusion 
Text (HTML) pane opens, as appropriate. 

2. Select the Quick View option. 

The displayed text for the node appears in a read-only WYSIWYG format. 

Note: Response links and other features of the node do not function when 
displayed in Quick View mode. 

3. Select the HTML Source option to edit the displayed text. 
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Rename a Node 

Note: By default, the response text you enter replaces the node name in the 
Tree pane (that is, the DT Builder synchronizes the response text and the node 
name). To disable synchronization, select the Copy Response command from 
the Options menu to clear the check mark from it. 

To rename a node, follow these steps: 

1. Right-click the node to rename in the Tree pane, then select Rename from 
the shortcut menu. 

The Prompt window opens. 

Select the current node name in the Prompt window. 

2. Enter a new name for the node. 

3. Click OK. 

The Prompt window closes and the Tree pane refreshes to display the 
updated node name. 

 

Save a Knowledge Tree 

To save changes to the open knowledge tree, do one of the following: 

 Click . 

The DT Builder saves all changes to the knowledge tree since you last 
saved. The DT Builder window remains open. 

 Click . 

The DT Builder saves all changes to the knowledge tree since you last 
saved, then closes the DT Builder window. 

 

82  Administrator Guide 
 



Procedures 
 

Set DT Builder Options 

Use the commands on the Options menu to control certain DT Builder 
behaviors, as follows: 

 To set whether the DT Builder uses response text as the name of an 
associated node, select Copy Response from the Options menu. 

– If a check mark displays next to the command on the menu, the 
option is active and the response text you specify for a node replaces 
its name in the Tree pane. This is the default setting. 

– If no check mark displays, the option is inactive and you must 
manually rename the node. 

 To set whether the DT Builder prompts you before deleting a node, Select 
Prompt on Node Delete from the Options menu. 

– If a check mark displays next to the command on the menu, the 
option is active and the DT Builder displays a confirmation prompt 
when you attempt to delete a node. Click OK to close the prompt and 
delete the node and its subnodes. This is the default setting. 

– If no check mark displays, the option is inactive and the DT Builder 
deletes the selected node and its subnodes without displaying a 
confirmation prompt. 
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Knowledge managers and system administrators can use the Administrator tab 
of Knowledge Tools to perform administrative tasks such as: 

 Maintaining approval process settings and templates 

 Managing document templates and settings 

 Managing search settings 

To access the administrative functions of Knowledge Tools, you must log in as 
a system administrator. All administrative functions can be accessed from the 
Administration tab. 

 

Approval Process Manager 
The Approval Process Manager allows you to manage the approval process 
settings and templates. The following panes are available: 

 Approval Process Settings Pane (see page 85) 

 Approval Process Template List Pane (see page 87) 

 Status List pane (see page 100) 

Approval Process Settings Pane 

The Approval Process Settings pane opens when you select Administration, 
Knowledge, Approval Process Manager, Approval Process Settings from the left 
pane of the Administration tab. 

Use the Approval Process Settings pane to specify permissions for editing 
documents during the approval process and after publishing. 

This pane contains the following fields: 

Permissions for Document Edit during Approval Process 

Specifies who may edit documents before they are published. Select one of 
the following options: 

Documents may be edited by a task assignee, an owner or users 
with the appropriate Access Type views 

Select this option so only the following contacts can edit a document: 

 A contact assigned the current task 
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 A contact specified as an owner of the document for the current 
task 

 A knowledge manager 

 A system administrator 

Documents may be edited by users with full permissions 

Select this option so any user with write permissions to the document 
can edit it. 

Default: Documents may be edited by users with full permissions. 

Permissions for Document Edit after Publish 

Specifies who may edit documents after they are published. Select one of 
the following options: 

User with full permissions may edit documents after they have 
been published 

Select this option so any user with write permissions to the document 
can edit it. 

Documents must be unpublished before editing is allowed 

Select this option to require a user to unpublish a document before 
editing it. 

Default: Documents must be unpublished before editing is allowed. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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Approval Process Template List Pane 

The Approval Process Template List pane opens when you select 
Administration, Knowledge, Approval Process Manager, Approval Process 
Templates from the left pane of the Administration tab. 

An approval process template groups tasks or steps to complete during the life 
of a document. 

Use the Approval Process Template List pane to add, edit, rename, or delete 
approval process templates and to designate an approval process template as 
the default template to use for new documents. When you edit an approval 
process template, you can add, modify, or delete tasks in the approval 
process. A default approval process template, Built In Workflow, installs with 
the product. 

Note: You cannot delete the Built In Workflow template. 

This pane contains the following columns: 

Template Name 

Lists approval process templates currently defined in the product. Select a 
template name to open the Update Approval Process Template dialog. 
Right-click a template name to open the Approval Process Template 
shortcut menu, which contains commands for working with the selected 
template. 

Description 

Displays the description defined for each approval process template, if 
available. Right-click a description to open the Approval Process Template 
shortcut menu, which contains commands for working with the selected 
template. 

Default 

Displays a mark denoting the approval process template that the product 
uses by default for newly-created documents or when a document's 
specified template is deleted. To set an approval process template as the 
default, right-click the template name or description and select Set as 
Default from the shortcut menu. 

This pane contains the following fields: 

Template 

Defines the name of the template for which to search. This field only 
displays when you click Show Filter. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 
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This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Create New 

Opens the Create New Approval Process Template window, on which you 
can define the name and description for a new template. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show Filter/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 

Approval Process Template Detail window 

The Approval Process Template Detail window opens when you do any of the 
following: 

 Click a template name in the Approval Process Template List pane 

 Right-click a template name in the Approval Process Template List pane 
and select View from the shortcut menu 

 Click Save on the Create New Approval Process Template window 

 Click Save on the Update Approval Process Template window 

 Click Cancel on the Update Approval Process Template window 

Use the Approval Process Template Detail window to review the name and 
description of the template and the tasks in the approval process, to add, edit 
and delete tasks, and to specify which task to assign to a document if it is 
unpublished or unretired. The tasks listed on the Approval Process Template 
Detail window define the life cycle of documents created with the associated 
template. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

88  Administrator Guide 
 



Approval Process Manager 
 

This window contains the following columns: 

Task Name 

Lists approval process tasks currently defined in the template. Select a 
task name to open the Task Detail window. Right-click a task name to 
open the Approval Process Task Name shortcut menu, which contains 
commands for working with the selected task. 

Status 

Displays the document status associated with the task. 

Assignee 

Displays the user name of the task's owner. A document may have a 
different owner during each stage of the approval process, and may have 
one owner who is primarily responsible for maintaining the document after 
it is published. 

Note: Analysts with write access to a document can modify the document 
even if they do not own it. 

Unpublish Task 

Displays a mark to indicate the approval process task to which the product 
assigns a document when a non-administrative user unpublishes it. 
Administrators can assign a task directly when unpublishing a document. 
To set the unpublish task, right-click the task name and select Set 
Unpublish Task from the shortcut menu. 

Unretire Task 

Displays a mark to indicate the approval process task to which the product 
assigns a document when a non-administrative user unretires it. 
Administrators can assign a task directly when unretiring a document. To 
set the unretire task, right-click the task name and select Set Unretire 
Task from the shortcut menu. 

This window contains the following fields: 

Template 

Displays the unique name associated with the template. This field is read-
only. 

Description 

Displays the description defined for the item, if available. This field is read-
only. 

This window contains the following buttons: 

Edit 

Opens the Update Approval Process Template window so you can modify 
the template name and description and work with approval process tasks. 

Administration Tab  89  
 



Approval Process Manager 
 

Publish After Unretiring 

Sets the status of a document associated with the current approval 
process template to Published when the document is unretired. 

Retire After Unpublishing 

Sets the status of a document associated with the current approval 
process template to Retired when the document is unpublished. 

 

Assignee Detail window 

The Assignee Detail window opens when you do any of the following: 

 Click Save on the Create New Assignee window 

 Click Save on the Update Assignee window 

 Click Cancel on the Update Assignee window 

Use the Assignee Detail window to review the user you selected as an 
alternate owner for a task. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Assignee 

Displays the contact's name, in "last name, first name" format. Click the 
user name to open the Detail window for the assignee. This field is read-
only. 

This window contains the following button: 

Edit 

Opens the Update Assignee window so you can change the contact 
assigned as alternate owner for an approval process task. 
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Create New Approval Process Template window 

The Create New Approval Process Template window opens when you do either 
of the following: 

 Click Create New in the Approval Process Template List pane 

 Right-click a template name in the Approval Process Template List pane, 
then select Save As from the shortcut menu 

Use the Create New Approval Process Template window to define the name 
and description for a template. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Template 

Defines a unique name for the template. This field is required. 

Description 

Defines a brief description of the item. 

This window contains the following buttons: 

Edit 

Opens the Update Task window so you can modify the Template and 
Description. 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Approval Process Template Detail window. 
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Create New Assignee window 

The Create New Assignee window opens when you do any of the following: 

 Click Add Assignee on the Update Task window 

 Click Add Assignee on the Task Detail window 

 Right-click an assignee name in the Alternate Assignee List on the Update 
Task window and select New from the shortcut menu 

 Right-click an assignee name in the Alternate Assignee List on the Task 
Detail window and select New from the shortcut menu 

Use the Create New Assignee window to define an alternate user to whom to 
assign a task when the primary assignee is unavailable or if multiple assignees 
are necessary. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Assignee 

Defines the contact to whom to assign a task. Do one of the following: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can search for and 
select a contact. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Assignee box. 

This field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Assignee Detail window. 
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Create New Task window 

The Create New Task window opens when you do one of the following: 

 Right-click a task name on the Approval Process Template Detail window 
and select New from the shortcut menu. 

 Right-click a task name on the Update Approval Process Template window 
and select New from the shortcut menu. 

Use the Create New Task window to add a new task to the approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Task 

Defines a unique name for the task. This field is required. 

Assignee 

Defines the contact to whom to assign a task. Do one of the following: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can search for and 
select a contact. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Assignee box. 

This field is required. 

Status 

Specifies the document status to associate with the task. You can select 
the predefined Draft status or a user-defined status from the drop-down 
list. This field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 
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Save 

Saves and applies the specified settings, closes the current window, and 
opens the Task Detail window. 

Task Detail window 

The Task Detail window opens when you do either of the following: 

 Select an existing task on the Approval Process Template Detail window 

 Click Save on the Create New Task window 

 Click Save on the Update Task window 

Use the Task Detail window to review the attributes set for an approval 
process task and to manage alternate assignees for the task. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Task 

Displays the name of the task. This field is read-only. 

Assignee 

Displays the contact's name, in "last name, first name" format. Click the 
user name to open the Detail window for the assignee. This field is read-
only. 

Status 

Displays the document status associated with the task. This field is read-
only. 

Alternate Assignee List 

Defines additional users or groups as owners of a task. You can specify 
multiple groups or users for each task, and you can also delete users or 
groups from the list. 

When you click Add Assignee, the Create New Assignee window opens so 
you can define or select contacts to add to the Alternate Assignee List. 

When you right-click an assignee name, a shortcut menu opens from 
which you can select commands to create, edit, review, or delete 
assignees. 
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This window contains the following buttons: 

Add Assignee 

Opens the Create New Assignee window, on which you can define an 
alternate user to whom to assign the task when the primary assignee is 
unavailable or if multiple assignees are necessary. 

Edit 

Opens the Update Task window so you can modify the Template and 
Description. 

Task List 

The Task List, which is a portion of the Template Detail window, opens when 
you do either of the following: 

 Click Edit on the Approval Process Template Detail window 

 Right-click a template name in the Approval Process Template List pane 
and select Edit from the shortcut menu 

Use the Task List window to edit the name and description for a template; to 
review the tasks in the approval process; to add, edit and delete tasks; and to 
specify which task to assign to a document when it is unpublished or unretired. 
The tasks listed on the Task List window define the life cycle of documents 
created with the associated template. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following columns: 

Task Name 

Lists approval process tasks currently defined in the template. Select a 
task name to open the Task Detail window. Right-click a task name to 
open the Approval Process Task Name shortcut menu, which contains 
commands for working with the selected task. 

Status 

Displays the document status associated with the task. 

Assignee 

Displays the user name of the task's owner. A document may have a 
different owner during each stage of the approval process, and may have 
one owner who is primarily responsible for maintaining the document after 
it is published. 

Note: Analysts with write access to a document can modify the document 
even if they do not own it. 
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Unpublish Task 

Displays a mark to indicate the approval process task to which the product 
assigns a document when a non-administrative user unpublishes it. 
Administrators can assign a task directly when unpublishing a document. 
To set the unpublish task, right-click the task name and select Set 
Unpublish Task from the shortcut menu. 

Unretire Task 

Displays a mark to indicate the approval process task to which the product 
assigns a document when a non-administrative user unretires it. 
Administrators can assign a task directly when unretiring a document. To 
set the unretire task, right-click the task name and select Set Unretire 
Task from the shortcut menu. 

This window contains the following fields: 

Template 

Defines a unique name for the template. This field is required. 

Description 

Defines a brief description of the item. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Approval Process Template Detail window. 

Publish after Unretiring 

Sets the status of a document associated with the current approval 
process template to Published when the document is unretired. 

Reset 

Returns all fields on the window or dialog to their default values. 

Retire after Unpublishing 

Sets the status of a document associated with the current approval 
process template to Retired when the document is unpublished. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Approval Process Template Detail window. 
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Update Assignee window 

The Update Assignee window opens when you do any of the following: 

 Click Edit on the Assignee Detail window 

 Right-click an assignee name in the Alternate Assignee List on the Update 
Task window and select Edit from the shortcut menu 

 Right-click an assignee name in the Alternate Assignee List on the Task 
Detail window and select Edit from the shortcut menu 

Use the Update Assignee window to change the contact assigned as alternate 
owner for an approval process task. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Assignee 

Defines the contact to whom to assign a task. Do one of the following: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can search for and 
select a contact. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Assignee box. 

This field is required. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Assignee Detail window. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Assignee Detail window. 
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Task Windows 

Task windows open when you do any of the following: 

 Click on a task name from the Task List on the Built in Approval Process 
Approval Process Template Detail window 

 Right-click a task name from the Task List on the Built in Approval Process 
Approval Process Template Detail window and select View 

 Click the Insert Task button from the Task List on the Built in Approval 
Process Approval Process Template Detail window 

 Right-click a task name from the Task List on the Built in Approval Process 
Approval Process Template Detail window and select Edit 

 Right-click a task name from the Task List on the Built in Approval Process 
Approval Process Template Detail window and select Insert 

 Click the Edit button from the Create Document Task Detail window 

 Click Save on the Create New Task window 

 Click Save on the Create Document Update Task window 

Use the Create Document Task Detail window to review the attributes set for 
an approval process task and to manage alternate assignees for the task. 

Use the Create New Task window to add a new task to the approval process. 

Use the Create Document Update Task window to change the name and (for 
user-defined tasks) the status, assignee, and alternate assignees for the 
selected task. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

These windows contain all or some of the following fields: 

Task 

Defines a unique name for the task. This field is read-only if viewing the 
task, and is required when creating a new task. 

Assignee 

Defines the name of the contact for the assigned task. When viewing a 
task, this field is read-only and displays the contact's name, in "last name, 
first name" format. Click the user name to open the detail window for the 
assignee. 

When creating or updating a task, do one of the following: 

 Enter the name of the contact in "last name, first name" format. 
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 Click  to open the Contact Search window so you can search for and 
select a contact. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Assignee box. 

This field is required when creating or updating a task. 

Status 

Specifies the document status to associate with the task. When viewing a 
task, this field is read-only. When creating or updating a task, you can 
select the predefined Draft status or a user-defined status from the drop-
down list. 

Alternate Assignee List 

Defines additional users or groups as owners of a task. You can specify 
multiple groups or users for each task, and you can also delete users or 
groups from the list. 

When you click Add Assignee, the Create New Assignee window opens so 
you can define or select contacts to add to the Alternate Assignee List. 

When you right-click an assignee name, a shortcut menu opens from 
which you can select commands to create, edit, review, or delete 
assignees. 

Note: The Assignee, Alternate Assignee List, and Status boxes only 
display on the Create Document Update Task window for user-defined 
tasks. 

This window contains the following buttons: 

Add Assignee 

Opens the Create New Assignee window, on which you can define an 
alternate user to whom to assign the task when the primary assignee is 
unavailable or if multiple assignees are necessary. 

Note: The Add Assignee button only displays on the Create Document 
Update Task window for user-defined tasks. 

Insert Task 

Opens the Create New Task window, allowing you to add a new task to the 
list. 

Cancel 

Discards changes, closes the current window or dialog, and opens the Task 
Detail window. 
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Edit 

Opens the Update Task window so you can modify the Template and 
Description. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Task Detail window. 

Status List Pane 

The Status List pane opens when you select Administration, Knowledge, 
Approval Process Manager, Document Statuses from the left pane of the 
Administration tab. 

Use the Status List pane to add and delete user-defined document statuses 
and modify their names and descriptions. You can also modify the names and 
descriptions of predefined document statuses. 

This pane contains the following columns: 

Status Name 

Displays the available document statuses. The default statuses are: 

Draft 

The document has been created and possibly assigned to an analyst 
for review and modification, but has not yet been published. 

Published 

The document is available in the knowledge base and users or groups 
with appropriate permissions can view it. 

Retired 

The document has been removed from the knowledge base, either 
manually or at its expiration date, and can no longer be viewed. 

You can change the names and descriptions of predefined statuses. You 
can also create, modify, or delete user-defined statuses. You cannot delete 
the predefined Draft, Published, and Retired statuses. 

Select a status name to open the Update Status window. Right-click a 
status name to open the Status List shortcut menu, which contains 
commands for editing or deleting the selected status. 

Description 

Displays the description defined for each document status, if available. You 
can change the descriptions for predefined and user-defined statuses. 
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This pane contains the following fields: 

Status 

Defines the name of the document status for which to search. This field 
only displays when you click Show Filter. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 

This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Create New 

Opens the Create New Status window so you can define the name and 
description for a new user-defined document status. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show Filter/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 

Create New Status window 

The Create New Status window opens when you click Create New on the 
Status List pane. 

Use the Create New Status dialog to define the name and a brief description 
for a new document status. The product adds the new status after the selected 
status on the Status List pane. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Status 

Defines a unique name for the document status. This field is required. 

Description 

Defines a brief description of the document status. 
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Limits: The description can be up to 255 characters in length. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Status Detail window. 

 

Status Detail window 

The Status Detail window opens when you do any of the following: 

 Click Save on the Create New Status window 

 Click Save on the Update Status window 

 Click Cancel on the Update Status window 

Use the Status Detail window to review the name and description for a 
document status. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Status 

Displays the unique name defined for the document status. 

Description 

Displays the description defined for the item, if available. 

This window contains the following button: 

Edit 

Opens the Update Status window so you can modify the status name and 
description. 
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Update Status window 

The Update Status window opens when you do any of the following: 

 Select a document status name on the Status List pane 

 Right-click a document status name and select Edit from the shortcut 
menu 

 Click Edit on the Status Detail window 

Use the Edit Status window to rename a document status or change its 
description. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Status 

Defines a unique name for the document status. This field is required. 

Description 

Defines a brief description of the document status. 

Limits: The description can be up to 255 characters in length. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Status Detail window. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Status Detail window. 

 

Documents 
The following panes are available for Document management: 

 Document Settings Pane (see page 104) 

 Document Template List Pane (see page 105) 
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Document Settings Pane 

The Document Settings pane opens when you select Administration, 
Knowledge, Documents, Document Settings from the left pane of the 
Administration tab. 

Use the Document Settings page to specify settings related to comments, 
submitting knowledge, and viewing knowledge tree documents. 

This pane contains the following fields: 

Knowledge Tree Document Viewing 

Specifies the viewing mode in which knowledge tree documents open. 
Select one of the following options: 

Open in Tree Mode 

Opens the knowledge tree directly. 

Open in Document Mode 

Opens the knowledge tree document initially. The user must click 
Display to open the actual knowledge tree. 

Default: Open in Tree Mode. 

Comments 

Specifies whether users can submit comments for documents and view 
document comments. Select one of the following options: 

Allow comment submission and comment viewing 

Displays a Comment box on the right side of an open document so 
users can submit comments for the document. Users can view 
comments already associated with the open document. 

Allow comment submission but not comment viewing 

Displays a Comment box on the right side of an open document so 
users can submit comments for the document. Users cannot view 
comments already associated with the open document. 

Allow neither comment submission nor comment viewing 

Denies users the ability to submit or view comments. The Comment 
box does not display in an open document. 

Default: Allow comment submission and comment viewing. 

Submit Knowledge 

Defines which repository to upload user-submitted documents. 

Submit Knowledge Repository 

The product populates the list with the names of repositories defined 
on the Attachment Library pane. 
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Maximum Characters Allowed in Resolution Field 

Defines the maximum size (in characters) that the Resolution field in a 
document may contain. 

Limits: The maximum characters allowed is 256000. 

Default: 32768. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 

Document Template List Pane 

The Document Template List pane opens when you select Administration, 
Knowledge, Documents, Document Templates from the left pane of the 
Administration tab. 

Use the Document Template List pane to create and manage document 
templates, which specify the content and appearance of documents in the 
knowledge base. 

Two default templates install with the product: 

 Built In - Knowledge Document 

 Built In - Knowledge Tree 

The product uses the default templates when you create knowledge 
documents and knowledge tree documents unless you create new document 
templates and associate them with your documents. 

This pane contains the following columns: 

Template Name 

Lists document templates currently defined in the product. Select a 
template name to open the Update Document Template window. Right-
click a template name to open the Template Name shortcut menu, which 
contains commands for working with the selected template. 

Default 

Displays a mark to indicate that a template is used by default for newly-
created documents or when a document's specified template is deleted. To 
set a template as the default, right-click the template name and select Set 
as Default from the shortcut menu. 
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Note: When you create a new document or delete a template associated with 
a document, the product associates the default template with it (unless you 
specify another template on the Attributes tab of the Create New Document 
window or the Update Knowledge Document window). 

This pane contains the following fields: 

Template 

Defines the name of the template for which to search. This field only 
displays when you click Show Filter. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 

This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Create New 

Opens the Create New Document Template window so you can define a 
new document template. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show Filter/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 

Create New Document Template window 

The Create New Document Template window opens when you do any of the 
following: 

 Click Create New on the Document Template List pane 

 Right-click a template name on the Document Template List pane and 
select Save As from the shortcut menu 

Use the Create New Document Template window to define the name, 
attributes, layout, and static content of a new document template. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 
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This window contains the following fields: 

Template 

Defines a unique name for the template. This field is required. 

Quick View 

Displays content in read-only format as it will display at runtime. 

HTML Source 

Displays HTML source code used to define content. Select this option to 
make simple changes directly to the HTML code. 

Detail 

Displays the static content that appears in documents created using the 
current template. If you select the HTML Source option, you can edit HTML 
code for the body directly in the Body box. If you select the Quick View 
option, the Body box is read-only and displays the static body content as it 
appears at runtime. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Edit Detail 

Opens the HTML Editor so you can specify the static content and layout 
used in documents based on the current document template. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Document Template Detail window. 

Spelling 

Checks the content in the pane for spelling accuracy. If the content 
contains spelling errors (that is, words that do not exist in the product 
dictionary), the Spell Check Results window opens. The Spelling button is 
only available when the HTML Source option is selected. 
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Document Template Detail window 

The Document Template Detail window opens when you do any of the 
following: 

 Click Save on the Create New Document Template window 

 Click Save on the Update Document Template window 

 Click Cancel on the Update Document Template window 

 Right-click a template name on the Document Template List pane and 
select View from the shortcut menu 

Use the Document Template Detail window to review the name, layout, and 
content of the selected template. You cannot change the settings on the 
Document Template Detail window. To modify the template, click Edit. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Template 

Displays the unique name associated with the template. This field is read-
only. 

Detail 

Displays the static content that appears in documents created using the 
template. This field is read-only. 

This window contains the following button: 

Edit 

Opens the Update Document Template window so you can modify the 
selected template. By modifying the document template, you can change 
the layout and default content of documents that use the template. 
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Preview Window (User View) 

The Preview window opens when you do either of the following: 

 Click User View on the Update Knowledge Document window 

 Click User View on the Knowledge Document Detail window 

 Right-click a Document in the Document List in the Knowledge Categories 
window under the Administration tab, and select User View 

Use the Preview window to view the current document as it will display to 
users at runtime. This enables you to verify your design before you publish the 
document. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Use the Print command in the Page Options menu on the upper right side of 
the Preview window to opens a standard Windows Print dialog so you can 
specify options for printing the contents of the current document. 

The Spell Check Results window opens when you check spelling or click the 
Spelling button. The spell checker scans the header or body information and 
displays each unrecognized word in the Spell Check Results window. Use the 
window to specify what action to take on such words. When you correct or 
otherwise act upon a word, the product moves to the next unrecognized word, 
and so on until it has scanned the entire header or body. 

You can use the Spell Check Results window to do the following: 

 Correct the spelling of a specific occurrence of the unrecognized word in 
the template header or body 

 Correct the spelling of all occurrences of the unrecognized word in the 
template header or body 

 Select a word to replace the unrecognized word 

 Ignore a specific occurrence of the unrecognized word in the template 
header or body 

 Ignore all occurrences of the unrecognized word in the template header or 
body 

This window contains the following fields: 

Not in Dictionary 

Displays the word that the product has identified as misspelled (that is, 
not in the product dictionary). 

Limits: This field is read-only. 
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Change To 

Displays the word in the product dictionary that is the closest in spelling to 
the unrecognized word or the current selection from the Suggestions list. 

You can accept the spelling of the replacement as presented or type an 
alternate spelling in the Change To box, then do one of the following: 

 Click Change. The product changes the current occurrence of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

 Click Change All. The product changes all occurrences of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

Suggestions 

Specifies words that are close in spelling to the unrecognized word. When 
you select a word from the list, it displays in the Change To box. 

Context 

Displays the unrecognized word in the context in which it is used in the 
template. 

Editing the text in the Context box has no effect on the template's 
contents. 

This window contains the following buttons: 

Change 

Changes the current occurrence of the word in the Not in Dictionary field 
to the word in the Change To box. 

Change All 

Changes all instances of the word in the Not in Dictionary field to the word 
in the Change To box. 

Close 

Closes the document, window, or dialog. 

Ignore 

Disregards the current instance of the unrecognized word and advances to 
the next unrecognized word. If there are no additional unrecognized 
words, the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 

Ignore All 

Disregards all instances of the unrecognized word and advances to the 
next unrecognized word. If there are no additional unrecognized words, 
the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 
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Update Document Template window 

The Update Document Template window opens when you do any of the 
following: 

 Select a template name on the Document Template List pane 

 Right-click a template name on the Document Template List pane and 
select Edit from the shortcut menu 

 Click the Edit button on the Document Template Detail window 

Use the Update Document Template window to change the name, layout, and 
content of the selected template. By modifying a document template, you can 
change the layout and default content of documents that use the template. 

This window contains the following fields: 

Template 

Defines a unique name for the template. This field is required. 

HTML Source 

Displays HTML source code used to define content. Select this option to 
make simple changes directly to the HTML code. 

Quick View 

Displays content in read-only format as it will display at runtime. 

Detail 

Displays the static content that appears in documents created using the 
current template. If you select the HTML Source option, you can edit HTML 
code for the body directly in the Body box. If you select the Quick View 
option, the Body box is read-only and displays the static body content as it 
appears at runtime. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Document Template Detail window. 

Edit Detail 

Opens the HTML Editor so you can specify the static content and layout 
used in documents based on the current document template. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Document Template Detail window. 
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Spelling 

Checks the content in the pane for spelling accuracy. If the content 
contains spelling errors (that is, words that do not exist in the product 
dictionary), the Spell Check Results window opens. The Spelling button is 
only available when the HTML Source option is selected. 

 

Knowledge Administration 
The following panes are available for Knowledge administration: 

 Noise Words List Pane (see page 116) 

 Special Terms List Pane (see page 116) 

 Synonyms List Pane (see page 120) 

 Knowledge Categories Pane (see page 124) 

Noise Words List Pane 

The Noise Words List pane opens when you select either of the following from 
the left pane of the Administration tab: 

 Administration, Knowledge, Knowledge Administration, Noise Words (when 
Unicenter KT is installed) 

 Administration, Knowledge, Keyword Administration, Noise Words (when 
Unicenter KT is not installed) 

When you publish a document to the knowledge base, the product parses the 
information in the Title, Summary, Problem, and Resolution fields of the 
document into keywords. When a user searches the knowledge base, the 
product compares keywords from the user's query with the keywords parsed 
from the knowledge base to produce a result list. 

Use the Noise Words List pane to specify words that the product can ignore in 
documents and queries without affecting search results. 

For example, when the product parses documents, it ignores default noise 
words such as "How," "do," and "I." When a user enters a query such as "How 
do I contact support?", the product removes these words from the search 
string before performing the query. This results in a quicker return of more 
accurate results. 

You cannot define a noise word that already exists as a synonym or keyword. 
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This pane contains the following fields: 

Noise Word 

Defines a noise word for which to search. This field only displays when you 
click Show Filter. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 

Noise Words List 

Displays words to filter out of search requests. The list displays when you 
click the Search button. If you entered a word in the Noise Word box, the 
list only displays the specified word. If you entered nothing in the Noise 
Word box, the list displays all noise words defined for the product. 

This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Create New 

Opens the Create New Noise Word window so you can define a noise word. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show Filter/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 
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Create New Noise Word Window 

The Create New Noise Word window opens when you click the Create New 
button on the Noise Words List pane. 

Use the Create New Noise Word window to add a new word to the list of words 
that the product can ignore in documents and queries without affecting search 
results. 

This window contains the following field: 

Noise Word 

Defines a word to add to or edit in the Noise Words list. This field is 
required. 

Note: Allows one-character Noise Words for multi-byte languages like 
Chinese, Japanese, and Korean. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Adds the noise word to the list, closes the current window, and opens the 
Noise Word Detail window. 

Close Window 

Closes the document, window, or dialog. 
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Noise Word Detail Window 

The Noise Word Detail window opens when you do any of the following: 

 Click the Save button on the Create New Noise Word window 

 Click the Save button on the Update Noise Word window 

 Click the Cancel button on the Update Noise Word window 

Use the Noise Word Detail window to review a new noise word or to review 
changes to an existing word in the list of words that the product can ignore in 
documents and queries without affecting search results. 

This window contains the following field: 

Noise Word 

Displays the word just added or updated in the Noise Words list. This field 
is read-only. 

Note: Allows one-character Noise Words for multi-byte languages like 
Chinese, Japanese, and Korean. 

This window contains the following buttons: 

Edit 

Opens the Update Noise Word window so you can modify a noise word. 

Close Window 

Closes the document, window, or dialog. 

Update Noise Word Window 

The Update Noise Word window opens when you do any of the following: 

 Right-click a noise word in the Noise Words List pane and select Edit from 
the shortcut menu 

 Click the Edit button on the Noise Word Detail window 

Use the Update Noise Word window to modify an entry in the list of words that 
the product can ignore in documents and queries without affecting search 
results. 

This window contains the following field: 

Noise Word 

Defines a word to add to or edit in the Noise Words list. This field is 
required. 

Note: Allows one-character Noise Words for multi-byte languages like 
Chinese, Japanese, and Korean. 
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This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Noise Word Detail window. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Adds the noise word to the list, closes the current window, and opens the 
Noise Word Detail window. 

Close Window 

Closes the document, window, or dialog. 

Special Terms List Pane 

The Special Terms List pane opens when you select either of the following 
from the left pane of the Administration tab: 

 Administration, Knowledge, Knowledge Administration, Special Terms 
(when Unicenter KT is installed) 

 Administration, Knowledge, Keyword Administration, Special Terms (when 
Unicenter KT is not installed) 

When you publish a document to the knowledge base, the product parses the 
information in the Title, Summary, Problem, and Resolution fields of the 
document into keywords. When a user searches the knowledge base, the 
product compares keywords from the user's query with the keywords parsed 
from the knowledge base to produce a result list. 

Use the Special Terms List pane to specify words or phrases that the product 
should treat as single keywords when parsing documents and queries. For 
example, you might add words or phrases to the list if users are likely to use 
them in queries and they contain spaces, hyphens, slashes, and so on (for 
example, words and phrases such as "automated teller machine", "e-mail", 
and "tcp/ip"). 

Create a special term for any complex synonym that you create so that the 
product processes the synonym as a single entity. Complex synonyms contain 
multiple words separated by spaces or other delimiters. For example, if you 
define "Computer Associates" as a synonym for "CA", you should also define 
"Computer Associates" as a special term. 
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This pane contains the following fields: 

Special Term 

Defines a special term for which to search. This field only displays when 
you click Show Filter. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 

Special Terms 

Displays words or phrases containing spaces or characters (such as 
hyphens, slashes, and so on) that the product should treat as single 
keywords when parsing queries. If you entered a word in the Special Term 
box before clicking Search, the list only displays the specified word. If you 
entered nothing in the Special Term box, the list displays all special terms 
defined for the product. 

This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Create New 

Opens the Create New Special Term window so you can define a word or 
phrase to use as a special term. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show Filter/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 
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Create New Special Term Window 

The Create New Special Term window opens when you click the Create New 
button on the Special Terms List pane. 

Use the Create New Special Term window to add a new entry to the list of 
compound words and phrases that the product should treat as single keywords 
when parsing queries. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Special Term 

Defines a word or phrase to add or edit in the Special Terms list. This field 
is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Adds the word or phrase to the list, closes the current window, and opens 
the Special Term Detail window. 

Special Term Detail Window 

The Special Term Detail window opens when you do any of the following: 

 Click the Save button on the Create New Special Term window 

 Click the Save button on the Update Special Term window 

 Click the Cancel button on the Update Special Term window 

Use the Special Term Detail window to review a new special term or to review 
changes to an existing special term in the list of compound words and phrases 
that the product should treat as single keywords when parsing queries. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 
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This window contains the following field: 

Special Term 

Displays the word or phrase just added or updated in the Special Terms 
list. This field is read-only. 

This window contains the following button: 

Edit 

Opens the Update Special Term window so you can modify a word or 
phrase defined as a special term. 

 

Update Special Term Window 

The Update Special Term window opens when you do any of the following: 

 Click a special term in the Special Terms List pane 

 Right-click a word or phrase in the Special Terms List pane and select Edit 
from the shortcut menu 

 Click the Edit button on the Special Term Detail window 

Use the Update Special Term window to modify an entry in the list of 
compound words and phrases that the product should treat as single keywords 
when parsing queries. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Special Term 

Defines a word or phrase to add or edit in the Special Terms list. This field 
is required. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Special Term Detail window. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Adds the word or phrase to the list, closes the current window, and opens 
the Special Term Detail window. 
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Synonyms List Pane 

The Synonyms List pane opens when you select either of the following from 
the left pane of the Administration tab: 

 Administration, Knowledge, Knowledge Administration, Synonyms (when 
Unicenter KT is installed) 

 Administration, Knowledge, Keyword Administration, Synonyms (when 
Unicenter KT is not installed) 

When you publish a document to the knowledge base, the product parses the 
information in the Title, Summary, Problem, and Resolution fields of the 
document into keywords. When a user searches the knowledge base, the 
product compares keywords from the user's query with the keywords parsed 
from the knowledge base to produce a result list. 

Synonyms are words or phrases that have the same or nearly the same 
meaning as the keyword with which they are associated. For example, if a 
query contains the word “computer” and "PC" is defined as a synonym of 
"computer", the product returns documents that contain either “computer” or 
“PC”. Use the Synonyms List pane to specify keyword/synonym pairs that the 
product should use interchangeably when parsing documents and queries. 
These keyword/synonym pairs can improve search results. 

If you define a new complex synonym (that is, a synonym containing multiple 
words separated by spaces or other delimiters), you should also create an 
identical special term so that the product can treat the synonym as a single 
entity. For example, if you define "Computer Associates" as a synonym for 
"CA", you should also define "Computer Associates" as a special term. 

You cannot define a synonym or keyword that already exists as a noise word. 

This pane contains the following fields: 

Keyword 

Defines a keyword for which to search. This field only displays when you click 
Show Filter. 

Synonym 

Defines a synonym for which to search. This field only displays when you 
click Show Filter. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 
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Synonyms List 

Displays keyword/synonym pairs defined in the product. For each keyword 
displayed in the Keyword column, the Synonym column displays one or 
more synonyms. 

This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Create New 

Opens the Create New Synonym window so you can define a keyword and 
a synonym to associate with it. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show Filter/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 

Create New Synonym Window 

The Create New Synonym window opens when you click the Create New 
button on the Synonyms List pane 

Use the Create New Synonym window to add a new keyword/synonym pair to 
the list of words that the product should use interchangeably when parsing 
documents and queries. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Keyword 

Defines the word with which to associate a synonym. This field is required. 

Synonym 

Defines a word that the product should use interchangeably with the word 
in the Keyword box when parsing documents or queries. This field is 
required. 
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This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Adds the keyword/synonym pair to the list, closes the current window, and 
opens the Synonym Detail window. 

 

Synonym Detail Window 

The Synonym Detail window opens when you do any of the following: 

 Click the Save button on the Create New Synonym window 

 Click the Save button on the Update Synonym window 

 Click the Cancel button on the Update Synonym window 

Use the Synonym Detail window to review a new keyword/synonym pair or to 
review changes to an existing keyword/synonym pair in the list of words the 
product should treat as interchangeable when parsing documents or queries. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Keyword 

Displays the word with which the specified synonym is associated. 

Synonym 

Displays the word that the product will use interchangeably with the 
specified keyword when parsing documents or queries. 

This window contains the following button: 

Edit 

Opens the Update Synonym window so you can modify a keyword or a 
synonym associated with it. 
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Update Synonym Window 

The Update Synonym window opens when you do any of the following: 

 Click a keyword or synonym on the Synonyms List pane 

 Right-click a keyword or synonym in the Synonyms List pane and select 
Edit from the shortcut menu 

 Click the Edit button on the Synonym Detail window 

Use the Update Synonym window to modify a keyword/synonym pair in the list 
of words that the product should use interchangeably when parsing documents 
and queries. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Keyword 

Defines the word with which to associate a synonym. This field is required. 

Synonym 

Defines a word that the product should use interchangeably with the word 
in the Keyword box when parsing documents or queries. This field is 
required. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the 
Synonym Detail window. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Adds the keyword/synonym pair to the list, closes the current window, and 
opens the Synonym Detail window. 
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Knowledge Categories Pane 

The Knowledge Categories pane opens when you select Administration, 
Knowledge, Knowledge Categories from the left pane of the Administration 
tab. 

Use the Knowledge Categories pane to manage content for each problem-
solving model in the knowledge base. From the Knowledge Categories pane, 
users with system administrator or knowledge manager rights can: 

 Create, publish, and maintain knowledge documents and knowledge tree 
documents 

 Manage the knowledge category structure to make document access easier 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Note: The File menu for this window contains additional commands to help 
you manage document categories. 

This pane has the following components: 

Category Pane 

The left pane, or Category pane, displays the hierarchical categories in 
which the documents comprising the knowledge base are stored. Use the 
Category pane to navigate the knowledge base and to select the category 
whose documents display in the Knowledge Document List pane. 

Knowledge Search Pane 

The Knowledge Search pane at the top of the right pane contains controls 
with which you can specify criteria for and initiate a basic or advanced 
search of the knowledge base. Click Advanced Search to display the 
advanced search fields; click Hide to display only the basic Search box. 
When you click Search, the Knowledge Document List pane shows the list 
of documents that match your search criteria. 

Knowledge Document List Pane 

The lower right pane, or Knowledge Document List pane, displays the 
documents that reside in the category selected from the Category pane. 
Use the Knowledge Document List pane to browse the list of documents in 
a category and to select documents with which to work. You can use the 
controls in the Knowledge Search pane above the Knowledge Document 
List pane to specify criteria by which to determine which documents from 
the current category display. 
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Notes: 

 Right-click a document title in the list to display the Knowledge 
Document administrative shortcut menu. 

 This pane has a vertical split bar that you can drag right or left to 
adjust the size of the panes. 

The left pane, or Category pane, displays the hierarchical categories in which 
the documents comprising the knowledge base are stored. Use the Category 
pane to navigate the knowledge base and to select the category whose 
documents display in the Knowledge Document List pane. 

 

Category Detail Window 

The Category Detail window opens when you do any of the following: 

 Click Save on the Create Category window 

 Click Save on the Update Category window 

 Click Cancel on the Update Category window 

Use the Category Detail window to review the title, description, keywords, and 
permissions defined for a category. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following tabs: 

 Content 

 Permissions 

This window contains the following button: 

Edit 

Opens the Update Category window so you can edit the title, description, 
keywords, and permissions defined for the category. 
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Create Category Window 

The Create Category window opens when you do either of the following: 

 Select a category in the Knowledge Categories pane, then select Add 
Category from the File menu 

 Right-click a category in the Knowledge Categories pane, then select Add 
Category from the shortcut menu 

Use the Create Category window to define attributes and permissions for a 
subcategory to add to the category selected in the Category pane. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following tabs: 

 Content 

 Permissions 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Creates or saves changes to the category, closes the current window, and 
opens the Category Detail window. 
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Create New Comment Window 

The Create New Comment window opens when you click Add Comment on the 
Comments tab on the Create New Document window or the Update Knowledge 
Document window. 

Use the Create New Comment window to enter a brief comment about the 
document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Defines a comment that provides information about the document. This 
field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the comment and opens the View Comment window. 

Create New/Update/Detail Document Windows 

The Create New, Update, and Detail Document windows open when you do 
any of the following: 

 Right-click a category name in the Category pane of the Knowledge 
Categories pane on the Knowledge or Administration tab and select Create 
Knowledge Document or Create Knowledge Tree Document from the 
shortcut menu 

 Right-click a document title in the Knowledge Document List pane of the 
Knowledge Categories pane on the Knowledge or Administration tab and 
select Create Knowledge Document or Create Knowledge Tree Document 
from the shortcut menu 

 Select a category in the Category pane of the Knowledge Categories pane 
on the Knowledge or Administration tab, then select Create Knowledge 
Document or Create Knowledge Tree Document from the File menu 

Administration Tab  127  
 



Knowledge Administration 
 

 Select New Knowledge Document or New Knowledge Tree Document from 
the File menu on the Knowledge tab (when Unicenter KT is installed) or 
the Keyword Search tab (when Unicenter KT is not installed). 

 Click Save on the Create New Document window 

 Right-click a document title in the Knowledge Categories pane on the 
Knowledge or Administration tab and select Open from the shortcut menu 

 Click a document title in the Knowledge Categories pane on the Knowledge 
or Administration tab 

 Right-click a document title in the Knowledge Document List pane on the 
Keyword Search tab and select Edit from the shortcut menu 

 Click Edit from the Knowledge Document window 

 Right-click a document title in the Knowledge Document List pane and 
select Edit from the shortcut menu 

Use the Create New Document window to define the initial content of a new 
knowledge document. 

Important! Make sure you use significant searchable words when filling in the 
Title, Summary, Problem and Resolution text fields, not just noise words. If 
you use only noise words, your document will become inaccessible after it is 
saved and indexed. 

Use the Update Knowledge Document window to update the content, 
attributes, permissions, category and document relationships, attachments, 
comments, and notifications for a document and to review the document's 
history. 

Note: The Update Knowledge Document window appears as the Detail 
Document window, without specifically stating the term update. Use the 
notebook pages to update the document. 

These windows include the Unicenter Service Desk banner, which may contain 
a menu bar, search fields, and other controls to help you work with 
information in Unicenter Service Desk. 

These windows contain one or more of the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 
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 Notifications 

 History 

These windows contain some or all of the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Assign to Category Owner 

This check box lets you indicate whether to assign the new document to a 
category owner. Click the check box to assign the new document to a 
category owner, or click again to un-check. This field in enabled on the 
Create New Document window only. 

Title 

Defines a short, descriptive name for the document. For knowledge tree 
documents, the value in the Title box also defines the name of the primary 
node in the knowledge tree. 

Summary 

Defines a summary that briefly describes the problem associated with the 
document. Use the Problem box to describe the problem in detail. 

Problem 

Defines the full description of the problem associated with the document. 

NLS search type is based on this field. 

Resolution 

Defines the description of how to resolve the problem. Click Edit Resolution 
to open the HTML Editor so you can create or update the resolution. This 
field only displays when you are creating or updating a knowledge 
document. 
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Quick View 

Specifies to display content in the associated field as it will appear at 
runtime. This field only displays when you are creating or updating a 
knowledge document. 

HTML Source 

Specifies to display content in the associated field as editable HTML source 
code. Select this option to make simple changes directly to the HTML code. 
This field only displays when you are creating or updating a knowledge 
document. 

Notes 

Defines additional information about the document. The contents of this 
field are available only to analysts. 

Depending on the approval process task with which the document is currently 
associated, these windows may contain the following buttons: 

Edit 

Opens the Create/Update Document window so you can modify document 
contents and attributes. The edit window will only open if you are a user 
with write permission to the document. If you do not have write 
permission to the document, the read-only view window will open instead. 

Forward 

Opens the Forward Document window so you can assign the document to 
the analyst who will complete the next task in the approval process. When 
you click OK to forward the document, the Forward Document and Update 
Knowledge Document windows close and the Knowledge Document Detail 
window opens. The Forward button displays for all approval process tasks 
except the last (which is, by default, Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Publish 

Opens the Knowledge Document Detail window and makes the document 
available for viewing. 

Note: System administrators can use the Publish button at any time to 
bypass the approval process and immediately publish a document. 
Analysts working on a document can use the Publish button if the 
document is at the last stage of the approval process and ready to be 
published. 
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Reject 

Opens the Reject Document window so you can reject the document, 
reassigning it to the previous assignee. When you click OK to reject the 
document, the Reject Document and Update Knowledge Document 
windows close and the Knowledge Document Detail window opens. The 
Reject button displays for all approval process tasks except the first (which 
is, by default, Create Document. 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Unpublish 

Changes the status of the document from "Published" to draft (or the 
appropriate custom status), and removes the document from the 
knowledge base availability. This button only displays when a document's 
status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

Cancel 

Discards changes and opens view mode. 

Design Tree 

Opens the DT Builder so you can create the knowledge tree structure to 
associate with the document. This button only displays when you are 
creating or updating a knowledge tree document. 

Edit Resolution 

Opens the HTML Editor so you can use plain text or HTML elements to 
design a resolution for the problem that the knowledge document 
addresses. This button only displays when you are creating or updating a 
knowledge document. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves changes to the current document. 
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Note: The Save button is only available on the Update/Create Document 
window if you have write access to the document. A document is read-only 
when it is published (as per Administrative option) or retired, or when the 
document's permissions preclude you from changing it. 

Spell Check All Fields 

Checks the content of the Title, Summary, Problem, Resolution, and Notes 
fields. If the text of any of the fields contains a spelling error (that is, a 
word that does not exist in the product dictionary), the Spell Check Results 
window opens. The window shows the contents of all non-empty fields, 
separated by headers of the form --TITLE--, --SUMMMARY-- and so on, 
with the first misspelled word highlighted. 

Date Helper Window 

The Date Helper window opens when you click  on a window or dialog on 
which you must specify a date and time. 

Use the Date Helper window to select when an event defined by the window or 
dialog from which you accessed the Date Help window occurs. 

This window contains the following fields: 

Month 

Specifies the month during which an event occurs. 

Default: The month during which the Date Helper window opened. 

Year 

Specifies the year during which an event occurs. 

Limits: The year must be in the range 1994 to 2013. 

Default: The year during which the Date Helper window opened. 

Calendar 

Displays the days of the selected month and year. Click a day to select it. 

Default: The day during which the Date Helper window opened. 

24-Hour 

Specifies how to display the values in the Hour list. 

 Select the 24-Hour check box to display values in the Hour list using 
24-hour time format. 

Example: 15. 

Clear the 24-Hour check box to display values in the Hour list using 
12-hour time format. 

Example: 3 pm. 

Default: The check box is cleared. 
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Hour 

Specifies the hour during which an event occurs. 

Default: The hour during which the Date Helper window opened. 

Minute 

Specifies the minute during which an event occurs. 

Default: The minute during which the Date Helper window opened. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Next 

Sets the Month value to the month that follows the current selection and 
refreshes the Calendar control to display the days of the newly selected 
month. 

OK 

Closes the Date Helper window and sets the value of the field from which 
you accessed the window to the selected date and time. 

Prev 

Sets the Month value to the month that precedes the current selection and 
refreshes the Calendar control to display the days of the newly selected 
month. 

Delete Category window 

The Delete Category dialog opens when you do either of the following: 

 Select a category in the Knowledge Categories pane, then select Delete 
Category from the File menu 

 Right-click a category in the Knowledge Categories pane, then choose 
Delete Category from the shortcut menu 

Use the Delete Category dialog to specify whether to delete subcategories and 
documents and to confirm deletion of the selected category. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This dialog contains the following fields: 

Include Subcategories 

Specifies whether the product should delete subcategories of the selected 
category. 
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 Select the Include Subcategories check box to delete all subcategories 
that reside in the selected category. If you also select the Include 
Documents check box, the product deletes documents that reside in 
the subcategories. 

 Clear the Include Subcategories check box to relocate subcategories 
from the selected category to its nearest available parent category. 

Include Documents 

Specifies whether the product should delete documents when it deletes the 
selected category. 

 Select the Include Documents check box to delete documents that 
reside in the selected category. When you select the Include 
Documents check box, the following options display: 

– Delete documents linked by primary category only-Select 
this option to delete only documents for which the selected 
category is the primary category.  

– Delete all documents linked to the category-Select this option 
to delete all documents in the selected category. 

If you also select the Include Subcategories check box, the product 
deletes documents that reside in subcategories of the selected 
category, as indicated by the Delete Documents option you selected. 

 Clear the Include Documents check box to relocate documents from 
the selected category to its nearest available parent category. 

This dialog contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Closes the Delete Category dialog, removes the selected category from the 
Category pane and the knowledge base, and moves or deletes 
subcategories and documents as specified. 
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Email Document window 

The Email Document window opens when you click Email on the Page Options 
menu when viewing a document. 

Use the Email Document window to email a link to the document or a copy of 
the document to specified recipients. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Your Name 

Defines the name (in "last name, first name" format) of the user to 
identify as sender of the email. 

Default: Your name (as specified to the product). 

Your Email 

Defines the email address of the email sender. 

Default: The email address associated with your user account. 

Send To 

Defines the email addresses of contacts to whom you want to send the 
document or link. Enter one or more email addresses, or click  to open 
the Contact Search window so you can search for and select contacts. Use 
semicolons (;) to separate multiple email addresses. 

Subject 

Defines a subject for the email. 

Default: The document's type (Knowledge Document or Knowledge Tree 
Document) and ID. 

Personal Message 

Defines a text message to accompany the document or link you are 
sending. 

Send Document 

Specifies how the product should attach the document to your email. 
Select one of the following options: 

In HTML 

The product inserts the document in the body of the email in HTML 
format. Recipients can view the document directly in the email. 
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Link Only 

The product inserts a URL link in the email. Recipients must click the 
link to display the document in a web browser. 

Default: In HTML. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Closes the Email Document window and sends the email to the specified 
recipients. 

 

Event for Document view window 

The Event for Document window opens when you right-click an Event on the 
History tab of the Update Knowledge Document window and select View from 
the shortcut menu. The fields on this window are read-only. 

Use the Event for Document window to view the detail of the selected event. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Event 

Displays the name of the selected event. 

Event Detail 

Displays the detail information for the selected event. 

Time Stamp 

Displays the date and time (in mm/dd/yyyy hh:mm am/pm format) at 
which the selected event occurred. 

Example: 08/23/2004 04:13 am 
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Knowledge Document Window 

The Knowledge Document window opens when you do either of the following: 

 Click a Knowledge Document icon or title on: 

 The Knowledge Document List on the Knowledge tab. 

 The Knowledge Document List of the Knowledge Documents nodes of 
the Scoreboard on the Knowledge Tools tab. 

 Right-click a knowledge document title in the Knowledge Categories pane 
on the Administration tab, then select Document View from the shortcut 
menu 

 Right-click a knowledge document title in the Knowledge Document List on 
the Knowledge tab and select View from the shortcut menu. 

 Click a Knowledge Document link, for example, under the Top Solutions 
section. 

 Click a Knowledge Document link, for example, under the Top Solutions 
section of Customer or Employee user interface 

 Click a Knowledge Document icon or title in Activities tab of a Request or 
an Issue of KT Log Solution type 

 Click a Knowledge Document icon or title after search on the Knowledge 
tab of a Request or an Issue 

Use the Knowledge Document window to view and interact with a knowledge 
document. 

Note: To create a new document or update an existing document, see Create 
New/Update/Detail Document Windows (see page 127). 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Documents contain a variety of information organized to optimize user access. 
Documents created using the default Built In - Knowledge Document template 
are divided into two areas: 

 The left side of the document (the document body) contains information 
about the problem the document addresses, the suggested resolution for 
the problem, and links to related resources. In addition to the document 
title, specific information displayed may include the following: 

Summary 

Displays a brief description of the problem associated with the document. 

Problem 

Displays the full description of the problem associated with the document. 
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Resolution 

Displays the description of how to resolve the problem. 

See Also 

Displays links to other documents in the knowledge base that are related 
to the current document. Click a link under See Also to open the 
associated document in a new window. 

Attachments 

Displays links to files attached to the document as supplemental 
information. When you click a link, the attached file opens in an 
appropriate application. 

Related Categories 

Displays links to categories that are related to the document. Click a link 
under Related Categories to list the documents that reside in the linked 
category and its subcategories in the Knowledge Document List pane. 

Related Tickets 

Lists any tickets related to this document. 

Properties 

Displays the properties specified in the document template. By default, the 
numeric Document ID and the date on which the document was created 
are displayed. 

Comments 

Displays comments added by document users through the Comment box 
on the document. Each comment displays with the name and email 
address of the contact who entered it and the date the comment was 
entered. 

 The right side of the document contains menus, page option links, solution 
survey fields, and comment fields. 

Page Options 

Displays commands for interacting with the document. Use the Page 
Options commands to edit, email, bookmark, print, close, and subscribe to 
the current document. You can also create a new request or create a new 
request based on the document being viewed, depending on how you 
accessed this window. 

 The Solution Survey and Comments are two boxes that let you rate and 
comment upon the document: 

Solution Survey 

Defines feedback regarding the effectiveness of the document in answering 
your question and lets you open an issue or request. The product uses 
your feedback to calculate the document's FAQ rating. 
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Comment 

Defines comments to add to the document. For example, you might add a 
comment that clarifies the document's resolution. Comments you add 
display under the Comments heading in the document body. 

Note: Documents created using a customized template may contain different 
information. 

Forward Document window 

The Forward Document window opens when you click Forward on the Update 
Knowledge Document window. 

Use the Forward Document window to move a document to the next stage of 
the approval process and to assign the document to an analyst for that stage. 
You can also specify an optional comment for the document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Next Task 

Displays the approval process task to which the document will be 
forwarded. This field is read-only. 

Next Status 

Displays the approval process status to which the document will be 
forwarded. The default statuses are: 

Draft 

The document has been created, and possibly assigned to an analyst 
for review and modification, but is not currently available in the 
knowledge base (that is, it is not published). 

Published 

The document is available in the knowledge base and those users or 
groups with access can view it. 

Retired 

The document has been removed from the knowledge base, either 
manually or as the result of the expiration date passing, and is no 
longer available. 

This field is read-only. 
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Next Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. Select the name of the contact to assign 
the document to, or click  to open the Contact Search window so you can 
locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm forwarding the document to the next approval 
process task. When you click OK, the Forward Document window closes. 
The forwarded document appears in the specified assignee's Inbox in the 
Knowledge Documents folder on the Service Desk tab. 

Knowledge Document Detail window 

The Knowledge Document Detail window opens when you do any of the 
following: 

 Click Cancel on the Update Knowledge Document window 

 Click Publish on the Update Knowledge Document window, then click OK to 
confirm publishing 

 Click OK on the Forward Document window, then click OK to confirm 
forwarding 

 Click OK on the Reject Document window, then click OK to confirm 
rejection 

Use the Knowledge Document Detail window to review the content and 
attributes defined for a document, to unpublish a document, or to preview a 
document as users will see it at runtime. 

This window contains the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 
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 Comments 

 Notifications 

 History 

This window contains the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

This window contains the following buttons: 

Edit 

Opens the Update Knowledge Document window so you can modify 
document contents and attributes. This command only displays for the 
document owner, for system administrators, and when the document 
status is "Unpublished." 

Unpublish 

Changes the status of the document from "Published" to "Unpublished", 
and removes the document from the knowledge base availability. This 
button only displays when a document's status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 
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Knowledge Document List Pane 

The lower right pane, or Knowledge Document List pane, displays the 
documents that reside in the category selected from the Category pane. Use 
the Knowledge Document List pane to browse the list of documents in a 
category and to select documents with which to work. You can use the controls 
in the Knowledge Search pane above the Knowledge Document List pane to 
specify criteria by which to determine which documents from the current 
category display. 

This pane contains the following columns: 

Title 

Displays the title and summary information defined for each document in 
the result set. When you click the document title, the document opens in 
the Update Knowledge Document window. When you right-click the 
document title, the Knowledge Document List shortcut menu opens. 

Attributes 

Displays the attributes for each document in the result set. Use the 
Preferences window to specify which attributes display. By default, the 
Attributes column includes the Document ID, Owner, Modify Date, and 
Status attributes. 

If the Knowledge Document List pane contains more documents than can 
display on a single page, you can use the following browse links at the top of 
the pane to navigate the list: 

<< 

Displays the first page of documents. 

< 

Displays the previous page of documents. 

> 

Displays the next page of documents. 

>> 

Displays the last page of documents. 

List All 

Displays all of the documents in a single scrollable list. 

An indicator at the top of the Knowledge Document List pane displays your 
current position and the total number of documents in the list. 
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The Knowledge Search pane at the top of the right pane contains controls with 
which you can specify criteria for and initiate a basic or advanced search of the 
knowledge base. Click Advanced Search to display the advanced search fields; 
click Hide to display only the basic Search box. When you click Search, the 
Knowledge Document List pane shows the list of documents that match your 
search criteria. 

Advanced search options allow overriding the Knowledge Search Document 
Settings on the Preferences window. 

This pane contains some or all of the following fields: 

Search 

Enter a space-delimited list of words or a phrase which is used to search 
for appropriate documents. 

Search Only In category 

Specifies to search for documents only in the selected category and its 
subcategories. If you do not want to limit your search to the selected 
category and its subcategories, select the Search All Categories option 
instead. This field only displays on the Knowledge tab when you select a 
category other than TOP from the Category pane. 

Search All Categories 

Specifies to search for documents in all categories and subcategories. If 
you want to limit your search to the category selected in the Category 
pane and its subcategories, select the Search Only In category option 
instead. This field only displays on the Knowledge tab when you select a 
category other than TOP from the Category pane. 

Search In 

Specifies which document fields to search for specified keywords. When you 
click Search, the product returns only documents that contain the specified 
keywords in the fields specified by the selected Search In check boxes. Select 
any combination of the following check boxes: 

 Problem 

 Resolution 

 Summary 

 Title 

These check boxes only display when Keyword Search is the selected 
search type. If you select Natural Language Search from the Search Type 
list, the Search In check boxes do not display and the product only 
searches the Problem fields of documents. 

Default: All check boxes are selected. 
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Search Type 

Specifies the type of search to perform. Select one of the following 
options: 

Keyword Search 

Select this option to search for the specified keywords in the Title, 
Summary, Problem, and Resolution fields of documents. Use the 
Search In check boxes to exclude one or more of these fields. 

Natural Language Search 

Select this option to search for the specified text only in the Problem 
fields. Natural Language Search (NLS) allows you to perform a search 
using natural language, which compares the pattern of words 
contained in the query with the patterns of words contained in the 
Problem field of knowledge base documents. 

Default: Keyword Search. 

Match Type 

Specifies the method for text matching during the search. Select one of the 
following options: 

Any of the Words (OR) 

A match occurs when the product finds any of the specified words in a 
document. 

All of the Words (AND) 

A match occurs only when the product finds all of the specified words in a 
document. 

Exact Match 

A match occurs only when the product finds the exact words or phrase 
specified in a document. 

Default: Any of the Words (OR). 

Match 

Specifies the method by which the product searches documents. Select 
one of the following options: 

Whole words 

The search retrieves only documents that contain the entire words 
entered. 
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Words beginning with... 

The search retrieves documents that contain the entire words entered 
or words that begin with the words entered. For example, a search for 
the word "print" also returns documents containing the words "printer" 
or "printing". 

The Match list setting overrides the default set on the Preferences window 
and is only available when you specify keywords or phrases for which to 
search. 

Default: Whole words. 

Order By 

Specifies a criterion by which to sort search results. Select one of the 
following options: 

Asset 

Sorts documents by the name of an associated asset. This field only 
displays for advanced searches in the Knowledge Categories pane on 
the Administration tab. 

Author 

Sorts documents by author name. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Creation Date 

Sorts documents by the date on which they were created, with the 
most recently created documents listed first. This field only displays for 
advanced searches in the Knowledge Categories pane on the 
Administration tab. 

Document ID 

Sorts documents by their product-defined ID number. This field only 
displays for advanced searches in the Knowledge Categories pane on 
the Administration tab. 

Document Type 

Sorts documents by their type (knowledge document or knowledge 
tree document), with knowledge documents listed first. This field only 
displays for advanced searches in the Knowledge Categories pane on 
the Administration tab. 

Expiration Date 

Sorts documents by the date on which they are scheduled to expire, 
with the nearest expiration dates listed first. This field only displays for 
advanced searches in the Knowledge Categories pane on the 
Administration tab. 
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FAQ Rating 

Sorts documents based on their FAQ rating, which considers how often 
the document is accessed, how helpful it has been to users, and its 
age. Documents with the highest FAQ ratings are listed first. 

Hits 

Sorts documents by the number of times users have accessed them, 
with the most frequently accessed documents listed first. Hits may not 
be available for all record types. This field only displays for advanced 
searches on the Knowledge tab. 

Modify Date 

Sorts documents by the date on which they were last modified, with 
the most recently modified documents listed first. 

Owner 

Sorts documents by owner name. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Product 

Sorts documents by the name of an associated product. This field only 
displays for advanced searches in the Knowledge Categories pane on 
the Administration tab. 

Relevance 

Sorts documents by their relevance to the specified search criteria 
(expressed as EXCELLENT, GOOD, and so on). Documents with the 
highest relevance (EXCELLENT) are listed first. 

Solution Count 

Sorts documents by the number of issues or requests they have 
resolved, as reported by users. Documents with the highest solution 
counts are listed first. This field only displays for advanced searches on 
the Knowledge tab. 

Start Date 

Sorts documents by the date on which they become available on the 
document list window, with the nearest start dates listed first. This 
field only displays for advanced searches in the Knowledge Categories 
pane on the Administration tab. 

Status 

Sorts documents by their current approval process status. This field 
only displays for advanced searches in the Knowledge Categories pane 
on the Administration tab. 
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Subject Expert 

Sorts documents by subject expert name. This field only displays for 
advanced searches in the Knowledge Categories pane on the 
Administration tab. 

Summary 

Sorts documents by the content of their summary. This field only 
displays for advanced searches in the Knowledge Categories pane on 
the Administration tab. 

Title 

Sorts documents by title. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Workflow Priority 

Sorts documents by their approval process priority, with the highest 
priority documents listed first. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

This field only displays when Keyword Search is the selected search type. 
If you select Natural Language Search from the Search Type list, the Order 
By list does not display. 

Sort Descending 

Specifies whether to sort retrieved documents in descending order by the 
attribute selected from the Order By list. This field only displays for 
advanced searches in the Knowledge Categories pane on the 
Administration tab. 

 Select the check box to sort retrieved documents in descending (Z to 
A) order. 

 Clear the check box to sort retrieved documents in ascending (A to Z) 
order. 

 Default: Cleared. 

Search in Child Categories 

Specifies whether to include subcategories when filtering documents. This 
field only displays for advanced searches in the Knowledge Categories 
pane on the Administration tab. 

 Select the check box to include subcategories of the category selected 
in the Category pane when searching for documents that match other 
filter settings. 

 Clear the check box to search only in the selected category. 

Status 

Specifies the document status by which to filter documents retrieved. This 
field only displays for advanced searches in the Knowledge Categories 
pane on the Administration tab. The default statuses are: 
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<empty> 

The product returns all documents that match other specified filtering 
criteria, regardless of approval process status. 

Draft 

The product only returns documents whose approval process status is 
"Draft". 

Published 

The product only returns documents whose approval process status is 
"Published". 

Retired 

The product only returns documents whose approval process status is 
"Retired". 

If you create additional document statuses on the Administration tab, the 
Status list includes them. When you select one of these statuses, the 
product only returns documents with the selected status when you click 
Search. 

Default: <empty>. 

Document Type 

Specifies the type of knowledge documents to retrieve. When you click 
Search, the product returns only documents of the specified type. Select 
one of the following options: 

<empty> 

Select this option to return both knowledge documents and knowledge 
tree documents. 

Document 

Select this option to return only knowledge documents. 

Tree Document 

Select this option to return only knowledge tree documents. 

Default: <empty>. 

User Defined ID 

Defines a user-defined ID by which to filter documents retrieved. 

Approval Process Priority 

Specifies the approval process priority (Low, Normal, High, or Emergency) 
by which to filter documents retrieved. When you select no priority (that 
is, you leave <empty> as the field value), the product does not consider 
priority when filtering documents. When you click Search, the product 
returns only documents associated with the specified approval process 
priority. 
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Default: <empty>. 

Owner 

Defines the name of the owner by which to filter documents retrieved. Do 
one of the following: 

 Enter the name of the owner in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select an owner. 

 Enter some or all of the owner name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Owner box. 

When you click search, the product returns only documents associated 
with the specified owner. 

Author 

Defines the author name by which to filter documents retrieved. Do one of 
the following: 

 Enter the name of the author in "last name, first name" format. 

 Click  to open the Contact Search dialog so you can locate and select 
an author. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Author box. 

When you click Search, the product returns only documents associated 
with the specified author. 

Subject Expert 

Defines the expert by which to filter documents retrieved. Do one of the 
following: 

 Enter the name of the expert in "last name, first name" format. 

 Click  to open the Contact Search dialog so you can search for and 
select an expert. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Subject Expert box. 
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When you click Search, the product returns only documents associated 
with the specified subject expert. 

Priority 

Specifies the priority level (1, 2, 3, 4, 5, or None) by which to filter 
documents retrieved. When you select no priority (that is, you leave 
<empty> as the field value), the product does not consider priority when 
filtering documents. When you click Search, the product returns only 
documents with the specified priority. 

Default: <empty>. 

Severity 

Specifies a severity level (1, 2, 3, 4, or 5) by which to filter documents 
retrieved. When you select no severity (that is, you leave <empty> as the 
field value), the product does not consider severity when filtering 
documents. When you click Search, the product returns only documents 
associated with the specified severity level. 

Default: <empty>. 

Product 

Defines a product by which to filter documents retrieved. Enter the name 
of the product in the box, or click  to open the Product Search window so 
you can search for and select one. When you click Search, the product 
returns only documents associated with the specified product. 

Asset 

Defines the name of an asset (hardware, software, or service) by which to 
filter documents retrieved. Enter the name of the asset in the box, or click 

 to open the Asset Search window so you can search for and select one. 
When you click Search, the product returns only documents associated 
with the specified asset. 

Root Cause 

Defines a root cause (that is, the core reason for opening the ticket) by 
which to filter documents retrieved. Possible root causes might include 
Hardware Failure, Software Failure, and Network Cable. Enter the root 
cause in the box, or click  to open the Root Cause Selection window so 
you can search for and select one. When you click Search, the product 
returns only documents associated with the specified root cause. 

Impact 

Specifies the level of impact (1, 2, 3, 4, 5, or none) by which to filter 
documents retrieved. When you select no impact (that is, you leave 
<empty> as the field value), the product does not consider impact when 
filtering documents. When you click Search, the product returns only 
documents associated with the specified impact. 

Default: <empty>. 
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Urgency 

Specifies an urgency level (1, 2, 3, 4, or 5) by which to filter documents 
retrieved. When you select no urgency level (that is, you leave <empty> 
as the field value), the product does not consider urgency when filtering 
documents. When you click Search, the product returns only documents 
associated with the specified urgency level. 

Default: <empty>. 

Solution Count 

Specifies the number of issues resolved by which to filter documents 
retrieved. Select a modifier (greater than, less than, or equal to) from the 
drop-down list, then enter a number in the text box. When you click 
Search, the product returns only documents with the specified number of 
issues resolved. This field only displays for advanced searches in the 
Knowledge Categories pane on the Administration tab. 

Category 

Defines one or more categories by which to filter documents retrieved. 
Click  to open the Category Selection window so you can select a 
category. When you click a category on the Category Selection window, 
the window closes and the Category box refreshes to display the selected 
category path. To remove a category from the Category box, select it and 
click the Remove Category link. To remove all categories from the 
Category box, click the Clear Categories link. When you click Search, the 
product returns only documents associated with the selected categories. 
This field only displays for advanced searches on the Knowledge tab. 

Primary Category 

Defines the primary category by which to filter documents retrieved. Enter 
the primary category name in the box, or click  to open the Knowledge 
Category Search window so you can locate and select one. When you click 
Search, the product returns only documents associated with the specified 
primary category. This field only displays for advanced searches in the 
Knowledge Categories pane on the Administration tab. 

All Categories 

Defines a comma-delimited list of categories by which to filter documents 
retrieved. Enter the category names in the box, or click  to open the 
Knowledge Category Search window so you can locate and select them. 
When you click Search, the product returns only documents associated 
with all of the specified categories. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Earliest Creation Date 
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Defines the earliest creation date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents created after the specified date. This field only 
displays when you click a More link in the Knowledge Search pane. This 
field only displays for advanced searches in the Knowledge Categories 
pane on the Administration tab. 

Latest Creation Date 

Defines the latest creation date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example, 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents created before the specified date. This field only 
displays when you click a More link in the Knowledge Search pane. This 
field only displays for advanced searches in the Knowledge Categories 
pane on the Administration tab. 

Earliest Modify Date 

Defines the earliest modification date and time by which to filter 
documents retrieved. Enter the date and time in mm/dd/yyyy hh:mm 
am/pm format (for example, 07/27/2004 08:15 am), or click  to open 
the Date Helper window so you can select them. When you click Search, 
the product returns only documents modified after the specified date. This 
field only displays when you click a More link in the Filter or Knowledge 
Search pane. This field only displays for advanced searches in the 
Knowledge Categories pane on the Administration tab. 

Latest Modify Date 

Defines the latest modification date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example, 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents modified before the specified date. This field only 
displays when you click a More link in the Knowledge Search pane. This 
field only displays for advanced searches in the Knowledge Categories 
pane on the Administration tab. 

Earliest Start Date 

Defines the earliest availability date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example, 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents that became available in the knowledge base after 
the specified date. This field only displays when you click a More link in the 
Knowledge Search pane. This field only displays for advanced searches in 
the Knowledge Categories pane on the Administration tab. 
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Latest Start Date 

Defines the latest availability date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example, 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents that became available in the knowledge base 
before the specified date. This field only displays when you click a More 
link in the Knowledge Search pane. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Earliest Expiration Date 

Defines the earliest expiration date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example, 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents scheduled for removal from the knowledge base 
after the specified date. This field only displays when you click a More link 
in the Knowledge Search pane. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Latest Expiration Date 

Defines the latest expiration date and time by which to filter documents 
retrieved. Enter the date and time in mm/dd/yyyy hh:mm am/pm format 
(for example, 07/27/2004 08:15 am), or click  to open the Date Helper 
window so you can select them. When you click Search, the product 
returns only documents scheduled for removal from the knowledge base 
before the specified date. This field only displays when you click a More 
link in the Knowledge Search pane. This field only displays for advanced 
searches in the Knowledge Categories pane on the Administration tab. 

Title 

Defines a document title by which to filter documents retrieved. When you 
click Search, the product returns only documents with the specified title. 
This field only displays when you click a More link in the Knowledge Search 
pane. 

Summary 

Defines a document summary by which to filter documents retrieved. 
When you click Search, the product returns only documents with the 
specified summary. This field only displays when you click a More link in 
the Knowledge Search pane. 

Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 
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This pane contains the following buttons: 

Advanced Search 

Expands the Knowledge Search pane to include advanced search fields so 
you can enter criteria to more precisely define your search. The Hide 
button replaces the Advanced Search button when the advanced search 
fields are displayed. 

Hide 

Hides the advanced search fields on the Knowledge Search pane. The 
Advanced Search button replaces the Hide button when the advanced 
search fields are hidden. 

Reset Search 

Returns fields on the Knowledge Search pane to their original values (that 
is, to their values before you made changes). 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Edit in List 

This button displays the appropriate Update window, allowing you to make 
changes to the record currently selected in the List window, or all the 
items in the list if you use the Change All button. Only the fields displayed 
in the list window may be updated. This feature can be used to make quick 
changes to the items in the list window. 

For example,on the SLA Map List window, you could change all the Service 
Types for all records in the list using the Change All button. 

Note: The "Edit in List" button feature for the fields Owner and Assignee 
for published documents will give you an error when using the default 
workflow settings. This is by default, because the workflow related fields 
may not be modified for published documents. 
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Knowledge Tree Document Window 

The Knowledge Tree Document window opens when you do any of the 
following: 

 Right-click a knowledge tree document title in the Knowledge Categories 
pane, then select Document View from the shortcut menu 

 Click a knowledge tree document title in the Knowledge Document List on 
the Knowledge tab 

 Right-click a knowledge tree document title in the Knowledge Document 
List on the Knowledge tab, then select View from the shortcut menu. 

Use the Knowledge Tree Document window to view and interact with a 
knowledge tree document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Documents contain a variety of information organized to optimize user access. 
Documents created using the default Built In - Knowledge Tree Document 
template are divided into three areas: 

 The left pane contains a dynamic map of the document. The bottom entry 
in the map indicates the current location in the document. Use the map in 
the left pane as necessary to navigate to previously viewed branches of 
the knowledge tree document. 

 The right pane contains the knowledge tree document, a menu, and two 
boxes that let you rate and comment upon it the document. This pane 
contains the following components: 

Document View 

Displays the document as a knowledge tree. In this mode, the window 
contains information about the problem the document addresses, the 
suggested resolution for the problem, and links to related resources. 
To view the document as a knowledge tree, click the Display button 
under the Resolution heading. 

Tree Navigation 

Provides navigation to nodes in the knowledge tree that you have 
already viewed. The following links may be available: 

 Tree Description-Displays a description of the purpose of the 
knowledge tree document, if one was defined. 

 Start Over-Returns to the first page of the document. 

 Prev-Returns to the previous page of the document. 
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 Next-Returns to the next page of the document. 

 Last-Returns to the last viewed page of the document. 

Page Options menu 

Displays commands for interacting with the document. Use the Page 
Options commands to edit, email, bookmark, print, close, and 
subscribe to the current document.You can also create a new request 
or create a new request based on the document being viewed, 
depending on how you accessed this window. 

Solution Survey 

Defines feedback regarding the effectiveness of the document in 
answering your question and lets you open an issue or request. The 
product uses your feedback to calculate the document's FAQ rating. 

Comment 

Defines comments to add to the document. For example, you might 
add a comment that clarifies the document's resolution. Comments 
you add display under the Comments heading in the document body. 

Note: Documents created using a customized template may contain different 
information. 

Preferences Window 

The Preferences Settings window opens when you do either of the following: 

 Select Preferences from the View menu 

 Click Edit on the Preferences Detail window 

Use the Preferences window to set default Knowledge Tools behaviors. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Avoid Popups 

Specifies whether to reduce the number of new browser windows opened 
by displaying new forms in the main browser window whenever possible. 

 Select the check box to minimize the number of new browser windows 
opened. 

 Clear the check box to open new browser windows according to the 
properties set in the form definition. 

Default: Cleared. 
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Note: If this option is selected, the Back to List button will be activated, 
and can be used to navigate from detail forms back to the previously 
displayed list window. The Back to List button will appear in the upper 
right-hand side of the window. 

Display Score Count 

Specifies whether you want to display the score count left-justified. 

Default: Cleared. 

Keep Log Reader Window 

Specifies whether to keep the Log Reader window open when you select 
the Close All Popups command from the Window menu and after you log 
off of Knowledge Tools. This setting has no effect when the Log Reader 
window is not open. 

 Select the check box to keep the Log Reader window open. 

 Clear the check box to close the Log Reader window when you select 
the Close All Popups command or log off of Knowledge Tools. 

Default: Selected. 

Preserve Popup Size 

Specifies whether to open new popup windows with the same dimensions 
as the most recently resized popup window. 

 Select the check box to use the new dimensions for new popup 
windows. 

 Clear the check box to open new popup windows with default 
dimensions. 

Default: Selected. 

Note: If you set Preserve Popup Size to on (checked), and you maximize a 
popup window, subsequent popup windows may cover any other Service 
Desk window you may have open. However, new popup windows will 
appear slightly off the screen, to the right and lower. This is because there 
is a 10 pixel (left and top) offset for popups - so that they do not 
completely overlay the currently displayed window. It is recommended 
that you do not maximize popup windows when using the Preserve Popup 
Size option. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 
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Using Screen Reader 

Selecting this preference modifies Service Desk behavior for optimal use 
with a screen reader for blind and limited vision users. You must log off 
and log back on again after changing this preference. From the Service 
Desk Help menu, select the item "Screen Reader Usage", for an overview 
of using Service Desk with a screen reader. 

Search Type 

Specifies the default type of search to perform. Select one of the following 
options: 

Keyword Search 

Select this option to search for the specified keywords in the Title, 
Summary, Problem, and Resolution fields of documents. 

Natural Language Search 

Select this option to search for the specified keywords in the Problem 
fields of documents. 

The Search Type field displayed when you click Show Filter in the 
Knowledge Document List pane overrides this setting. 

Default: Keyword Search. 

Match Type 

Specifies the default method for text matching during a search. Select one 
of the following options: 

Any of the Words (OR) 

A match occurs if the product finds any of the words specified in the 
Keywords for Advanced Search box in a document. 

All of the Words (AND) 

A match occurs only if the product finds all of the words specified in 
the Keywords for Advanced Search box in a document. 

Exact Phrase 

A match occurs only if the product finds the exact phrase specified in 
the Keywords for Advanced Search box in a document. 

The Match Type field displayed when you click Show Filter in the 
Knowledge Document List pane overrides this setting. 

Default: Any of the Words (OR). 

Match 

Specifies the default method by which the product searches documents. 
Select one of the following options: 
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Whole words 

The search retrieves only documents that contain the entire words 
entered. 

Words beginning with... 

The search retrieves documents that contain the entire words entered 
or words that begin with the words entered. For example, a search for 
the word "print" also returns documents containing the words "printer" 
or "printing". 

The Match field displayed when you click Show Filter in the Knowledge 
Document List pane overrides this setting. 

Default: Whole words. 

Order By 

Specifies the default property by which to sort documents retrieved. The 
Order By field displayed when you click Show Filter in the Knowledge 
Document List pane overrides this setting. 

Default: Relevance. 

Search In 

Specifies which document fields to search for specified keywords. When you 
click Search, the product returns only documents that contain the specified 
keywords in the fields specified by the selected Search In check boxes. Select 
any combination of the following check boxes: 

 Problem 

 Resolution 

 Summary 

 Title 

These check boxes only display when Keyword Search is the selected 
search type. If you select Natural Language Search from the Search Type 
list, the Search In check boxes do not display and the product only 
searches the Problem fields of documents. 

Default: All check boxes are selected. 

Documents Per Page (Knowledge Document List Settings) 

Specifies the number of documents (25 or 50) to display on each page of 
the Knowledge Document List pane. 

Default: 25. 

Show Document List Details 

Specifies whether detailed information displays in the Knowledge 
Document List pane on the Knowledge tab. 

Select the check box to display the following default information: 
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 Title 

 Summary 

 Document ID 

 Modify Date 

Clear the check box to display only the document title. 

Default: The check box is selected. 

Documents Per Page (Knowledge Categories Document List Settings) 

Specifies the number of documents (25 or 50) to display on each page of 
the Knowledge Document List pane. 

Default: 25. 

Attributes to be shown in list 

Displays two lists with which you can define the properties that display for 
each document in the Knowledge Document List pane on the Knowledge 
Categories pane of the Administration tab. 

 To display a property in the Knowledge Document List pane, select it 
from the Available List and use the > (Select Item) button to move it 
to the Selected list. 

 To move all of the properties from the Available list to the Selected 
list, click >> (Select All Available Items). 

 To remove a property from the Knowledge Document List pane, select 
it from the Selected list and use the < (Remove Item from Selected 
List) button to move it to the Available list. 

 To move all of the the properties from the Selected list to the Available 
list, click << (Remove All Items from Selected List). 

To select multiple items in either the Available or Selected list, hold down 
the Ctrl key while you click each item you want to select or hold down the 
Shift key while you click the first and last items in a series. 

Default: DOC ID, Owner, Assignee, Modify Date, and Document Status 
display in the Selected list. 

Note: Choosing attributes different than the Preference default may 
impact performance. If you believe that extra display columns are needed, 
contact the system administration and ask them to use the Web Screen 
Painter utility to modify the default page columns for the Document List 
form. 

Active Zone 

From the drop down list, select the active zone for your Global Knowledge 
Tools environment, for example, your organization's Intranet. 
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This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Preferences Detail window (see page 161). 

Preferences Detail window 

The Preferences Detail window opens when you click Save or Cancel on the 
Preferences window. 

Use the Preferences Detail window to review default Knowledge Tools 
behaviors. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Avoid Popups 

When selected, will reduce the number of new browser windows opened by 
displaying new forms in the main browser window whenever possible. 

Note: If this option is selected, the Back to List button will be activated, 
and can be used to navigate from detail forms back to the previously 
displayed list window. The Back to List button will appear in the upper 
right-hand side of the window. 

Display Score Count 

Displays the score count as left-justified.. 

Keep Log Reader Window 

Displays whether the product will keep the Log Reader window open when 
you select the Close All Popups command from the Window menu and 
after you log off of Unicenter SD. This setting has no effect when the Log 
Reader window is not open. 

Preserve Popup Size 

Displays whether the product will open new popup windows with the same 
dimensions as the most recently resized popup window. 
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Note: If you set Preserve Popup Size to on (checked), and you maximize a 
popup window, subsequent popup windows may cover any other Service 
Desk window you may have open. However, new popup windows will 
appear slightly off the screen, to the right and lower. This is because there 
is a 10 pixel (left and top) offset for popups - so that they do not 
completely overlay the currently displayed window. It is recommended 
that you do not maximize popup windows when using the Preserve Popup 
Size option. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Using Screen Reader 

Selecting this preference modifies Service Desk behavior for optimal 
use with a screen reader for blind and limited vision users. You must 
log off and log back on again after changing this preference. From the 
Service Desk Help menu, select the item "Screen Reader Usage", for 
an overview of using Service Desk with a screen reader. 

Search Type 

"Using" indicates the type of search to perform. Select either Keyword 
Search or Natural Language Search. 

Match Type 

Displays the default method for text matching during a search. Possible 
values are Any of the Words (OR), All of the Words (AND), and Exact 
Phrase. 

Match 

Displays the default method by which the product searches documents, 
either Whole Words or Words Beginning With. 

Order By 

Displays the default property by which the product will sort documents 
retrieved. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Search In 

Displays which document fields the product will search for specified 
keywords. These check boxes only display when Keyword Search is the 
selected search type. 
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Documents Per Page (Knowledge Document List Settings) 

Displays the number of documents (10, 25, or 50) that the product will 
display on each page of the Knowledge Document List pane. 

Show Document List Details 

Displays whether the Knowledge Document List pane on the Knowledge 
tab includes detailed information. If the check box is selected, the 
following default information displays: 

 Title 

 Summary 

 Document ID 

 Modify Date 

If the check box is cleared, on the document title displays. 

Documents Per Page (Knowledge Categories Document List Settings) 

Displays the number of documents (10, 25, or 50) that the product will 
display on each page of the Knowledge Document List pane. 

Attributes to be shown in list 

Displays the properties listed for each document in the Knowledge 
Document List pane of the Knowledge Categories pane on the 
Administration tab. 

Note: Choosing attributes different than the Preference default may 
impact performance. If you believe that extra display columns are needed, 
contact the system administration and ask them to use the Web Screen 
Painter utility to modify the default page columns for the Document List 
form. 

Active Zone 

From the drop down list, select the active zone for your Global Knowledge 
Tools environment, for example, your organization's Intranet. 

This window contains the following buttons: 

Edit 

Opens the Preferences Window (see page 156) so you can modify 
preferences. 
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Preview Window (User View) 

The Preview window opens when you do either of the following: 

 Click User View on the Update Knowledge Document window 

 Click User View on the Knowledge Document Detail window 

 Right-click a Document in the Document List in the Knowledge Categories 
window under the Administration tab, and select User View 

Use the Preview window to view the current document as it will display to 
users at runtime. This enables you to verify your design before you publish the 
document. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Use the Print command in the Page Options menu on the upper right side of 
the Preview window to opens a standard Windows Print dialog so you can 
specify options for printing the contents of the current document. 

Reject Document Window 

The Reject Document window opens when you click Reject on the Update 
Knowledge Document window. 

Use the Reject Document window to move a document to a previous approval 
process task and assign an analyst to the document for that task. When 
multiple previous tasks exist, system administrators can choose the approval 
process task to which the document will revert. Assignees without 
administrator privileges can reject the document back to the previous task in 
the approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 
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Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Previous Tasks 

Lists approval process tasks to which the document can revert. This field 
only displays if the current assignee has administrator privileges and there 
are multiple previous tasks in the approval process. 

For each task, the Previous Tasks list displays the assignee who completed 
the task and the date on which the document was forwarded. When you 
click a task name to select the task to which to reject the document, the 
Reject Document window refreshes so you can specify an assignee and 
enter a comment. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm rejecting the document to a previous approval 
process task. When you click OK, the Reject Document window closes and 
the rejected document appears in the specified assignee's Inbox in the 
Knowledge Document folder on the Service Desk tab. 
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The Spell Check Results window opens when you check spelling or click the 
Spelling button. The spell checker scans the header or body information and 
displays each unrecognized word in the Spell Check Results window. Use the 
window to specify what action to take on such words. When you correct or 
otherwise act upon a word, the product moves to the next unrecognized word, 
and so on until it has scanned the entire header or body. 

You can use the Spell Check Results window to do the following: 

 Correct the spelling of a specific occurrence of the unrecognized word in 
the template header or body 

 Correct the spelling of all occurrences of the unrecognized word in the 
template header or body 

 Select a word to replace the unrecognized word 

 Ignore a specific occurrence of the unrecognized word in the template 
header or body 

 Ignore all occurrences of the unrecognized word in the template header or 
body 

This window contains the following fields: 

Not in Dictionary 

Displays the word that the product has identified as misspelled (that is, 
not in the product dictionary). 

Limits: This field is read-only. 

Change To 

Displays the word in the product dictionary that is the closest in spelling to 
the unrecognized word or the current selection from the Suggestions list. 

You can accept the spelling of the replacement as presented or type an 
alternate spelling in the Change To box, then do one of the following: 

 Click Change. The product changes the current occurrence of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

 Click Change All. The product changes all occurrences of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

Suggestions 

Specifies words that are close in spelling to the unrecognized word. When 
you select a word from the list, it displays in the Change To box. 

Context 

Displays the unrecognized word in the context in which it is used in the 
template. 
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Editing the text in the Context box has no effect on the template's 
contents. 

This window contains the following buttons: 

Change 

Changes the current occurrence of the word in the Not in Dictionary field 
to the word in the Change To box. 

Change All 

Changes all instances of the word in the Not in Dictionary field to the word 
in the Change To box. 

Close 

Closes the document, window, or dialog. 

Ignore 

Disregards the current instance of the unrecognized word and advances to 
the next unrecognized word. If there are no additional unrecognized 
words, the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 

Ignore All 

Disregards all instances of the unrecognized word and advances to the 
next unrecognized word. If there are no additional unrecognized words, 
the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 

Unpublish Document Window 

The Unpublish Document window opens when you do either of the following: 

 Click Unpublish on the Update Knowledge Document window 

 Click Unpublish on the Knowledge Document Detail window 

Use the Unpublish Document window to remove the document from the 
knowledge base so it is no longer available to users. If you have administrator 
privileges, you can use the Unpublish Document window to retire the 
document (that is, remove it from the knowledge base and the approval 
process) or select the approval process task to which the document will revert. 
If you do not have administrator privileges, the document reverts to the 
previous task in the approval process. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 
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Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Previous Tasks 

Lists approval process tasks to which the document can revert. This field 
only displays if the current assignee has administrator privileges and there 
are multiple previous tasks in the approval process. 

For each task, the Previous Tasks list displays the default assignee for the 
task. When you click a task name to select the task to which to unpublish 
the document, the Unpublish Document window refreshes so you can 
specify an assignee and enter a comment. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 
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This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm unpublishing the document to a previous approval 
process task. When you click OK, the Unpublish Document window closes 
and the unpublished document appears in the specified assignee's Inbox in 
the Knowledge Documents folder on the Service Desk tab. 

Retire this Document 

Prompts you to confirm retiring the selected document. When you click 
OK, the Unpublish Document window closes and the product removes the 
document from the knowledge base and the approval process. 

Unretire Document Window 

The Unretire Document window opens when you click Unretire on the Update 
Knowledge Document window. 

Use the Unretire Document window to return a retired document to the 
knowledge base and workflow. If you are a system administrator, you can 
republish the document or (when multiple tasks exist) choose the approval 
process task to which the document will return. Assignees without 
administrator privileges can return the document to the previous task in the 
approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 
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 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm unretiring the document to the selected approval 
process task. When you click OK, the Unretire Document window closes 
and the document appears in the specified assignee's Inbox in the 
Knowledge Documents folder on the Service Desk tab. 

Publish this Document 

Unretires and publishes the document. When you click Publish this 
Document, the product prompts you to confirm the action. Click OK to 
close the message and the Unretire Document window, and republish the 
document. 
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Update Category Window 

The Update Category window opens when you do either of the following: 

 Select a category from the Knowledge Categories pane, then select Edit 
Category from the File menu 

 Right-click a category in the Knowledge Categories pane, then select Edit 
Category from the shortcut menu 

 Click Edit on the Category Detail window 

Use the Update Category window to update attributes and permissions for the 
category selected in the Category pane. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following tabs: 

 Content 

 Permissions 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Creates or saves changes to the category, closes the current window, and 
opens the Category Detail window. 
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Update Comment Window 

The Update Comment window opens when you do any of the following: 

 Click Edit on the View Comment window 

 Click a comment on the Comments tab of the Update Knowledge 
Document window 

 Right-click a comment on the Comments tab of the Update Knowledge 
Document window, then select Edit from the shortcut menu 

Use the Update Comment window to edit a comment associated with the 
current document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Defines a comment that provides information about the document. This 
field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the comment and opens the View Comment window. 

The Update Knowledge Document window opens when you do any of the 
following: 

 Click Save on the Create New Document window 

 Right-click a document title in the Knowledge Categories pane on the 
Administration tab and select Open from the shortcut menu 

 Click a document title in the Knowledge Categories pane on the 
Administration tab 

 Right-click a document title in the Knowledge Document List pane on the 
Keyword Search tab and select Edit from the shortcut menu 
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Use the Update Knowledge Document window to update the content, 
attributes, permissions, category and document relationships, attachments, 
comments, and notifications for a document and to review the document's 
history. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 

 Notifications 

 History 

This window contains the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Depending on the approval process task with which the document is currently 
associated, this window may contain the following buttons: 

Cancel 

Discards changes, closes the current window, and opens the Knowledge 
Document Detail window. 
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Forward 

Opens the Forward Document window so you can assign the document to 
the analyst who will complete the next task in the approval process. When 
you click OK to forward the document, the Forward Document and Update 
Knowledge Document windows close and the Knowledge Document Detail 
window opens. The Forward button displays for all approval process tasks 
except the last (which is, by default, Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Publish 

Opens the Knowledge Document Detail window and makes the document 
available for viewing. 

Note: System administrators can use the Publish button at any time to 
bypass the approval process and immediately publish a document. 
Analysts working on a document can use the Publish button if the 
document is at the last stage of the approval process and ready to be 
published. 

Reject 

Opens the Reject Document window so you can reject the document, 
reassigning it to the previous owner and task. When you click OK to reject 
the document, the Reject Document and Update Knowledge Document 
windows close and the Knowledge Document Detail window opens. The 
Reject button displays for all approval process tasks except the first (which 
is, by default, Create Document) and the last (which is, by default, 
Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves changes to the current document and (as appropriate) notifies 
analysts of the changes. 

Note: The Save button is only available on the Update/Create Document 
window if you have write access to the document. A document is read-only 
when it is published (as per Administrative option) or retired, or when the 
document's permissions preclude you from changing it. 
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Unpublish 

Changes the status of the document from "Published" to "Unpublished", 
and removes the document from the knowledge base availability. This 
button only displays when a document's status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

 

View Comment Window 

The Comment for Document Detail window opens when you do any of the 
following: 

 Click Save on the Create New Comment window 

 Click Save on the Update Comment window 

 Click Cancel on the Update Comment window 

 Right-click a comment on the Comments tab of the Update Knowledge 
Document window and select View from the shortcut menu 

Use the View Comment window to review a comment you added or edited for 
a document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Displays a comment that provides information about the document you are 
editing, forwarding, rejecting, publishing, unpublishing, or unretiring. This 
field is read-only. 

This window contains the following buttons: 

Close 

Closes the document, window, or dialog. 

Edit 

Opens the Update Comment window so you can modify the comment. 
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Windows window 

The Windows window opens when you select List All Windows from the 
Window menu on the Knowledge tab. 

Use the Windows window to view a list of windows that Knowledge Tools 
currently has open and to navigate directly to a specific open window. 

To move focus (that is, navigate) to a specific window, click its name on the 
Windows window. 

This window contains the following buttons: 

Close Window 

Closes the current window. 

Refresh 

Updates the list of open windows. 
 

System Administration 
The following panes are available for System Administration: 

 FAQ Options pane (see page 179) 

 General Settings pane (see page 179) 

 Parse Settings pane (see page 180) 

 Report Card pane (see page 183) 

 Search Options pane (see page 185) 
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FAQ Options pane 

The FAQ Settings Window opens when you select Administration, Knowledge, 
Solution Survey, FAQ Settings from the left pane of the Administration tab. 

Use the FAQ Settings Window to set parameters by which the product 
calculates the FAQ rating assigned to each document. The product bases the 
FAQ rating on the following criteria: 

 How frequently the document was accessed in the past 

 How helpful the document was to users 

 How the document's effectiveness has decreased over time 

By default, the document list window displays documents sorted in order of 
FAQ rating (that is, in order of usefulness). The most useful documents 
“bubble up” to the top of the document list. Over time, documents tend to 
move downward in the document list as users learn solutions to the problems. 

This pane contains the following fields: 

Last Updated 

Specifies whether to run the FAQ Rating Service and displays the date on 
which FAQ ratings were last updated. 

 Select the Run the FAQ Rating Service check box to run the FAQ 
calculation service using the settings on this window. 

 Clear the Run the FAQ Rating Service check box to turn off the FAQ 
calculation service. 

Schedule 

Defines the frequency at which the product updates FAQ ratings. This field 
contains the following components: 

Perform the FAQ Calculation Every... 

Specifies the time that elapses before the product updates the FAQ 
rating for documents. 

Default: 1 day. 

From... 

Specifies the time of day that the product should begin recalculating 
FAQ ratings. 

Default: 00:00 (12:00 A.M.). 

To... 

Specifies the time of day that the product should stop recalculating 
FAQ ratings, regardless of whether the calculation is finished. 

Default: 07:00 (7:00 A.M.). 
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Note: This setting initially takes effect the day after product installation. 
For example, if you install the product on April 19, 2005, the FAQ server 
runs for the first time on April 20, 2005. 

Aging 

Defines the number of times a document's FAQ rating will be recalculated 
before it reaches 0. Based on the specified value, the document's FAQ 
rating decreases and eventually becomes 0, at which point it appears at 
the bottom of the document list (when the list is sorted by FAQ Rating). 

Default: 180. 

Example: If the Aging value is 180 for a document with a rating of 4 (very 
helpful), the document's FAQ rating will be 0 when the product has 
recalculated the FAQ rating 180 times. 

Note: By default, the FAQ bubble-up calculation requires bu_trans data for 
the last 180 days, where 180 is the aging factor. So, if you change the 
aging factor for FAQ to more than 365 days, you should extend the archive 
rules for the bu_trans table accordingly. 

Days New 

Specifies the number of days that a newly created or imported document 
displays in the New Documents folder on the Knowledge tab. 

Default: 5 days. 

Rating 

Specifies the default rating (Not Helpful at All, Somewhat Helpful, or Very 
Helpful) for documents that users have opened but not rated. 

Default: Somewhat Helpful. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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General Settings pane 

The General Settings pane opens when you select Administration, Knowledge, 
System Administration, General Settings from the left pane of the 
Administration tab. 

Use the General Settings pane to set the default information to display on the 
Knowledge tab at logon, the format in which categories display in the 
Knowledge Categories pane on the Administration tab, and the number of 
documents to list in the Top Solutions list on the Knowledge Tools home page. 

Important! It is critical that you set an Assignee to receive document 
indexing notifications in the Document Indexing Notifications section. An email 
address must be defined for this assignee on the Contact Notification page to 
enable email notifications. 

General Settings contain the following sections: 

Search Tool Opening Screen 

Specifies the information displayed by default on the Knowledge tab. 
Select one of the following options: 

Open with FAQ/Search 

Displays the Category, Knowledge Search, and Knowledge Document 
List panes. 

Open with Knowledge Tree Document ID 

Displays the knowledge tree with the document ID specified in the field 
provided. You can return to the knowledge tree document itself, and 
then to the Category, Knowledge Search, and Knowledge Document 
List panes. 

Default: Open with FAQ/Search. 

Category Viewing 

Specifies the format in which document categories display in the 
Knowledge Categories pane on the Administration tab. Select one of the 
following options: 

Display categories in tree view 

Presents categories in a hierarchical tree structure in the Knowledge 
Categories pane. Categories expand to reveal associated 
subcategories. In this manner, you can view all the categories in the 
tree simultaneously. 

Display categories in list view 

Presents categories in a list format in the Knowledge Categories pane. 
When you select a category, its subcategories display in a list. You can 
view only the current level of categories or subcategories at one time. 
Use the Up One Level link to return to the previous category level. 
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Note: If you have more than 250 categories under the top category, 
or under any category, use the Display Categories in List View option 
and not the tree view. 

Top Solutions 

Specifies the number of documents to list in the Top Solutions list on the 
Unicenter SD home page. 

Default: 10. 

Document Indexing Notifications 

Sets a user to receive email notifications about status or when errors occur 
with document indexing. The user must have an email address in the 
ca_contacts table to receive these email notifications. Use the Notification 
Page for the assignee's contact record for setting notification methods. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 

Parse Settings pane 

The Parse Settings pane opens when you select either of the following from 
the left pane of the Administration tab: 

 Administration, Knowledge, System Administration, Parse Settings (when 
Unicenter KT is installed) 

 Administration, Knowledge, Settings, Parse Settings (when Unicenter KT is 
not installed) 

When you publish a document to the knowledge base, the product parses the 
information in the Title, Summary, Problem, and Resolution fields of the 
document into keywords. When a user searches the knowledge base, the 
product compares keywords from the user's query with the keywords parsed 
from the knowledge base to produce a result list. 

Use the Parse Settings pane to define the settings used to parse documents in 
the knowledge base. 

This pane contains the following fields: 

Maximum Search Keywords 

Defines the maximum number of keywords to extract when the product 
parses the search text. 

180  Administrator Guide 
 



System Administration 
 

Default: 20 

Note: The valid range is 1-100, so that a Service Desk Knowledge 
administrator can change the value within this range, based on search 
needs and parameters of a specific Knowledge database. Use a lower 
number of search keywords for faster performance. 

Language 

Specifies the language type to use for parse processing. Select one of the 
following settings: 

English 

Performs certain types of processing specific to the English language 
(for example, de-pluralizing search terms) during a search, if 
applicable. 

Non-English 

Performs only non-English specific processing during the search. 

Default: English. 

Valid Character Range 

Defines the range of alphanumeric characters to consider valid when 
parsing the Title, Summary, Problem, and Resolution fields in a document. 
The product treats any other characters as separators. 

Note: When you select Yes from the Recognize Special Terms list, the 
product does not parse words and phrases defined as special terms. 

Default: a-z, which indicates that the alphabetic characters a through z 
are valid characters for parsing. 

Remove Similar Words 

Specifies whether the product should remove structurally similar keywords 
from the groups used in a search. Select one of the following settings: 

Yes 

Removes structurally similar keywords from the search criteria. 

Note: When you select Yes, the product also removes similar words 
when you save or publish the document. This can impact whether a 
document is searchable if the Remove Similar Words box was set to 
Yes. The similar word may have not been indexed and used in the later 
search and retrieval of the document. 

No 

Leaves structurally similar keywords in the search criteria. 

Default: No. 
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Remove Noise Words 

Specifies whether the product should remove noise words when parsing 
the Title, Summary, Problem, and Resolution fields in a document. Select 
one of the following settings: 

Yes 

Removes noise words from the search criteria. 

No 

Leaves noise words in the search criteria. 

Default: Yes. 

Recognize Special Terms 

Specifies whether the product should consider special terms as single 
entities or as multiple words when parsing the Title, Summary, Problem, 
and Resolution fields in a document. Select one of the following settings: 

Yes 

Processes special terms as single entities in the search criteria. 

No 

Processes the words that comprise special terms as separate entities in 
the search criteria. 

Default: Yes. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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Report Card pane 

The Report Card pane opens when you select Administration, Knowledge, 
Knowledge Report Card from the left pane of the Administration tab. 

The Knowledge Report Card provides feedback to analysts, knowledge 
engineers, knowledge managers, supervisors, category owners, and system 
administrators about which knowledge documents are most effective. The 
information provided can be used in a variety of ways to improve the 
processes of creating knowledge documents and providing the best support to 
customers. 

Use the Report Card pane to define the schedule at which the product 
calculates and sends notifications about the Knowledge Report Card and to 
define the content of Knowledge Report Card notification emails. 

This pane contains the following fields: 

Last Updated 

Displays the date and time on which the Report Card service was last 
updated. This field is read-only. 

Report Card Calculation will be Run Every xxx 

Specifies the frequency with which to recalculate the Report Card 
statistics. 

Default: Never. 

Report Card Email Notifications will be Sent Every xxx 

Specifies the frequency with which to send Report Card notifications. 

Default: Never. 

Report Card Email Should Display Statistics for the Past xxx 

Specifies the amount of time for which the Report Card notification should 
contain information. This field is only available when you select a value 
other than Never from the Report Card Email Notifications will be Sent 
Every xxx list. 

Default: 365 days. 

Start the Report Card Service at hh:mm 

Specifies the time at which to start the Report Card service. This field is 
only available when you select a value other than Never from the Report 
Card Calculation will be Run Every xxx list. 

Default: 03:00. 

Subject 

Defines a subject for the email. 

Default: Knowledge Report Card Notification. 
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Body 

Defines the content of the Report Card notification email. The product 
provides default content for this email that contains placeholders for which 
data is inserted at runtime. When the HTML Source option is selected, you 
can edit the text directly in the Body box. Click Edit Body to open the 
HTML Editor so you can make more complex changes to the email content. 

Important! If you do edit the Body text, be careful to maintain the code 
that generates the statistics that appear in the email notification, for 
example: 

<a name=my_stats/> for the beginning of the user's statistics 
<a name=end_my_stats/> for the end of the user's statistics 
 
<a name=org_stats/> for the beginning of the user's organization 
statistics 
<a name=end_org_stats/> for the end of the user's organization statistics 
 
<a name=overall_stats/> for the beginning of the all organization 
statistics 
<a name=end_overall_stats/> for the end of the all organization statistics 

Quick View 

Displays content in read-only format as it will display at runtime. 

HTML Source 

Displays HTML source code used to define content. Select this option to 
make simple changes directly to the HTML code. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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Search Options pane 

The Search Options pane opens when you select either of the following from 
the left pane of the Administration tab: 

 Administration, Knowledge, System Administration, Search Options (when 
Unicenter KT is installed) 

 Administration, Knowledge, Settings, Search Options (when Unicenter KT 
is not installed) 

Use the Search Options page to set default search options for use on the 
Knowledge tab and the Knowledge Search pane. 

Note: These settings only apply to users who have not specified personal 
search settings on the Preferences window. Users can specify additional search 
options in the Knowledge Search pane on the Knowledge tab or in the 
Knowledge Categories pane on the Administration tab. 

This pane contains the following fields: 

Default Search Type 

Specifies the default search type for users who have not specified their 
own default search options. Select one of the following options: 

Keyword 

Bases searches on the presence or absence of keywords in the Title, 
Summary, Problem, and Resolution fields (or a subset of these, as 
determined by the values set for other options). 

NLS 

Matches search text submitted by the user against the value of the 
Problem field of each document. NLS (Natural Language Search) 
compares word patterns in the search string with word patterns in the 
Problem fields of potentially related documents and adds the most 
relevant documents to the result set. 

Note: When NLS is selected, some other options in the pane will not 
be available. 

Default: Keyword. 

Using 

Specifies the default criteria used to perform text matching during 
searches. Select one of the following options: 

Any of the words (OR) 

Includes a document in the result set when it contains any of the 
words in the Search box. 
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All of the words (AND) 

Includes a document in the result set only when it contains all of the 
words in the Search box. 

Default: Any of the words (OR). 

Allow Search in Resolution Field 

Specifies whether searches may include the Resolution field. This field only 
displays when the Default Search Type option is set to Keyword. 

 Select the check box to give users the option to include the Resolution 
field in keyword searches. 

 Note: Including the Resolution field in keyword searches may impact 
performance because Resolution fields can contain large amounts of 
text. 

 Clear the check box to deny users the option to include the Resolution 
field in keyword searches. 

Default: The check box is selected. 

Default Search Fields 

Specifies which document fields to include by default in keyword searches. 
Select a check box to include the associated field in default searches. Clear 
a check box to exclude the associated field from default searches. You can 
select whether to include the following document fields: 

 Title 

 Summary 

 Problem 

 Resolution (only available when the Allow Search in Resolution Field 
check box is selected) 

This field only displays when the Default Search Type option is set to 
Keyword. 

Default: All options are selected. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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Service Desk Integration 
The following panes are available for Service Desk integration: 

 Field Mapping pane (see page 187) 

 Issue Search Configuration pane (see page 190) 

 Request Search Configuration pane (see page 191) 

Field Mapping pane 

The Field Mapping pane opens when you select either of the following from the 
left pane of the Administration tab: 

 Administration, Knowledge, System Administration, Service Desk 
Integration, Field Mapping (when Unicenter KT is installed) 

 Administration, Knowledge, Settings, Service Desk Integration, Field 
Mapping (when Unicenter KT is not installed) 

Use the Field Mapping pane to specify which Unicenter SD fields to populate 
with Unicenter KT information, and whether to overwrite existing information. 

This pane contains the following fields: 

Populate Service Desk Values from Knowledge Tools 

Specifies whether to use information from Unicenter KT to populate fields 
in Unicenter SD issues or requests. 

 Select the check box to make fields in the Knowledge Tools, Populate 
Empty Service Desk Values, and Overwrite Service Desk Values 
columns available so you can specify which Unicenter KT information 
to use to populate fields in Unicenter SD issues or requests. 

 Clear the check box to make fields in the Knowledge Tools, Populate 
Empty Service Desk Values, and Overwrite Service Desk Values 
unavailable. In this case, users must manually populate Unicenter SD 
issues or requests created from Unicenter KT. 

Default: This check box is selected. 

Service Desk 

Identifies the fields in Unicenter SD issues or requests that correspond to 
Unicenter KT fields listed in the Knowledge Tools column. 

For each check box selected in the Populate Empty Service Desk Values 
column, information from the corresponding field in the Knowledge Tools 
column will populate the Unicenter SD issue or request. 
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The Service Desk column lists the following fields: 

 Summary 

 Description 

 Root Cause 

 Product 

 Asset 

 Severity 

 Impact 

 Urgency 

 Service Desk Priority 

 Request Area 

 Parent 

Knowledge Tools 

Identifies the Unicenter KT fields that correspond to the Unicenter SD 
fields listed in the Service Desk column. 

For each check box selected in the Populate Empty Service Desk Values 
column, information from the corresponding field in the Knowledge Tools 
column will populate the Unicenter SD issue or request. 

The Knowledge Tools column contains two drop-down lists: 

 The first drop-down list corresponds to the Summary field in the 
Service Desk column and specifies the Unicenter KT field (Title, 
Summary, or Problem) with which to populate the Summary field in a 
Unicenter SD issue or request. 

Default: Summary. 

The second drop-down list corresponds to the Description field in the 
Service Desk column and specifies the Unicenter KT field (Title, 
Summary, or Problem) with which to populate the Description field in a 
Unicenter SD issue or request. 

Default: Problem. 

The Knowledge Tools column also lists the following fields: 

 Root Cause 

 Product 

 Asset 

 Severity 

 Impact 

 Urgency 
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 Approval Process Priority 

 Category 

 Parent 

Populate Empty Service Desk Values 

Specifies which empty fields in a Unicenter SD issue or request to populate 
with information from Unicenter KT. 

 Select a check box to map information from the Unicenter KT field to 
the corresponding Unicenter SD field if that field currently contains no 
information. 

 Clear a check box if you do not want to map information from the 
Unicenter KT field to the corresponding Unicenter SD field. 

Default: The check boxes corresponding to the Summary, Description, 
Product, Asset, and Request Area fields in Unicenter SD are selected. 

Overwrite Service Desk Values 

Specifies which fields in a Unicenter SD issue or request to overwrite with 
information from Unicenter KT. 

 Select a check box to replace information in the Unicenter SD field 
with information from the corresponding Unicenter KT field. 

 Clear a check box if you do not want to replace information in the 
Unicenter SD field with information from the corresponding Unicenter 
KT field. 

These check boxes are only available when the corresponding check boxes 
in the Populate Empty Service Desk Values column are selected. 

Default: All Overwrite Service Desk Values check boxes are cleared. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 

 

Administration Tab  189  
 



Service Desk Integration 
 

Issue Search Configuration pane 

The Issue Search Configuration pane opens when you select either of the 
following from the left pane of the Administration tab: 

 Administration, Knowledge, Service Desk Integration, Issue Search 
Configuration (when Unicenter KT is installed) 

 Administration, Knowledge, Settings, Service Desk Integration, Issue 
Search Configuration (when Unicenter KT is not installed) 

Use the Issue Search Configuration pane to select the fields to search when 
you click the Search Knowledge button on a ticket. 

This screen controls which fields from the ticket are copied to the 
corresponding fields in the Search Filter on the the Knowledge tab of an Issue 
Detail window. The population of the Search Filter fields from the ticket occurs 
when the Knowledge tab is selected or the Reset Filter button (on the 
Knowledge tab) is clicked. 

On the Search Configuration window, the selection of Summary and 
Description is exclusive - you cannot select both. When you are in the edit 
window of an Issue, this choice controls where the Search Knowledge button 
appears. When you select Description on the Search Configuration window, the 
Search Knowledge button will appear above the Description field of a ticket. If 
you choose Summary, it will appear above the Summary. When the Search 
Knowledge button is clicked, it will bring the Knowledge tab into view, 
populate the fields of the Search Filter, and perform the knowledge search. 

The Search Configuration windows are only available when the full KT product 
is installed. If the full KT product is not installed, these windows are hidden, 
and the Search Filter (Knowledge tab of a ticket) uses the simplified Keyword 
Search format. In this case, only the ticket summary is used to populate 
Search Filter. 

This pane contains the following fields: 

Service Desk Field 

The Service Desk Field column lists the following fields: 

 Summary 

 Description 

 Asset 

 Severity 

 Impact 

 Urgency 

 Priority 
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 Category 

 Root Cause 

 Product 

Use this Information 

Under "Use this information",  check the boxes for the fields you want to 
search when clicking the Search Knowledge button on a ticket. 

Default: The check boxes corresponding to the Summary and Description 
Service Desk fields are selected. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 

Request Search Configuration pane 

The Request Search Configuration pane opens when you select either of the 
following from the left pane of the Administration tab: 

 Administration, Knowledge, System Administration, Service Desk 
Integration, Request Search Configuration (when Unicenter KT is installed) 

 Administration, Knowledge, Settings, Service Desk Integration, Request 
Search Configuration (when Unicenter KT is not installed) 

Use the Request Search Configuration pane to select the fields to search when 
you click the Search Knowledge button on a ticket. 

This screen controls which fields from the ticket are copied to the 
corresponding fields in the Search Filter on the the Knowledge tab of an 
Request Detail window. The population of the Search Filter fields from the 
ticket occurs when the Knowledge tab is selected or the Reset Filter button (on 
the Knowledge tab) is clicked. 

On the Search Configuration window, the selection of Summary and 
Description is exclusive - you cannot select both. When you are in the edit 
window of a Request, this choice controls where the Search Knowledge button 
appears. When you select Description on the Search Configuration window, the 
Search Knowledge button will appear above the Description field of a ticket. If 
you choose Summary, it will appear above the Summary. When the Search 
Knowledge button is clicked, it will bring the Knowledge tab into view, 
populate the fields of the Search Filter, and perform the knowledge search. 
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The Search Configuration windows are only available when the full KT product 
is installed. If the full KT product is not installed, these windows are hidden, 
and the Search Filter (Knowledge tab of a ticket) uses the simplified Keyword 
Search format. In this case, only the ticket summary is used to populate 
Search Filter. 

This pane contains the following fields: 

Service Desk Field 

The Service Desk Field column lists the following fields: 

Summary 

 Description 

 Asset 

 Severity 

 Impact 

 Urgency 

 Priority 

 Request Area 

 Root Cause 

Use this Information 

Under "Use this information",  check the boxes for the fields you want to 
search when clicking the Search Knowledge button on a ticket. 

Default: The check boxes corresponding to the Summary and Description 
Service Desk fields are selected. 

This pane contains the following buttons: 

Reset Defaults 

Returns all fields on the pane, window, or dialog to their default values. 

Save 

Saves and applies your settings and (when appropriate) closes the pane, 
window, or dialog. 
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Chapter 7: Knowledge Tab 
The Knowledge tab is the main interface for providing Unicenter KT users with 
access to documents in the knowledge base to quickly resolve issues. From the 
Knowledge tab, users can: 

 Browse categories of documents and view documents by category 

 Perform natural language (NLS) and keyword searches of the knowledge 
base 

 Filter and sort documents 

 Open and work with information provided by knowledge documents and 
knowledge tree documents 

 Create a new document by right-clicking a node and selecting either 
Create Knowledge Document or Create New Knowledge Tree Document 

 Bookmark documents to quickly find frequently referenced knowledge 
sources 

 Submit knowledge for possible inclusion in the knowledge base 

Users with analyst, knowledge engineer, knowledge manager, or system 
administrator rights can access the Administration tab, which is the centralized 
console for managing content for each problem-solving model in the 
knowledge base. 

This tab has the following components: 

Category pane 

The left pane, or Category pane, displays the hierarchical categories in 
which the documents comprising the knowledge base are stored. It also 
includes the My Bookmarks folder (which contains documents you have 
bookmarked for quick access) and the New Documents folder (which 
contains documents created in the last n days). Use the Category pane to 
navigate the knowledge base and to select the category whose documents 
display in the Knowledge Document List pane. 

Menu Bar 

The menu bar on the Knowledge tab provides access to the File, View, 
Reports, Window, and Help menus. 

Knowledge Search pane 

The Knowledge Search pane at the top of the right pane contains controls 
with which you can specify criteria for and initiate a basic or advanced 
search of the knowledge base. Click Advanced Search to display the 
advanced search fields; click Hide to display only the basic Search box. 
When you click Search, the Knowledge Document List pane shows the list 
of documents that match your search criteria. 
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Knowledge Document List pane 

The right pane, or Knowledge Document List pane, displays the documents 
that reside in the folder or category selected from the Category pane. Use 
the Knowledge Document List pane to browse the list of documents in a 
folder or category and to select documents with which to work. 

This tab has a vertical split bar that you can drag right or left to adjust the size 
of the panes. 

 

Windows 
The Knowledge tab provides access to a number of windows to help you 
access multiple knowledge modules and perform rapid knowledge base 
searches to quickly resolve issues. Typically, a window opens when you select 
a command from a menu or click a button in another window. For example, 
when you select Preferences from the View menu, the Preferences window 
opens. 

 

Add File window 

The Add File window opens when you do either of the following: 

 Right-click a folder or repository in the Repositories list from the 
Administration tab and select Add File from the shortcut menu 

 Right-click a folder or repository in the Repositories list on the 
Attachments tab on the Update Knowledge Document window and select 
Add File from the shortcut menu 

Use the Add File window to specify the location and name of a file to upload to 
the attachment library. When you click Upload, the product puts the specified 
file in the folder or repository you selected. 

This window contains the following fields: 

File 

Defines the location and name of a file to upload to the attachment library. 
If you click the Browse button, a standard Windows Choose File window 
opens so you can choose the file to upload. 

Example: C:\mydirectory\myfile.doc 

Name 

Enter an internal name that you can use to track the file. 
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Description 

Enter an internal description of the file, for example, what the file is for, 
what it contains, or other descriptive text. 

This window contains the following buttons: 

Browse 

Opens a standard Windows Choose File window on which you can navigate 
to and select a file to upload. 

Upload 

Uploads the specified file to the attachment library and displays a prompt 
when the upload finishes. Click OK to close the prompt. 

Close 

Closes the document, window, or dialog. 
 

Category Selection window 

The Category Selection window opens when you click  on the Category box 
in the Knowledge Search pane on the Knowledge tab. 

The Category Selection window displays the hierarchical categories in which 
documents comprising the knowledge base reside. Use the window to select 
categories and subcategories in which to search. 

Click  or  as necessary to open and close branches of the category tree. 
When you click a category or subcategory on the Category Selection window, 
the window closes and the selected category path appears in the Category box 
in the Knowledge Search pane. To close the window without selecting a 
category, click Close Window. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 
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Create New Comment window 

The Create New Comment window opens when you click Add Comment on the 
Comments tab on the Create New Document window or the Update Knowledge 
Document window. 

Use the Create New Comment window to enter a brief comment about the 
document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Defines a comment that provides information about the document. This 
field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the comment and opens the View Comment window. 

Create New/Update/Detail Document Windows 

The Create New, Update, and Detail Document windows open when you do 
any of the following: 

 Right-click a category name in the Category pane of the Knowledge 
Categories pane on the Knowledge or Administration tab and select Create 
Knowledge Document or Create Knowledge Tree Document from the 
shortcut menu 

 Right-click a document title in the Knowledge Document List pane of the 
Knowledge Categories pane on the Knowledge or Administration tab and 
select Create Knowledge Document or Create Knowledge Tree Document 
from the shortcut menu 

 Select a category in the Category pane of the Knowledge Categories pane 
on the Knowledge or Administration tab, then select Create Knowledge 
Document or Create Knowledge Tree Document from the File menu 
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 Select New Knowledge Document or New Knowledge Tree Document from 
the File menu on the Knowledge tab (when Unicenter KT is installed) or 
the Keyword Search tab (when Unicenter KT is not installed). 

 Click Save on the Create New Document window 

 Right-click a document title in the Knowledge Categories pane on the 
Knowledge or Administration tab and select Open from the shortcut menu 

 Click a document title in the Knowledge Categories pane on the Knowledge 
or Administration tab 

 Right-click a document title in the Knowledge Document List pane on the 
Keyword Search tab and select Edit from the shortcut menu 

 Click Edit from the Knowledge Document window 

 Right-click a document title in the Knowledge Document List pane and 
select Edit from the shortcut menu 

Use the Create New Document window to define the initial content of a new 
knowledge document. 

Important! Make sure you use significant searchable words when filling in the 
Title, Summary, Problem and Resolution text fields, not just noise words. If 
you use only noise words, your document will become inaccessible after it is 
saved and indexed. 

Use the Update Knowledge Document window to update the content, 
attributes, permissions, category and document relationships, attachments, 
comments, and notifications for a document and to review the document's 
history. 

Note: The Update Knowledge Document window appears as the Detail 
Document window, without specifically stating the term update. Use the 
notebook pages to update the document. 

These windows include the Unicenter Service Desk banner, which may contain 
a menu bar, search fields, and other controls to help you work with 
information in Unicenter Service Desk. 

These windows contain one or more of the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 
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 Notifications 

 History 

These windows contain some or all of the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Assign to Category Owner 

This check box lets you indicate whether to assign the new document to a 
category owner. Click the check box to assign the new document to a 
category owner, or click again to un-check. This field in enabled on the 
Create New Document window only. 

Title 

Defines a short, descriptive name for the document. For knowledge tree 
documents, the value in the Title box also defines the name of the primary 
node in the knowledge tree. 

Summary 

Defines a summary that briefly describes the problem associated with the 
document. Use the Problem box to describe the problem in detail. 

Problem 

Defines the full description of the problem associated with the document. 

NLS search type is based on this field. 

Resolution 

Defines the description of how to resolve the problem. Click Edit Resolution 
to open the HTML Editor so you can create or update the resolution. This 
field only displays when you are creating or updating a knowledge 
document. 

198  Administrator Guide 
 



Windows 
 

Quick View 

Specifies to display content in the associated field as it will appear at 
runtime. This field only displays when you are creating or updating a 
knowledge document. 

HTML Source 

Specifies to display content in the associated field as editable HTML source 
code. Select this option to make simple changes directly to the HTML code. 
This field only displays when you are creating or updating a knowledge 
document. 

Notes 

Defines additional information about the document. The contents of this 
field are available only to analysts. 

Depending on the approval process task with which the document is currently 
associated, these windows may contain the following buttons: 

Edit 

Opens the Create/Update Document window so you can modify document 
contents and attributes. The edit window will only open if you are a user 
with write permission to the document. If you do not have write 
permission to the document, the read-only view window will open instead. 

Forward 

Opens the Forward Document window so you can assign the document to 
the analyst who will complete the next task in the approval process. When 
you click OK to forward the document, the Forward Document and Update 
Knowledge Document windows close and the Knowledge Document Detail 
window opens. The Forward button displays for all approval process tasks 
except the last (which is, by default, Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Publish 

Opens the Knowledge Document Detail window and makes the document 
available for viewing. 

Note: System administrators can use the Publish button at any time to 
bypass the approval process and immediately publish a document. 
Analysts working on a document can use the Publish button if the 
document is at the last stage of the approval process and ready to be 
published. 
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Reject 

Opens the Reject Document window so you can reject the document, 
reassigning it to the previous assignee. When you click OK to reject the 
document, the Reject Document and Update Knowledge Document 
windows close and the Knowledge Document Detail window opens. The 
Reject button displays for all approval process tasks except the first (which 
is, by default, Create Document. 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Unpublish 

Changes the status of the document from "Published" to draft (or the 
appropriate custom status), and removes the document from the 
knowledge base availability. This button only displays when a document's 
status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

Cancel 

Discards changes and opens view mode. 

Design Tree 

Opens the DT Builder so you can create the knowledge tree structure to 
associate with the document. This button only displays when you are 
creating or updating a knowledge tree document. 

Edit Resolution 

Opens the HTML Editor so you can use plain text or HTML elements to 
design a resolution for the problem that the knowledge document 
addresses. This button only displays when you are creating or updating a 
knowledge document. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves changes to the current document. 
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Note: The Save button is only available on the Update/Create Document 
window if you have write access to the document. A document is read-only 
when it is published (as per Administrative option) or retired, or when the 
document's permissions preclude you from changing it. 

Spell Check All Fields 

Checks the content of the Title, Summary, Problem, Resolution, and Notes 
fields. If the text of any of the fields contains a spelling error (that is, a 
word that does not exist in the product dictionary), the Spell Check Results 
window opens. The window shows the contents of all non-empty fields, 
separated by headers of the form --TITLE--, --SUMMMARY-- and so on, 
with the first misspelled word highlighted. 

Date Helper window 

The Date Helper window opens when you click  on a window or dialog on 
which you must specify a date and time. 

Use the Date Helper window to select when an event defined by the window or 
dialog from which you accessed the Date Help window occurs. 

This window contains the following fields: 

Month 

Specifies the month during which an event occurs. 

Default: The month during which the Date Helper window opened. 

Year 

Specifies the year during which an event occurs. 

Limits: The year must be in the range 1994 to 2013. 

Default: The year during which the Date Helper window opened. 

Calendar 

Displays the days of the selected month and year. Click a day to select it. 

Default: The day during which the Date Helper window opened. 

24-Hour 

Specifies how to display the values in the Hour list. 

 Select the 24-Hour check box to display values in the Hour list using 
24-hour time format. 

Example: 15. 

Clear the 24-Hour check box to display values in the Hour list using 
12-hour time format. 

Example: 3 pm. 
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Default: The check box is cleared. 

Hour 

Specifies the hour during which an event occurs. 

Default: The hour during which the Date Helper window opened. 

Minute 

Specifies the minute during which an event occurs. 

Default: The minute during which the Date Helper window opened. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Next 

Sets the Month value to the month that follows the current selection and 
refreshes the Calendar control to display the days of the newly selected 
month. 

OK 

Closes the Date Helper window and sets the value of the field from which 
you accessed the window to the selected date and time. 

Prev 

Sets the Month value to the month that precedes the current selection and 
refreshes the Calendar control to display the days of the newly selected 
month. 

Email Document window 

The Email Document window opens when you click Email on the Page Options 
menu when viewing a document. 

Use the Email Document window to email a link to the document or a copy of 
the document to specified recipients. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Your Name 

Defines the name (in "last name, first name" format) of the user to 
identify as sender of the email. 

Default: Your name (as specified to the product). 
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Your Email 

Defines the email address of the email sender. 

Default: The email address associated with your user account. 

Send To 

Defines the email addresses of contacts to whom you want to send the 
document or link. Enter one or more email addresses, or click  to open 
the Contact Search window so you can search for and select contacts. Use 
semicolons (;) to separate multiple email addresses. 

Subject 

Defines a subject for the email. 

Default: The document's type (Knowledge Document or Knowledge Tree 
Document) and ID. 

Personal Message 

Defines a text message to accompany the document or link you are 
sending. 

Send Document 

Specifies how the product should attach the document to your email. 
Select one of the following options: 

In HTML 

The product inserts the document in the body of the email in HTML 
format. Recipients can view the document directly in the email. 

Link Only 

The product inserts a URL link in the email. Recipients must click the 
link to display the document in a web browser. 

Default: In HTML. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Closes the Email Document window and sends the email to the specified 
recipients. 
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Event for Document View window 

The Event for Document window opens when you right-click an Event on the 
History tab of the Update Knowledge Document window and select View from 
the shortcut menu. The fields on this window are read-only. 

Use the Event for Document window to view the detail of the selected event. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Event 

Displays the name of the selected event. 

Event Detail 

Displays the detail information for the selected event. 

Time Stamp 

Displays the date and time (in mm/dd/yyyy hh:mm am/pm format) at 
which the selected event occurred. 

Example: 08/23/2004 04:13 am 

Forward Document window 

The Forward Document window opens when you click Forward on the Update 
Knowledge Document window. 

Use the Forward Document window to move a document to the next stage of 
the approval process and to assign the document to an analyst for that stage. 
You can also specify an optional comment for the document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Next Task 

Displays the approval process task to which the document will be 
forwarded. This field is read-only. 
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Next Status 

Displays the approval process status to which the document will be 
forwarded. The default statuses are: 

Draft 

The document has been created, and possibly assigned to an analyst 
for review and modification, but is not currently available in the 
knowledge base (that is, it is not published). 

Published 

The document is available in the knowledge base and those users or 
groups with access can view it. 

Retired 

The document has been removed from the knowledge base, either 
manually or as the result of the expiration date passing, and is no 
longer available. 

This field is read-only. 

Next Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. Select the name of the contact to assign 
the document to, or click  to open the Contact Search window so you can 
locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm forwarding the document to the next approval 
process task. When you click OK, the Forward Document window closes. 
The forwarded document appears in the specified assignee's Inbox in the 
Knowledge Documents folder on the Service Desk tab. 
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Knowledge Document List pane 

The Knowledge Document List lists the documents that reside in the category 
selected from the Category pane item selected. Initially, the Knowledge Search 
(see page Error! Bookmark not defined.) window displays, allowing you to 
perform a standard or advanced search. Use the filter controls to specify 
criteria by which to search for documents from the current category or folder, 

display or select (if you accessed this window from a field lookup  link). 

By default, the document list is sorted by FAQ rating (see below), so that the 
Top category presents the most usable documents of the entire knowledge 
base. 

Right-click a document in the list to display the document shortcut menu (see 
page Error! Bookmark not defined.). 

This pane contains the following columns: 

Title 

By default, displays the title and summary information defined for each 
document in the result set. When you click the document title, the 
document opens. When you right-click the document, the Knowledge 
Document List shortcut menu opens. 

Attributes 

Displays the attributes for each document in the result set. Use the 
Preferences window to specify which attributes display. By default, the 
Attributes column includes the Document ID and Modify Date attributes. 

If the Knowledge Document List pane contains more documents than can 
display on a single page, you can use the following browse links at the top of 
the pane to navigate the list: 

<< 

Displays the first page of documents. 

< 

Displays the previous page of documents. 

> 

Displays the next page of documents. 

>> 

Displays the last page of documents. 

List All 

Displays all of the documents in a single scrollable list. 
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An indicator at the top of the Knowledge Document List pane displays your 
current position and the total number of documents in the list. 

This pane contains the following field: 

Order By 

Specifies the order in which to display documents in the selected category 
and its subcategories. Select one of the following options: 

FAQ Rating 

Sorts documents based on their FAQ rating, which considers how often 
the document is accessed, how helpful it has been to users, and its 
age. Documents with the highest FAQ ratings are listed first. 

Hits 

Sorts documents by the number of times users have accessed them, 
with the most frequently accessed documents listed first. 

Modify Date 

Sorts documents by the date on which they were last modified, with 
the most recently modified documents listed first. 

Solution Count 

Sorts documents by the number of issues or requests they have 
resolved, as reported by users. Documents with the highest solution 
counts are listed first. 

Default: FAQ Rating. 

Knowledge Document Detail window 

The Knowledge Document Detail window opens when you do any of the 
following: 

 Click Cancel on the Update Knowledge Document window 

 Click Publish on the Update Knowledge Document window, then click OK to 
confirm publishing 

 Click OK on the Forward Document window, then click OK to confirm 
forwarding 

 Click OK on the Reject Document window, then click OK to confirm 
rejection 

Use the Knowledge Document Detail window to review the content and 
attributes defined for a document, to unpublish a document, or to preview a 
document as users will see it at runtime. 
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This window contains the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 

 Notifications 

 History 

This window contains the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

This window contains the following buttons: 

Edit 

Opens the Update Knowledge Document window so you can modify 
document contents and attributes. This command only displays for the 
document owner, for system administrators, and when the document 
status is "Unpublished." 

Unpublish 

Changes the status of the document from "Published" to "Unpublished", 
and removes the document from the knowledge base availability. This 
button only displays when a document's status is "Published". 
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If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

Knowledge Tree Document window 

The Knowledge Tree Document window opens when you do any of the 
following: 

 Right-click a knowledge tree document title in the Knowledge Categories 
pane, then select Document View from the shortcut menu 

 Click a knowledge tree document title in the Knowledge Document List on 
the Knowledge tab 

 Right-click a knowledge tree document title in the Knowledge Document 
List on the Knowledge tab, then select View from the shortcut menu. 

Use the Knowledge Tree Document window to view and interact with a 
knowledge tree document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Documents contain a variety of information organized to optimize user access. 
Documents created using the default Built In - Knowledge Tree Document 
template are divided into three areas: 

 The left pane contains a dynamic map of the document. The bottom entry 
in the map indicates the current location in the document. Use the map in 
the left pane as necessary to navigate to previously viewed branches of 
the knowledge tree document. 

 The right pane contains the knowledge tree document, a menu, and two 
boxes that let you rate and comment upon it the document. This pane 
contains the following components: 

Document View 

Displays the document as a knowledge tree. In this mode, the window 
contains information about the problem the document addresses, the 
suggested resolution for the problem, and links to related resources. 
To view the document as a knowledge tree, click the Display button 
under the Resolution heading. 
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Tree Navigation 

Provides navigation to nodes in the knowledge tree that you have 
already viewed. The following links may be available: 

 Tree Description-Displays a description of the purpose of the 
knowledge tree document, if one was defined. 

 Start Over-Returns to the first page of the document. 

 Prev-Returns to the previous page of the document. 

 Next-Returns to the next page of the document. 

 Last-Returns to the last viewed page of the document. 

Page Options menu 

Displays commands for interacting with the document. Use the Page 
Options commands to edit, email, bookmark, print, close, and 
subscribe to the current document. You can also create a new request 
or create a new request based on the document being viewed, 
depending on how you accessed this window. 

Solution Survey 

Defines feedback regarding the effectiveness of the document in 
answering your question and lets you open an issue or request. The 
product uses your feedback to calculate the document's FAQ rating. 

Comment 

Defines comments to add to the document. For example, you might 
add a comment that clarifies the document's resolution. Comments 
you add display under the Comments heading in the document body. 

Note: Documents created using a customized template may contain different 
information. 

Preferences Window 

The Preferences Settings window opens when you do either of the following: 

 Select Preferences from the View menu 

 Click Edit on the Preferences Detail window 

Use the Preferences window to set default Knowledge Tools behaviors. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 
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This window contains the following fields: 

Avoid Popups 

Specifies whether to reduce the number of new browser windows opened 
by displaying new forms in the main browser window whenever possible. 

 Select the check box to minimize the number of new browser windows 
opened. 

 Clear the check box to open new browser windows according to the 
properties set in the form definition. 

Default: Cleared. 

Note: If this option is selected, the Back to List button will be activated, 
and can be used to navigate from detail forms back to the previously 
displayed list window. The Back to List button will appear in the upper 
right-hand side of the window. 

Display Score Count 

Specifies whether you want to display the score count left-justified. 

Default: Cleared. 

Keep Log Reader Window 

Specifies whether to keep the Log Reader window open when you select 
the Close All Popups command from the Window menu and after you log 
off of Knowledge Tools. This setting has no effect when the Log Reader 
window is not open. 

 Select the check box to keep the Log Reader window open. 

 Clear the check box to close the Log Reader window when you select 
the Close All Popups command or log off of Knowledge Tools. 

Default: Selected. 

Preserve Popup Size 

Specifies whether to open new popup windows with the same dimensions 
as the most recently resized popup window. 

 Select the check box to use the new dimensions for new popup 
windows. 

 Clear the check box to open new popup windows with default 
dimensions. 

Default: Selected. 
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Note: If you set Preserve Popup Size to on (checked), and you maximize a 
popup window, subsequent popup windows may cover any other Service 
Desk window you may have open. However, new popup windows will 
appear slightly off the screen, to the right and lower. This is because there 
is a 10 pixel (left and top) offset for popups - so that they do not 
completely overlay the currently displayed window. It is recommended 
that you do not maximize popup windows when using the Preserve Popup 
Size option. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Using Screen Reader 

Selecting this preference modifies Service Desk behavior for optimal use 
with a screen reader for blind and limited vision users. You must log off 
and log back on again after changing this preference. From the Service 
Desk Help menu, select the item "Screen Reader Usage", for an overview 
of using Service Desk with a screen reader. 

Search Type 

Specifies the default type of search to perform. Select one of the following 
options: 

Keyword Search 

Select this option to search for the specified keywords in the Title, 
Summary, Problem, and Resolution fields of documents. 

Natural Language Search 

Select this option to search for the specified keywords in the Problem 
fields of documents. 

The Search Type field displayed when you click Show Filter in the 
Knowledge Document List pane overrides this setting. 

Default: Keyword Search. 

Match Type 

Specifies the default method for text matching during a search. Select one 
of the following options: 

Any of the Words (OR) 

A match occurs if the product finds any of the words specified in the 
Keywords for Advanced Search box in a document. 

All of the Words (AND) 

A match occurs only if the product finds all of the words specified in 
the Keywords for Advanced Search box in a document. 
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Exact Phrase 

A match occurs only if the product finds the exact phrase specified in 
the Keywords for Advanced Search box in a document. 

The Match Type field displayed when you click Show Filter in the 
Knowledge Document List pane overrides this setting. 

Default: Any of the Words (OR). 

Match 

Specifies the default method by which the product searches documents. 
Select one of the following options: 

Whole words 

The search retrieves only documents that contain the entire words 
entered. 

Words beginning with... 

The search retrieves documents that contain the entire words entered 
or words that begin with the words entered. For example, a search for 
the word "print" also returns documents containing the words "printer" 
or "printing". 

The Match field displayed when you click Show Filter in the Knowledge 
Document List pane overrides this setting. 

Default: Whole words. 

Order By 

Specifies the default property by which to sort documents retrieved. The 
Order By field displayed when you click Show Filter in the Knowledge 
Document List pane overrides this setting. 

Default: Relevance. 

Search In 

Specifies which document fields to search for specified keywords. When you 
click Search, the product returns only documents that contain the specified 
keywords in the fields specified by the selected Search In check boxes. Select 
any combination of the following check boxes: 

 Problem 

 Resolution 

 Summary 

 Title 

These check boxes only display when Keyword Search is the selected 
search type. If you select Natural Language Search from the Search Type 
list, the Search In check boxes do not display and the product only 
searches the Problem fields of documents. 
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Default: All check boxes are selected. 

Documents Per Page (Knowledge Document List Settings) 

Specifies the number of documents (25 or 50) to display on each page of 
the Knowledge Document List pane. 

Default: 25. 

Show Document List Details 

Specifies whether detailed information displays in the Knowledge 
Document List pane on the Knowledge tab. 

Select the check box to display the following default information: 

 Title 

 Summary 

 Document ID 

 Modify Date 

Clear the check box to display only the document title. 

Default: The check box is selected. 

Documents Per Page (Knowledge Categories Document List Settings) 

Specifies the number of documents (25 or 50) to display on each page of 
the Knowledge Document List pane. 

Default: 25. 

Attributes to be shown in list 

Displays two lists with which you can define the properties that display for 
each document in the Knowledge Document List pane on the Knowledge 
Categories pane of the Administration tab. 

 To display a property in the Knowledge Document List pane, select it 
from the Available List and use the > (Select Item) button to move it 
to the Selected list. 

 To move all of the properties from the Available list to the Selected 
list, click >> (Select All Available Items). 

 To remove a property from the Knowledge Document List pane, select 
it from the Selected list and use the < (Remove Item from Selected 
List) button to move it to the Available list. 

 To move all of the the properties from the Selected list to the Available 
list, click << (Remove All Items from Selected List). 

To select multiple items in either the Available or Selected list, hold down 
the Ctrl key while you click each item you want to select or hold down the 
Shift key while you click the first and last items in a series. 

Default: DOC ID, Owner, Assignee, Modify Date, and Document Status 
display in the Selected list. 
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Note: Choosing attributes different than the Preference default may 
impact performance. If you believe that extra display columns are needed, 
contact the system administration and ask them to use the Web Screen 
Painter utility to modify the default page columns for the Document List 
form. 

Active Zone 

From the drop down list, select the active zone for your Global Knowledge 
Tools environment, for example, your organization's Intranet. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Preferences Detail window. 

Preferences Detail window 

The Preferences Detail window opens when you click Save or Cancel on the 
Preferences window. 

Use the Preferences Detail window to review default Knowledge Tools 
behaviors. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Avoid Popups 

When selected, will reduce the number of new browser windows opened by 
displaying new forms in the main browser window whenever possible. 

Note: If this option is selected, the Back to List button will be activated, 
and can be used to navigate from detail forms back to the previously 
displayed list window. The Back to List button will appear in the upper 
right-hand side of the window. 

Display Score Count 

Displays the score count as left-justified.. 
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Keep Log Reader Window 

Displays whether the product will keep the Log Reader window open when 
you select the Close All Popups command from the Window menu and 
after you log off of Unicenter SD. This setting has no effect when the Log 
Reader window is not open. 

Preserve Popup Size 

Displays whether the product will open new popup windows with the same 
dimensions as the most recently resized popup window. 

Note: If you set Preserve Popup Size to on (checked), and you maximize a 
popup window, subsequent popup windows may cover any other Service 
Desk window you may have open. However, new popup windows will 
appear slightly off the screen, to the right and lower. This is because there 
is a 10 pixel (left and top) offset for popups - so that they do not 
completely overlay the currently displayed window. It is recommended 
that you do not maximize popup windows when using the Preserve Popup 
Size option. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Using Screen Reader 

Selecting this preference modifies Service Desk behavior for optimal use 
with a screen reader for blind and limited vision users. You must log off 
and log back on again after changing this preference. From the Service 
Desk Help menu, select the item "Screen Reader Usage", for an overview 
of using Service Desk with a screen reader. 

Search Type 

"Using" indicates the type of search to perform. Select either Keyword 
Search or Natural Language Search. 

Match Type 

Displays the default method for text matching during a search. Possible 
values are Any of the Words (OR), All of the Words (AND), and Exact 
Phrase. 

Match 

Displays the default method by which the product searches documents, 
either Whole Words or Words Beginning With. 

Order By 

Displays the default property by which the product will sort documents 
retrieved. 
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Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Search In 

Displays which document fields the product will search for specified 
keywords. These check boxes only display when Keyword Search is the 
selected search type. 

Documents Per Page (Knowledge Document List Settings) 

Displays the number of documents (10, 25, or 50) that the product will 
display on each page of the Knowledge Document List pane. 

Show Document List Details 

Displays whether the Knowledge Document List pane on the Knowledge 
tab includes detailed information. If the check box is selected, the 
following default information displays: 

 Title 

 Summary 

 Document ID 

 Modify Date 

If the check box is cleared, on the document title displays. 

Documents Per Page (Knowledge Categories Document List Settings) 

Displays the number of documents (10, 25, or 50) that the product will 
display on each page of the Knowledge Document List pane. 

Attributes to be shown in list 

Displays the properties listed for each document in the Knowledge 
Document List pane of the Knowledge Categories pane on the 
Administration tab. 

Note: Choosing attributes different than the Preference default may 
impact performance. If you believe that extra display columns are needed, 
contact the system administration and ask them to use the Web Screen 
Painter utility to modify the default page columns for the Document List 
form. 

Active Zone 

From the drop down list, select the active zone for your Global Knowledge 
Tools environment, for example, your organization's Intranet. 

This window contains the following buttons: 

Edit 

Opens the Preferences window so you can modify preferences. 
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Preview Window (User View) 

The Preview window opens when you do either of the following: 

 Click User View on the Update Knowledge Document window 

 Click User View on the Knowledge Document Detail window 

 Right-click a Document in the Document List in the Knowledge Categories 
window under the Administration tab, and select User View 

Use the Preview window to view the current document as it will display to 
users at runtime. This enables you to verify your design before you publish the 
document. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Use the Print command in the Page Options menu on the upper right side of 
the Preview window to opens a standard Windows Print dialog so you can 
specify options for printing the contents of the current document. 

Knowledge Document Window 

The Knowledge Document window opens when you do either of the following: 

 Click a Knowledge Document icon or title on: 

 The Knowledge Document List on the Knowledge tab. 

 The Knowledge Document List of the Knowledge Documents nodes of 
the Scoreboard on the Knowledge Tools tab. 

 Right-click a knowledge document title in the Knowledge Categories pane 
on the Administration tab, then select Document View from the shortcut 
menu 

 Right-click a knowledge document title in the Knowledge Document List on 
the Knowledge tab and select View from the shortcut menu. 

 Click a Knowledge Document link, for example, under the Top Solutions 
section. 

 Click a Knowledge Document link, for example, under the Top Solutions 
section of Customer or Employee user interface 

 Click a Knowledge Document icon or title in Activities tab of a Request or 
an Issue of KT Log Solution type 

 Click a Knowledge Document icon or title after search on the Knowledge 
tab of a Request or an Issue 
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Use the Knowledge Document window to view and interact with a knowledge 
document. 

Note: To create a new document or update an existing document, see Create 
New/Update/Detail Document Windows. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Documents contain a variety of information organized to optimize user access. 
Documents created using the default Built In - Knowledge Document template 
are divided into two areas: 

 The left side of the document (the document body) contains information 
about the problem the document addresses, the suggested resolution for 
the problem, and links to related resources. In addition to the document 
title, specific information displayed may include the following: 

Summary 

Displays a brief description of the problem associated with the document. 

Problem 

Displays the full description of the problem associated with the document. 

Resolution 

Displays the description of how to resolve the problem. 

See Also 

Displays links to other documents in the knowledge base that are related 
to the current document. Click a link under See Also to open the 
associated document in a new window. 

Attachments 

Displays links to files attached to the document as supplemental 
information. When you click a link, the attached file opens in an 
appropriate application. 

Related Categories 

Displays links to categories that are related to the document. Click a link 
under Related Categories to list the documents that reside in the linked 
category and its subcategories in the Knowledge Document List pane. 

Related Tickets 

Lists any tickets related to this document. 

Properties 

Displays the properties specified in the document template. By default, the 
numeric Document ID and the date on which the document was created 
are displayed. 
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Comments 

Displays comments added by document users through the Comment box 
on the document. Each comment displays with the name and email 
address of the contact who entered it and the date the comment was 
entered. 

 The right side of the document contains menus, page option links, solution 
survey fields, and comment fields. 

Page Options 

Displays commands for interacting with the document. Use the Page 
Options commands to edit, email, bookmark, print, close, and subscribe to 
the current document.You can also create a new request or create a new 
request based on the document being viewed, depending on how you 
accessed this window. 

 The Solution Survey and Comments are two boxes that let you rate and 
comment upon the document: 

Solution Survey 

Defines feedback regarding the effectiveness of the document in answering 
your question and lets you open an issue or request. The product uses 
your feedback to calculate the document's FAQ rating. 

Comment 

Defines comments to add to the document. For example, you might add a 
comment that clarifies the document's resolution. Comments you add 
display under the Comments heading in the document body. 

Note: Documents created using a customized template may contain different 
information. 

Reject Document window 

The Reject Document window opens when you click Reject on the Update 
Knowledge Document window. 

Use the Reject Document window to move a document to a previous approval 
process task and assign an analyst to the document for that task. When 
multiple previous tasks exist, system administrators can choose the approval 
process task to which the document will revert. Assignees without 
administrator privileges can reject the document back to the previous task in 
the approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 
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This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Previous Tasks 

Lists approval process tasks to which the document can revert. This field 
only displays if the current assignee has administrator privileges and there 
are multiple previous tasks in the approval process. 

For each task, the Previous Tasks list displays the assignee who completed 
the task and the date on which the document was forwarded. When you 
click a task name to select the task to which to reject the document, the 
Reject Document window refreshes so you can specify an assignee and 
enter a comment. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 
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This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm rejecting the document to a previous approval 
process task. When you click OK, the Reject Document window closes and 
the rejected document appears in the specified assignee's Inbox in the 
Knowledge Document folder on the Service Desk tab. 

The Spell Check Results window opens when you check spelling or click the 
Spelling button. The spell checker scans the header or body information and 
displays each unrecognized word in the Spell Check Results window. Use the 
window to specify what action to take on such words. When you correct or 
otherwise act upon a word, the product moves to the next unrecognized word, 
and so on until it has scanned the entire header or body. 

You can use the Spell Check Results window to do the following: 

 Correct the spelling of a specific occurrence of the unrecognized word in 
the template header or body 

 Correct the spelling of all occurrences of the unrecognized word in the 
template header or body 

 Select a word to replace the unrecognized word 

 Ignore a specific occurrence of the unrecognized word in the template 
header or body 

 Ignore all occurrences of the unrecognized word in the template header or 
body 

This window contains the following fields: 

Not in Dictionary 

Displays the word that the product has identified as misspelled (that is, 
not in the product dictionary). 

Limits: This field is read-only. 

Change To 

Displays the word in the product dictionary that is the closest in spelling to 
the unrecognized word or the current selection from the Suggestions list. 

You can accept the spelling of the replacement as presented or type an 
alternate spelling in the Change To box, then do one of the following: 

 Click Change. The product changes the current occurrence of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 
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 Click Change All. The product changes all occurrences of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

Suggestions 

Specifies words that are close in spelling to the unrecognized word. When 
you select a word from the list, it displays in the Change To box. 

Context 

Displays the unrecognized word in the context in which it is used in the 
template. 

Editing the text in the Context box has no effect on the template's 
contents. 

This window contains the following buttons: 

Change 

Changes the current occurrence of the word in the Not in Dictionary field 
to the word in the Change To box. 

Change All 

Changes all instances of the word in the Not in Dictionary field to the word 
in the Change To box. 

Close 

Closes the document, window, or dialog. 

Ignore 

Disregards the current instance of the unrecognized word and advances to 
the next unrecognized word. If there are no additional unrecognized 
words, the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 

Ignore All 

Disregards all instances of the unrecognized word and advances to the 
next unrecognized word. If there are no additional unrecognized words, 
the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 
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Unpublish Document window 

The Unpublish Document window opens when you do either of the following: 

 Click Unpublish on the Update Knowledge Document window 

 Click Unpublish on the Knowledge Document Detail window 

Use the Unpublish Document window to remove the document from the 
knowledge base so it is no longer available to users. If you have administrator 
privileges, you can use the Unpublish Document window to retire the 
document (that is, remove it from the knowledge base and the approval 
process) or select the approval process task to which the document will revert. 
If you do not have administrator privileges, the document reverts to the 
previous task in the approval process. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Previous Tasks 

Lists approval process tasks to which the document can revert. This field 
only displays if the current assignee has administrator privileges and there 
are multiple previous tasks in the approval process. 

For each task, the Previous Tasks list displays the default assignee for the 
task. When you click a task name to select the task to which to unpublish 
the document, the Unpublish Document window refreshes so you can 
specify an assignee and enter a comment. 
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Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm unpublishing the document to a previous approval 
process task. When you click OK, the Unpublish Document window closes 
and the unpublished document appears in the specified assignee's Inbox in 
the Knowledge Documents folder on the Service Desk tab. 

Retire this Document 

Prompts you to confirm retiring the selected document. When you click 
OK, the Unpublish Document window closes and the product removes the 
document from the knowledge base and the approval process. 

Unretire Document window 

The Unretire Document window opens when you click Unretire on the Update 
Knowledge Document window. 

Use the Unretire Document window to return a retired document to the 
knowledge base and workflow. If you are a system administrator, you can 
republish the document or (when multiple tasks exist) choose the approval 
process task to which the document will return. Assignees without 
administrator privileges can return the document to the previous task in the 
approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 
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This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm unretiring the document to the selected approval 
process task. When you click OK, the Unretire Document window closes 
and the document appears in the specified assignee's Inbox in the 
Knowledge Documents folder on the Service Desk tab. 
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Publish this Document 

Unretires and publishes the document. When you click Publish this 
Document, the product prompts you to confirm the action. Click OK to 
close the message and the Unretire Document window, and republish the 
document. 

Update Comment window 

The Update Comment window opens when you do any of the following: 

 Click Edit on the View Comment window 

 Click a comment on the Comments tab of the Update Knowledge 
Document window 

 Right-click a comment on the Comments tab of the Update Knowledge 
Document window, then select Edit from the shortcut menu 

Use the Update Comment window to edit a comment associated with the 
current document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Defines a comment that provides information about the document. This 
field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the comment and opens the View Comment window. 

The Update Knowledge Document window opens when you do any of the 
following: 

 Click Save on the Create New Document window 

 Right-click a document title in the Knowledge Categories pane on the 
Administration tab and select Open from the shortcut menu 
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 Click a document title in the Knowledge Categories pane on the 
Administration tab 

 Right-click a document title in the Knowledge Document List pane on the 
Keyword Search tab and select Edit from the shortcut menu 

Use the Update Knowledge Document window to update the content, 
attributes, permissions, category and document relationships, attachments, 
comments, and notifications for a document and to review the document's 
history. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 

 Notifications 

 History 

This window contains the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 
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Depending on the approval process task with which the document is currently 
associated, this window may contain the following buttons: 

Cancel 

Discards changes, closes the current window, and opens the Knowledge 
Document Detail window. 

Forward 

Opens the Forward Document window so you can assign the document to 
the analyst who will complete the next task in the approval process. When 
you click OK to forward the document, the Forward Document and Update 
Knowledge Document windows close and the Knowledge Document Detail 
window opens. The Forward button displays for all approval process tasks 
except the last (which is, by default, Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Publish 

Opens the Knowledge Document Detail window and makes the document 
available for viewing. 

Note: System administrators can use the Publish button at any time to 
bypass the approval process and immediately publish a document. 
Analysts working on a document can use the Publish button if the 
document is at the last stage of the approval process and ready to be 
published. 

Reject 

Opens the Reject Document window so you can reject the document, 
reassigning it to the previous owner and task. When you click OK to reject 
the document, the Reject Document and Update Knowledge Document 
windows close and the Knowledge Document Detail window opens. The 
Reject button displays for all approval process tasks except the first (which 
is, by default, Create Document) and the last (which is, by default, 
Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves changes to the current document and (as appropriate) notifies 
analysts of the changes. 
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Note: The Save button is only available on the Update/Create Document 
window if you have write access to the document. A document is read-only 
when it is published (as per Administrative option) or retired, or when the 
document's permissions preclude you from changing it. 

Unpublish 

Changes the status of the document from "Published" to "Unpublished", 
and removes the document from the knowledge base availability. This 
button only displays when a document's status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

View Comment window 

The Comment for Document Detail window opens when you do any of the 
following: 

 Click Save on the Create New Comment window 

 Click Save on the Update Comment window 

 Click Cancel on the Update Comment window 

 Right-click a comment on the Comments tab of the Update Knowledge 
Document window and select View from the shortcut menu 

Use the View Comment window to review a comment you added or edited for 
a document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Displays a comment that provides information about the document you are 
editing, forwarding, rejecting, publishing, unpublishing, or unretiring. This 
field is read-only. 
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This window contains the following buttons: 

Close 

Closes the document, window, or dialog. 

Edit 

Opens the Update Comment window so you can modify the comment. 
 

Windows window 

The Windows window opens when you select List All Windows from the 
Window menu on the Knowledge tab. 

Use the Windows window to view a list of windows that Knowledge Tools 
currently has open and to navigate directly to a specific open window. 

To move focus (that is, navigate) to a specific window, click its name on the 
Windows window. 

This window contains the following buttons: 

Close Window 

Closes the current window. 

Refresh 

Updates the list of open windows. 
 

Menus 
The menu bar on the Knowledge tab contains the following menus: 

 File (see page 232) 

 View (see page 232) 

 Reports (see page 233) 

 Window (see page 234) 

 Help (see page 234) 

Note: Some windows and dialogs contain menu bars with window-specific 
commands. For information about window- or dialog-specific menu bars, see 
the appropriate topics in this help system. 

The Knowledge tab also includes shortcut menus that open when you right-
click an item in the Category pane or the Knowledge Document List pane. For 
example, if you right-click a document title in the Knowledge Document List 
pane, the Knowledge Document List shortcut menu opens. 
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File menu 

The commands on the File menu let you print the current window or create a 
knowledge document or knowledge tree document. 

This menu contains one or more of the following commands: 

New Knowledge Document 

Opens the Create New Document window so you can define the content 
and attributes of a new knowledge document in the selected category. 

New Knowledge Tree Document 

Opens the Create New Document window so you can define the content 
and attributes of a new knowledge tree document in the selected category. 

Print Form 

Opens a standard Windows Print dialog so you can specify options for 
printing the contents of the current document, pane, window, or dialog. 

In addition, the File menu on the Knowledge Categories window has the 
additional commands to help you manage documents and document 
categories. 

View menu 

The commands on the View menu let you view response time statistics for 
Knowledge Tools, set preferences, and refresh the Knowledge Document List 
pane. 

This menu contains one or more of the following commands: 

Knowledge Categories 

Opens the Knowledge Categories pane which is used to manage content 
for each problem-solving model in the knowledge base. From the 
Knowledge Categories pane, users with system administrator or knowledge 
manager rights can: 

 Create, publish, and maintain knowledge documents and knowledge 
tree documents 

 Manage the knowledge category structure to make document access 
easier 

Knowledge Report Card 

The Knowledge Report Card provides feedback to analysts, knowledge 
engineers, knowledge managers, and system administrators about which 
knowledge documents are most effective. See Knowledge Report Card for 
more information. 
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Response Time Statistics 

Activates response time statistics reporting. Until you deactivate the 
function, a prompt reports Knowledge Tools response times when you 
preform an action. This command only displays when the function is not 
active. 

Preferences 

Opens the Preferences window so you can specify default preferences for 
various product components. 

Refresh 

Updates the current window to include the latest changes. 
 

Reports menu 

The commands on the Reports menu let you generate summary and detail 
reports for the documents currently displayed in the list pane. On the 
Administration tab, the reports menu only displays for Tree pane selections for 
which reporting information exists (for example, events and macros panes, 
notifications panes, and application data panes). 

This menu contains one or more of the following commands: 

Summary 

Generates and displays a report of summary information about each item 
in the current result set. This report contains the following information: 

 Issue number 

 Status 

 Category 

 Open date 

 The name of the user who opened the issue 

 Priority 

 Summary 

Click Print to open a Windows Print dialog so you can print the report. 

Detail 

Generates and displays a report of detailed information about each 
document in the current result set. This report lists all of the attributes 
defined for each document in the result set. Click Print to open a Windows 
Print dialog so you can print the report. 
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Window menu 

The commands on the Window menu let you manage which windows and 
dialogs display on your screen. This menu contains one or more of the 
following commands: 

Close All Popups 

Closes all currently open Knowledge Tools windows except the main 
window. 

List All Windows 

Opens the Windows window, which lists all currently open Knowledge Tools 
windows. Click a window name to move focus to the selected window. 

View Main Page 

Moves focus to the main Knowledge Tools window. This command only 
displays on windows other than the main Knowledge Tools window. 

Help menu 

This menu contains one or more of the following commands: 

Knowledge Tools Help 

Opens a window that provides online help information about the main 
interface window. The Contents, Index, and Search tabs appear on the 
left, allowing you to navigate the help system. 

Help on This Window 

Opens a window that provides online help information about the currently 
active Knowledge Tools pane or window. 

Power User Tips 

Opens a window that provides help information such as keyboard shortcuts 
for expert Knowledge Tools users. 

Screen Reader Usage 

This Help menu item opens a window explaining how to use a Screen 
Reader with Knowledge Tools. 

Support for Knowledge Tools 

Opens the CA support web site for Knowledge Tools. 
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Operations Info 

Typically, this Help menu command displays a window showing 
information about your  product installation, such as hours of operation 
and contact information. 

If you want to customize this file for your installation, please copy it to: 
$NX_ROOT/site/mods/www/htmpl/web/analyst/about.htmpl-  

and then make the required changes. 

About Knowledge Tools 

Opens the About window, which provides information about this version of 
the product, third party notices, technical support information, and system 
information. Click Done to close the About window. 

 displayed on this window is contained in the file: 
$NX_ROOT/bopcfg/www/htmpl/web/analyst/about.htmpl 

 

Default Shortcut Menu 

The default shortcut menu opens when you right-click an empty area in any 
tab. 

This menu contains one or more of the following commands: 

About 

Opens the About window, which provides information about this version of 
the product, third party notices, technical support information, and system 
information. Click Done to close the About window. 

Help on Main Window 

Opens a window that provides online help information about the main 
interface window. The Contents, Index, and Search tabs appear on the 
left, allowing you to navigate the help system. 

Help on This Window 

Opens a window that provides online help information about the currently 
active Knowledge Tools pane or window. 

Print Form 

Opens a standard Windows Print dialog so you can specify options for 
printing the contents of the current document, pane, window, or dialog. 

Refresh 

Updates the current window to include the latest changes. 
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Knowledge Document List shortcut menu 

The Knowledge Document List shortcut menu opens when you right-click the 
Title for a document in the Knowledge Document List pane on the Knowledge 
tab or the Keyword Search tab. 

There is an administrative shortcut menu available for the Knowledge 
Document List under the Administration tab> Knowledge Tools> Knowledge 
Categories. See the section below. 

Note: The default Knowledge Tools shortcut menu opens when you right-click 
outside the area served by a function-specific shortcut menu. 

This menu contains one or more of the following commands: 

View 

Opens the selected document in the Knowledge Document window or the 
Knowledge Tree Document window. 

Edit 

Opens the selected document in the Update Knowledge Document window. 

Refresh 

Refreshes the Knowledge Document List. 

Print Form 

Prints the currently displayed form. 

Help on This Window 

Opens the help topic for the current window. 

The following additional shortcut commands are available on the Knowledge 
Document List of the Knowledge Categories window. This window is accessed 
from Administration tab> Knowledge> Knowledge Categories. The following 
shortcut commands allow the administrator to manage documents: 

User View 

Opens the Preview window, where you can view the document as it will 
appear at runtime. 

New Knowledge Document 

Opens the Create New document window, allowing you to create a new 
knowledge document. 

New Knowledge Tree Document 

Opens the Create New Tree Document window. 
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Delete Selected Document 

Will delete the selected document. A prompt will appear confirming the 
delete request. 

Note: If the document is also contained in another Knowledge Category, it 
will be deleted in that category as well. 

Delete All Documents Retrieved 

Will delete all the documents in the current list. A prompt will appear 
confirming the delete request. 

Note: If any documents in the list are contained in other Knowledge 
Categories, they will be deleted in those categories as well. 

 

Procedures 
The following topics provide procedures for using the Knowledge tab to work 
with knowledge documents and knowledge tree documents in the knowledge 
base. 

 

Work with Bookmarks 

The Bookmark feature reduces the time you spend looking for frequently 
referenced documents by storing links to them in the My Bookmarks folder. 
When you click My Bookmarks in the Category pane on the Knowledge tab, the 
list of bookmarked documents displays in the Knowledge Document List pane. 

The following topics contain procedures for working with bookmarks: 

Bookmark a Document (see page 237) 
Access a Bookmarked Document (see page 238) 
Delete a Bookmark (see page 238) 

 

Bookmark a Document 

To bookmark a document for quicker access, follow these steps: 

1. Open the document. 

2. Click Add Bookmark on the Page Options menu. 

The Remove Bookmark button replaces Add Bookmark on the Page 
Options menu and the product adds the document to the My Bookmarks 
folder. 

Note: Users logged in as Guest cannot create or delete bookmarks or access 
the My Bookmarks folder. 
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Access a Bookmarked Document 

To access a bookmarked document, follow these steps: 

1. Select My Bookmarks from the Category pane on the Knowledge tab. 

The Knowledge Document List pane refreshes to display all bookmarked 
documents. 

2. (Optional) Use the Knowledge Search pane to specify criteria by which to 
filter the result list. 

3. Click the appropriate document's title in the Knowledge Document List 
pane. 

The document opens. 
 

Delete a Bookmark 

To delete a bookmark, follow these steps: 

1. Select My Bookmarks from the Category pane. 

The Knowledge Document List pane refreshes to list bookmarked 
documents. 

2. Click the title of the document whose bookmark you want to delete. 

The document opens. 

3. Click Remove Bookmark on the Page Options menu. 

The product deletes the bookmark and the Add Bookmark button replaces 
the Remove Bookmark button on the Page Options menu. When you select 
My Bookmarks from the Category pane, the document no longer appears 
on the list. 

Note: Users logged in as Guest cannot create or delete bookmarks or access 
the My Bookmarks folder. 
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Work with Documents 

The following topics contain procedures for working with knowledge documents 
and knowledge tree documents: 

Access a Bookmarked Document (see page 238) 
Add a Comment to a Document (see page 239) 
Bookmark a Document (see page 237) 
Check Spelling in a Document (see page 243) 
Complete the Solution Survey for a Document (see page 244) 
Delete a Bookmark (see page 238) 
Generate Reports (see page 251) 
Open a Knowledge Document (see page 252) 
Print a Document (see page 253) 
Send a Document in Email (see page 257) 
View a Document (see page 260) 

 

Add a Category Link to a Document 

To add a category link to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Right-click the category to link to the document, then select Link this 
Category from the shortcut menu. 

The product adds the selected category path to the Category Links list and 
to the current document. At runtime, the link displays in the document 
under the "Related Categories" heading. 

Add a Comment to a Document You are Editing 

To add a comment to a document you are editing, follow these steps: 

1. Open the document for editing. 

2. Click the Comments tab. 

3. Click Add Comment. 

The Create New Comment window opens. 

4. Enter a brief comment in the Comment box. 

5. Click Save. 

The Create New Comment window closes and the View Comment window 
opens so you can review your comment. 
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6. Do one of the following: 

 Click Close Window. 

The View Comment window closes. Select Refresh from the View menu 
to refresh the Comments tab. 

 Click Edit. 

The View Comment window closes and the Update Comment window 
opens so you can change the comment. 

 

Add a Comment to a Document You are Viewing 

To add a comment to a document you are viewing, follow these steps: 

1. View the document. 

2. Locate the Comment box on the document window. 

3. Enter your user name (that is, the ID with which you log into the product) 
in the Name box. 

4. Enter your email address in the Email box. 

5. Enter your feedback in the Comment box. 

6. Click Submit. 

The product displays an informational message and the Comment box 
becomes read-only. When you next access the document, your user ID, 
email address, and comment display under the Comments heading. 

Add a Contact to the Notification List 

You can specify contacts to notify by email of events such as changes in a 
document's content or status. To add a contact to a document's notification 
list, follow these steps: 

1. Open the document for editing. 

2. Click the Notifications tab. 

3. Click Add Notification. 

The Create New Notification window opens. 

4. Do one of the following to define the contact to notify in the User Name 
box: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select a contact. 
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 Enter one or more characters of the contact name and click  to open 
the Contact List window so you can select from entries that match the 
characters you entered. For example, if you enter "Pa", the Contact 
List window lists all contacts whose last name begins with "Pa". If only 
one entry matches the characters you typed, the product automatically 
enters that name in the field. 

5. (Optional) Enter an alternate email address to which to send notifications 
in addition to the address associated with the specified contact in the 
Alternate Email box. 

6. Click Save. 

The Create New Notification window closes and the View Notification 
window opens so you can review your settings. 

7. Do one of the following: 

 Click Close Window. 

The View Notification window closes. Select Refresh from the View 
menu to refresh the Notifications tab. 

 Click Edit. 

The View Notification window closes and the Update Notification 
window opens so you can change the user name or alternate email 
address. 

 

Add a Document Link to a Document 

To add a document link to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Select the category that contains the document for which you want to add 
a link from the Categories list. 

The Documents list refreshes to display the ID numbers and titles of 
documents in the selected category. 

4. Right-click the ID number of the document to link, then select Link this 
Document from the shortcut menu. 

The product adds the selected document to the Document Links list and to 
the current document. At runtime, the link displays in the document under 
the "See Also" heading. 
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Add a URL Link to a Document 

To add a URL link to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Type the fully-qualified URL (for example, http://www.ca.com) in the 
field provided, then click Add URL Link. 

The Attachments list refreshes to include the URL. At runtime, the link 
displays in the document under the "Attachments" heading. When a user 
clicks the link, the associated resource opens for viewing in a separate 
browser window. 

 

Attach a File to a Document 

To add a file attachment to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Navigate to the folder that contains the file you want to attach in the 
Repositories list. 

The Files list refreshes to display the ID numbers and names of files in the 
selected folder. 

(Optional) Right-click the ID number of a file, then select View from the 
shortcut menu to open the selected file in an appropriate program so you 
can preview it before attaching it to the document. 

4. Right-click the ID number of the file to attach, then select Attach this File 
from the shortcut menu. 

The Attachments list refreshes to list the path and name of the file 
attachment. At runtime, file attachments are typically listed under the 
"Attachments" heading in the document. When a user clicks the link to a 
file attachment, the attachment opens for viewing in an appropriate 
program. 
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Check Spelling in a Document 

To check spelling in a document, follow these steps: 

1. Open the document for editing. 

2. Click the Spell Check button. 

Note: The Spelling button is only available for the Resolution section when 
the HTML Source option is selected. 

The product scans the document and opens the Spell Check Results 
window. 

 If the product encounters no unrecognized words, it closes the Spell 
Check Results window. The spelling check is complete. 

 If the product encounters unrecognized words, it displays the first 
unrecognized word in the Not in Dictionary field on the Spell Check 
Results window. Continue with Step 3. 

3. Do one of the following: 

 Enter a replacement for the unrecognized word in the Change To box. 

 Select one of the suggested replacements for the unrecognized word 
from the Suggestions list. 

 Continue with Step 4 without specifying an alternative to the 
unrecognized word. 

4. Do one of the following: 

 Click Change to replace the current occurrence of the unrecognized 
word with the word you entered in the Change To box or selected from 
the Suggestions list. 

 Click Change All to replace all occurrences of the unrecognized word 
with the word you entered in the Change To box or selected from the 
Suggestions list. 

 Click Ignore to leave the current occurrence of the unrecognized word 
unchanged. 

 Click Ignore All to leave all occurrences of the unrecognized word 
unchanged. 

The Spell Check Results window displays the next unrecognized word. If 
there are no more unrecognized words in the document, the Spell Check 
Results window closes. 
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Complete the Solution Survey for a Document 

You can use the Solution Survey box in a document to open an issue or 
request and to provide information that the product uses to calculate the 
document's FAQ rating. 

To complete the solution survey for the currently open document, follow these 
steps: 

1. (Optional) Select an option in the Solution Survey box to open an issue or 
request. 

2. Select one of the following options in the Solution Survey box to rate the 
effectiveness of the current document in addressing your problem: 

Very helpful 

Indicates that the document solved the problem or provided all of the 
information necessary to solve the problem. 

Somewhat helpful 

Indicates that the document provided most of the information 
necessary to solve the problem. 

Not helpful at all 

Indicates that the document provided very little or none of the 
information necessary to solve the problem. 

3. Click Submit. 

The document refreshes and the Solution Survey box becomes read-only. 
If you selected an option other than No in Step 1, the Create New Request 
window opens. 

Note: If the document helped you solve your problem or answer your question 
and you do not want to complete the solution survey, click the Yes (Close) 
button. The product closes the document and adds it to the solution count 
used to calculate FAQ ratings. 

 

244  Administrator Guide 
 



Procedures 
 

Create a Knowledge Document 

Note: Only an Administrator with Administration rights can create a 
Knowledge Document. 

To create a knowledge document, follow these steps: 

1. Select the category in which to add the new document from the Category 
pane on the Knowledge tab. 

The Knowledge Document List pane refreshes to display documents in the 
selected category. 

Select New Knowledge Document from the File menu. 

The Create New Document window opens. 

2. Complete the fields in the Content tab as appropriate. 

3. Click Edit Resolution. 

The HTML Editor opens. 

4. Use the HTML Editor to design the body (that is, the resolution) of the 
document, then click OK to save the resolution and close the HTML Editor. 

5. (Optional) Click Spell Check to check spelling in the content you entered. 

6. Click Save. 

The Create New Document window closes and the Update Knowledge 
Document window opens. 

7. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

8. Complete the fields on the remaining tabs on the Update Knowledge 
Document window as appropriate. 

9. Click Save when you finish editing the document. 

10. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 
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Create a Knowledge Tree Document 

To create a knowledge document, follow these steps: 

1. Select the category in which to add the new document from the Category 
pane on the Knowledge tab. 

The Knowledge Document List pane refreshes to display documents in the 
selected category. 

Select New Knowledge Tree Document from the File menu on the Keyword 
Search tab. 

The Create New Document window opens. 

2. Complete the fields in the Content tab as appropriate. 

3. (Optional) Click Spell Check to check spelling in the content you entered. 

4. Click Save. 

5. The Create New Document window closes and the Update Knowledge 
Document window opens. 

6. Click Design Tree. 

The DT Builder opens. 

7. Create the knowledge tree, then click Save and Close to save the tree 
design and close the DT Builder. 

8. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

9. Complete the fields on the remaining tabs on the Update Knowledge 
Document window as appropriate. 

10. Click Save when you finish editing the document. 

11. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 
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Delete a Comment from a Document 

To delete a comment from a document, follow these steps: 

1. Open the document for editing. 

2. Click the Comments tab. 

3. Right-click the comment, then select Delete from the shortcut menu. 

An informational message displays. 

4. Click OK. 

The informational message closes and the product deletes the contact 
from the Comment list. 

 

Delete a Contact from the Notification List 

To delete a contact from a document's notification list, follow these steps: 

1. Open the document for editing. 

2. Click the Notifications tab. 

3. Right-click the user name or alternate email of the contact to delete, then 
select Delete from the shortcut menu. 

An informational message displays. 

4. Click OK. 

The informational message closes and the product deletes the contact 
from the notification list. 

 

Delete a File Attachment from a Document 

To remove an attachment from a document, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Right-click the file to remove from the document in the Attachments list, 
then select Remove from the shortcut menu. 

A confirmation message displays. 

4. Click OK. 

The confirmation message closes and the product removes the selected 
attachment from the Attachments list and the document. 
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Edit a Comment in a Document 

To edit a comment associated with a document, follow these steps: 

1. Open the document for editing. 

2. Click the Comments tab. 

3. Right-click the comment to edit, then select Edit from the shortcut menu. 

The Update Comment window opens. 

Edit the comment as appropriate, then click Save. 

The Update Comment window closes and the View Comment window 
opens so you can review your changes. 

4. Do one of the following: 

 Click Close Window. 

The View Comment window closes and the Comments tab refreshes. 

 Click Edit. 

The View Comment window closes and the Update Comment window 
opens so you can change the comment definition. 

Edit a Contact in the Notification List 

To edit a contact in a document's notification list, follow these steps: 

1. Open the document for editing. 

2. Click the Notifications tab. 

3. Right-click the alternate email address or the user name of the contact to 
edit in the Document Notification List, then select Edit from the shortcut 
menu. 

The Update Notification window opens. 

(Optional) Do one of the following to define the contact to notify in the 
User Name box: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select a contact. 

 Enter one or more characters of the contact name and click  to open 
the Contact List window so you can select from entries that match the 
characters you entered. For example, if you enter "Pa", the Contact 
List window lists all contacts whose last name begins with "Pa". If only 
one entry matches the characters you typed, the product automatically 
enters that name in the field. 
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4. (Optional) Enter an alternate email address to which to send notifications 
in addition to the address associated with the specified contact in the 
Alternate Email box. 

5. Click Save. 

The Update Notification window closes and the View Notification window 
opens so you can review your settings. 

6. Do one of the following: 

 Click Close Window. 

The View Notification window closes and the Notifications tab 
refreshes. 

Click Edit. 

The View Notification window closes and the Update Notification 
window opens so you can change the user name or alternate email 
address. 

Edit a Document from the Knowledge Tab 

To edit a document, follow these steps: 

1. Select the category in which the document to edit resides from the 
Category pane on the Knowledge tab. 

The Knowledge Document List pane refreshes to display documents in the 
selected category. 

2. Right-click the title of the document to edit, then select Edit from the 
shortcut menu. 

The Update Knowledge Document window opens. 

Note: If the document has been published, you may need to unpublish it 
before making changes. 

3. (Optional) Complete or change the fields on the various tabs as 
appropriate. 

4. (Optional) Do one of the following, as appropriate: 

 For a knowledge document, click Edit Resolution on the Content tab to 
open the HTML Editor so you can modify the body (that is, the 
resolution) of the document. Click OK to save your changes and close 
the HTML Editor. 

 For a knowledge tree document, click Design Tree on the Content tab 
to open the DT Builder so you can edit the knowledge tree. Click Save 
and Close to save the tree design and close the DT Builder. 

5. (Optional) Click Spell Check to check spelling in the content you entered. 
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6. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

7. Click Save when you finish editing the document. 

The product saves your changes. 

8. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 

 

Filter the Knowledge Document List 

To specify criteria by which to determine which documents from the current 
category display in the Knowledge Document List pane, follow these steps: 

1. Select the category in which to filter documents from the Category pane. 

The Knowledge Document List pane refreshes to display all of the 
documents in the selected category. 

Note: To filter all the documents in the knowledge base, select the TOP 
category. 

(Optional) Enter a phrase by which to filter documents to retrieve in the 
Search box. 

2. (Optional) Click Advanced Search to display the advanced search fields, 
then complete the fields as appropriate. 

The more criteria you specify, the fewer results will return when you apply 
the filter. 

3. Click Search. 

The Knowledge Document List pane displays your filtered results. 
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Forward a Document 

When you complete an approval process task for a document that is not yet at 
the last stage of the approval process, you can forward it to the next task. 

To forward a document to the next approval process task, follow these steps: 

1. Open the document for editing. 

2. Click Forward on the Update Knowledge Document window. 

Note: The Forward button is only available if the document is not at the 
final stage of the approval process. 

The Forward Document window opens. 

3. (Optional) Specify a contact to have responsibility for the document for the 
duration of the next approval process task. Do one of the following: 

4. Select the name of the contact to assign the document to, or click  to 
open the Contact Search window so you can locate and select one. 

If you do not select an alternate assignee, the product associates the 
document with the assignee defined in the approval process template. 

5. (Optional) Enter a brief comment for the document in the Comment box. 

6. Click OK. 

A confirmation message displays. 

7. Click OK. 

The confirmation message and the Forward Document window close, and 
the product forwards the document to the next approval process task and 
assignee. 

 

Generate Reports 

To generate a report, follow these steps: 

1. Choose Reports from the Admin menu. 

The Reports dialog opens. 

2. Click the link corresponding to the report you want to generate. 

A specific report dialog opens. 

Note: When you click the Noise Words, Synonyms, Special Terms, or 
Unpublished Documents link on the Reports dialog, the product generates 
and displays the corresponding report without displaying an intermediate 
dialog. 

3. Complete the fields on the report dialog as appropriate, then click Go. 

The product generates and displays the selected report. 
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Open a Document from the Knowledge Tab 

To open a knowledge document, follow these steps: 

1. Select the folder, category, or subcategory in which the document resides 
from the Category pane on the Knowledge tab. 

The Knowledge Document List pane refreshes to display the contents of 
the selected folder or of the selected category and its subcategories. 

2. (Optional) Use the Knowledge Search pane to specify criteria with which to 
refine the results list. 

3. Do one of the following: 

 To open the document for editing, right-click its title in the Knowledge 
Document List pane and select Edit from the shortcut menu. 

The selected document opens in the Update Knowledge Document 
window. 

 To open the document as it will display to users at runtime,  click its 
title in the Knowledge Document List pane. 

The selected document opens in the Knowledge Document window or 
the Knowledge Tree Document window, as appropriate. 

 

Preview a Document 

To preview a document as it will display to users at runtime so you can verify 
content and design before you publish the document, follow these steps: 

1. Do one of the following, as appropriate: 

 On the Knowledge tab or the Keyword Search tab, click on the title of 
the document to view it in the User View. 

On the Administration tab, click the title of the document. 

The document opens Update Knowledge Document window. 

2. Click User View. 

The document opens in the Preview window. 

3. (Optional) Select Print from the Page Options menu on the right side of the 
document to open a standard Windows Print dialog so you can print the 
document. 

4. Click . 

The Preview window closes. 
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Print a Document 

To print a document, follow these steps: 

1. Do one of the following, as appropriate: 

 On the Knowledge tab or the Keyword Search tab, click the title of the 
document in the Knowledge Document List pane. 

 On the Administration tab, right-click the title of the document in the 
Knowledge Categories pane, then select User View from the shortcut 
menu. 

The document opens. 

2. Click Print on the Page Options menu. 

A standard Windows Print dialog opens. 

3. Specify the appropriate print settings, then click Print. 

The Print dialog closes and the document prints. 
 

Publish a Document 

When you are ready to add a document to the knowledge base, you can 
“publish” it from the Update Knowledge Document window. Analysts and 
knowledge engineers can publish documents when they are at the last stage of 
the approval process. Knowledge managers and system administrators can 
publish documents at any stage of the approval process. 

To publish a document, follow these steps: 

1. Open the document for editing. 

2. Click Publish. 

A confirmation message displays. 

3. Click OK. 

The confirmation message and the Update Knowledge Document window 
close, and the Knowledge Document Detail window opens. The product 
adds the document to the knowledge base. 
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Reject a Document 

The approval process determines the consecutive tasks and task owners 
through which a document progresses during its life cycle. When a document 
arrives in your Inbox in the Knowledge Documents folder on the Service Desk 
tab (indicating that you are the document's owner for a specific workflow 
task), you can do one of the following: 

 Accept the task by editing the document and then publishing it or 
forwarding it to the next workflow task. 

Note: By default, all users with full permissions may edit documents. 
However, the system administrator can specify in the Approval Process 
Settings pane on the Administration tab that only an assignee, the 
document owner, a system administrator, or a knowledge manager may 
edit documents. 

 Reject the task by clicking Reject on the Update Knowledge Document 
window to revert the document to a previous approval process task and 
owner. You might reject a task, for example, if the forwarding analyst did 
not complete a prerequisite task or if you are no longer responsible for the 
subject matter associated with the document. 

To reject a document and return it to a previous approval process task, follow 
these steps: 

1. Click  to open the Knowledge Documents branch of the scoreboard in the 
left pane of the Service Desk tab. 

2. When the Inbox branch displays a number other than zero, the knowledge 
base contains one or more documents awaiting your attention. 

3. Click the Inbox branch. 

The Knowledge Document List pane refreshes to list documents in your 
Inbox. 

4. Right-click the title of the appropriate document in the Knowledge 
Document List pane, then select Edit from the shortcut menu. 

The Update Knowledge Document window opens. 

5. Click Reject. 

The Reject Document window opens. 
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6. Do one of the following: 

 If you are not the current assignee or a system administrator or there 
is only one previous workflow task, you can choose an owner for the 
task and (optionally) enter a comment. 

– Select the name of a contact to assign the document to from the 
Assignee list, or click  to open the Contact Search window so you 
can search for and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

 If you are the current assignee or a system administrator and there 
are multiple previous workflow tasks, you can choose the task to which 
the document will revert. 

– Click the name of a previous task to which to assign the rejected 
document. The Reject Document window refreshes. 

– Select the name of a contact to assign the document to from the 
Assignee list, or click  to open the Contact Search window so you 
can search for and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

7. Click OK. 

The confirmation message and the Reject Document window close and the 
rejected document appears in the specified assignee's Inbox in the 
Knowledge Document folder on the Service Desk tab. 

 

Remove a Category Link from a Document 

To remove a category link, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Right-click the category link to remove in the Category Links list, then 
select Remove this Category from the shortcut menu. 

Note: You cannot remove the link to the primary category. 

The product removes the selected category link from the Category Links 
list and the document. 
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Remove a Document Link from a Document 

To remove a document link, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Right-click the document link to remove in the Document Links list, then 
select Remove this Link from the shortcut menu. 

The product removes the selected document link from the Document Links 
list and the document. 

 

Remove a URL Link from a Document 

To remove a document link, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Right-click the URL link to remove in the Attachments list, then select 
Remove from the shortcut menu. 

An informational message displays. 

Click OK. 

The informational message closes and the product removes the selected 
document link from the Attachments list and the document. 

 

Retire a Document 

When a published document reaches its expiration date, the product typically 
retires it (that is, removes the document from the knowledge base and the 
approval process). 

To retire a document before its expiration date, follow these steps: 

1. Open the document for editing. 

2. Click Unpublish. 

The Unpublish Document window opens. 

3. Click Retire This Document. 

A confirmation message displays. 

4. Click OK. 

The confirmation message and the Unpublish Document window close, and 
the product removes the document from the knowledge base and the 
workflow. 
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Send a Document in Email 

To email the current document to one or more recipients, follow these steps: 

1. View the document. 

2. Click Email on the Page Options menu. 

The Email Document window opens. 

3. Complete the fields on the Email Document window as appropriate. 

4. Click OK. 

The Email Document window closes and the product sends your email to 
the specified recipients. 

 

Set the Primary Category for a Document 

To specify a document's primary category, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

The Primary Category field at the top of the tab displays the current 
primary category path. for example, TOP>Email. 

3. (Optional) If the Category Links list does not display the category you 
want to set as primary, right-click the category in the Categories list and 
select Link this Category from the shortcut menu. 

The product adds the selected category path to the Category Links list and 
to the current document. 

4. Right-click the name of the category to set as the document's primary 
category in the Category Links list, then select Set as Primary Category 
from the shortcut menu. 

A confirmation message displays. 

5. Click OK. 

The confirmation message closes, and the Primary Category field refreshes 
to display the updated information. 
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Unpublish a Document 

After a document has been published, a system administrator or a user with 
full permissions can unpublish it, thereby removing it from the knowledge base 
and returning it to the approval process. 

To unpublish a document, follow these steps: 

1. Open the document for editing. 

2. Click Unpublish. 

The Unpublish Document window opens. 

3. Do one of the following, as appropriate: 

 If you are a system administrator, you can retire the document, 
thereby removing it from the knowledge base and the approval 
process. To do so, click Retire this Document. A confirmation message 
displays. 

 If you are a system administrator and there are multiple approval 
process tasks to which the document might revert, you can select the 
task to which to assign the document, select an assignee, and 
(optionally) enter a comment: 

– Click the name of a previous task to which to assign the 
unpublished document. The Unpublish Document window 
refreshes. 

– Select the name of a contact to assign the document to from the 
Assignee list, or click  to open the Contact Search dialog so you 
can locate and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

 If you are a knowledge engineer or analyst, you can choose an 
assignee for the task and (optionally) enter a comment: 

– Select the name of a contact to assign the document to from the 
Assignee list, or click  to open the Contact Search dialog so you 
can locate and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

4. Click OK. 

The confirmation message and the Unpublish Document window close, and 
the product retires the document or assigns it to the specified task and 
owner, as appropriate. 

 

258  Administrator Guide 
 



Procedures 
 

Unretire a Document 

When a published document reaches its expiration date, the product typically 
retires it (that is, removes the document from the knowledge base and the 
approval process). A system administrator or a user with full permissions can 
unretire or republish the document to return it to the approval process and the 
knowledge base. 

To unretire a document, follow these steps: 

1. Open the document for editing. 

2. Click Unretire. 

The Unretire Document window opens. 

3. Do one of the following, as appropriate: 

 If you are a system administrator, you can republish the document. To 
do so, click Publish this Document. A confirmation message displays. 

 If you are a system administrator and there are multiple approval 
process tasks to which the document might revert, you can choose the 
task to which to assign the document, choose an assignee, and 
(optionally) enter a comment: 

– Click the name of a previous task to which to assign the unretired 
document. The Unretire Document window refreshes. 

– Select the name of a contact to assign as the owner for the 
document from the Assignee list, or click  to open the Assignee 
List dialog so you can search for and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

 If you are a knowledge engineer or analyst, you can choose an 
assignee for the task and (optionally) enter a comment: 

– Select the name of a contact to assign as the owner for the 
document from the Assignee list, or click  to open the Assignee 
List dialog so you can search for and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

4. Click OK. 

The confirmation message and the Unretire Document window close, and 
the product assigns the document to the specified task and owner and 
returns the document to the knowledge base and the workflow. 
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View a Document from the Knowledge Tab or the Keyword Search Tab 

To view a document as it displays to users at runtime, click its title in the 
Knowledge Document List. The selected document opens in the Knowledge 
Document window or the Knowledge Tree Document window, as appropriate. 

 

View Document History 

To view the history of a document, follow these steps: 

1. Open the document for editing. 

2. Click the History tab. 

The History tab displays all actions performed on the current document, 
with the most recent actions listed first. The information on the History tab 
is read-only. 

3. (Optional) Click Show Filter to display controls with which you can specify 
criteria for filtering the list of events displayed on the History tab. When 
you specify filtering criteria and click Search, the Event List refreshes to 
display only events that match your criteria. 

 

Work with the Knowledge Tab 

The following topics contain procedures for using the Knowledge tab to search 
for, view, and work with knowledge documents and knowledge tree 
documents: 

Browse the Category Pane (see page 261) 
Browse the Knowledge Document List Pane (see page 261) 
Hide or Show Document Details (see page 262) 
Open a Knowledge Document (see page 252) 
Retrieve Documents by Category Path (see page 262) 
Search for Document (see page 263) 
Search for Documents Using Advanced Criteria (see page 264) 
Set Preferences for the Knowledge Document List (see page 265) 
Sort Documents in the Knowledge Document List Pane (see page 266) 
View New Documents (see page 266) 
View Response Time Statistics (see page 232) 
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Browse the Category Pane 

To navigate the Category pane on the Knowledge tab, click a folder or 
category name. 

When you click a folder or category name, the Knowledge Document List pane 
lists documents that reside in the currently selected folder or category and its 
subcategories. When you click the TOP category, the Knowledge Document List 
pane lists all of the documents in the knowledge base. 

To expand a category or subcategory and view its subcategories, click . To 
close a category or subcategory, click . 

Note: You can also click the links at the top of the Knowledge Document List 
pane (for example, ) to return to a previous level 
in the category hierarchy. 

 

Browse the Knowledge Document List Pane 

When you select a folder or category from the Category pane or you perform a 
search in the Knowledge Search pane, the Knowledge Document List pane 
displays a list of documents that reside in the selected folder or category and 
its subcategories or that result from the search. 

To open a document, click its title in the Knowledge Document List pane or 
right-click the document name and select a command from the shortcut menu. 

If the Knowledge Document List pane contains more documents than can 
display on a single page, you can use the following browse links at the top of 
the pane to navigate the list: 

<< 

Displays the first page of documents. 

< 

Displays the previous page of documents. 

> 

Displays the next page of documents. 

>> 

Displays the last page of documents. 

List All 

Displays all of the documents in a single scrollable list. 

An indicator at the top of the Knowledge Document List pane displays your 
current position and the total number of documents in the list. 
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Hide or Show Document Details 

You can select whether detailed information displays in the Knowledge 
Document List pane on the Knowledge tab. By default, the Knowledge 
Document List pane displays the following information: 

 Title (displays as the document heading in the Title column) 

 Summary (displays beneath the document heading in the Title column) 

 Document ID (displays to the right of the document heading in the 
Attributes column) 

 Modify Date (displays to the right of the document heading in the 
Attributes column) 

To hide or show the detailed information on the Knowledge Document List 
pane, follow these steps: 

1. Select Preferences from the View menu. 

The Preferences window opens. 

2. Do one of the following: 

3. To hide the detailed information on the Knowledge Document List pane so 
more documents can display on the pane simultaneously, clear the Show 
Document List Details check box. 

 To show the detailed information on the Knowledge Document List 
pane, select the Show Document List Details check box. 

4. Click Save. 

The Preferences window closes and the Preferences Detail window opens. 

5. Click Close Window. 

The Preferences Detail window closes. 

Retrieve Documents by Category Path 

To retrieve documents in a specific category path, follow these steps: 

1. Click Advanced Search in the Knowledge Search pane. 

The Knowledge Search pane expands to display advanced search fields. 

2. Click . 

The Category Selection window opens. 

3. Navigate to and select the category or subcategory for which to list 
documents. 

The Category Selection window closes and the Category box in the 
Knowledge Search pane refreshes to include the selected path. 
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4. Repeat Steps 2 and 3 for each category path for which to retrieve 
documents. 

5. (Optional) Specify other search criteria as appropriate. 

6. Click Search. 

The product performs the specified search and hides the advanced search 
fields. The Knowledge Document List pane refreshes to display the search 
results. 

 

Search for Documents 

To search the knowledge base for documents, follow these steps: 

1. Depending upon the default search type selected from the Search Type list 
on the Preferences window, enter the appropriate search criteria in the 
Search box on the Knowledge Search pane: 

 If Keyword Search is selected from the Search Type list, enter 
keywords for which to search in the Search box. Separate each 
keyword with a space or a comma. 

 If Natural Language Search is selected from the Search Type list, enter 
a question (for example, "How do I install a network printer?") in the 
Search box. 

2. Do one of the following: 

 To search only in the category or subcategory selected in the Category 
pane, select the Search Only in 'category' option. 

 To search in all categories and subcategories, select the Search All 
Categories option. 

Note: These options do not display on the Knowledge tab when you select 
the TOP category or the My Bookmarks or New Documents folder from the 
Category pane. 

3. Click Search. 

The product searches the knowledge base for documents that match your 
search criteria and displays the results in the Knowledge Document List 
pane. 
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Search for Documents Using Advanced Criteria 

When you click Advanced Search in the Knowledge Search pane of the 
Knowledge tab, the pane expands to display advanced search fields that you 
can use to specify criteria with which to narrow a search of documents in the 
knowledge base and to filter the results of that search. 

To use the advanced search fields to refine search results, follow these steps: 

1. Depending upon the default search type selected from the Search Type list 
on the Preferences window, enter the appropriate search criteria in the 
Search box on the Knowledge Search pane: 

 If Keyword Search is selected from the Search Type list, enter 
keywords for which to search in the Search box. Separate each 
keyword with a space or a comma. 

 If Natural Language Search is selected from the Search Type list, enter 
a question (for example, "How do I install a network printer?") in the 
Search box. 

2. Do one of the following: 

 To search only in the category or subcategory selected in the Category 
pane, select the Search Only in 'category' option. 

 To search in all categories and subcategories, select the Search All 
Categories option. 

Note: These options do not display on the Knowledge tab when you select 
the TOP category or the My Bookmarks or New Documents folder from the 
Category pane. 

3. Click Advanced Search. 

The Knowledge Search pane expands to display advanced search fields. 

4. Complete advanced search fields as appropriate. 

5. Click Search. 

The product searches the knowledge base for documents that match your 
search criteria and displays the results in the Knowledge Document List 
pane. 
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Set Preferences for the Knowledge Document List 

To set preferences for the contents of the Knowledge Document List on the 
Knowledge tab, follow these steps: 

1. Select Preferences from the View menu. 

The Preferences window opens. 

2. Locate the Knowledge Document List Settings options. 

3. (Optional) Select the number of documents to display on each page of the 
document list from the Documents Per Page list. 

4. (Optional) Do one of the following to specify whether details display for 
each document in the Knowledge Document List: 

 Select the Show Document List Details check box to display the title 
and additional attributes (for example, Summary, Status, Modify Date, 
and Owner) for each document. 

 Clear the Show Document List Details check box to display only the 
title for each document. 

5. Click Save. 

The Preferences window closes and the Preferences Detail window opens 
so you can review your settings. 

6. Do one of the following: 

 Click Close Window. 

The Preferences Detail window closes and the Knowledge Document 
List pane refreshes to reflect your settings. Select Refresh from the 
View menu to update the Knowledge Document List to reflect your 
settings. 

 Click Edit. 

The Preferences Detail window closes and the Preferences window 
opens so you can change your settings. 
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Sort Documents in the Knowledge Document List Pane 

To set the order in which documents display in the Knowledge Document List 
pane, select one of the following sort options from the Order By list: 

FAQ Rating 

Sorts documents based on their FAQ rating, which considers how often the 
document is accessed, how helpful it has been to users, and its age. 
Documents with the highest FAQ ratings are listed first. This is the default 
sort order. 

Hits 

Sorts documents by the number of times users have accessed them, with 
the most frequently accessed documents listed first. 

Modify Date 

Sorts documents by the date on which they were last modified, with the 
most recently modified documents listed first. 

Solution Count 

Sorts documents by the number of issues or requests they have resolved, 
as reported by users. Documents with the highest solution counts are 
listed first. 

When you change the Order By selection, the Knowledge Document List pane 
refreshes to reflect the new sort order. 

View New Documents 

The New Documents folder in the Category pane on the Knowledge tab 
contains documents published during the interval specified in the FAQ Options 
pane on the Administration tab (the default interval is five days). 

Note: The product also lists documents in the New Documents folder with 
their parent category. 

To view documents in the New Documents folder, follow these steps: 

1. Click New Documents in the Category pane on the Knowledge tab. 

The Knowledge Document List pane refreshes to display a list of 
documents in the New Documents folder. 

2. Click the title of a document to view. 

The document opens. 
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To set Unicenter SD to report information about its response time when 
performing various functions, follow these steps: 

1. Select Response Time Statistics from the View menu on the Knowledge 
tab. 

An informational message displays. 

2. Click OK. 

The informational message closes. 

3. Work with Unicenter SD as you typically do. 

Each time the product completes an action, a message containing the 
some or all of the following information displays: 

Request Time 

Displays the time (in hh:mm:ss format) and time zone at which you 
began the action for which statistics are reported. 

Load Start 

Displays the time (in hh:mm:ss format) and time zone at which the 
product began loading the document, window, or dialog that is the 
target of the action. If available, this statistic includes the elapsed time 
(in seconds) since your original request. 

Load Complete 

Displays the time (in hh:mm:ss format) and time zone at which the 
product finished loading the document, window, or dialog that is the 
target of the action. If available, this statistic includes the elapsed time 
(in seconds) since load start. 

User Resp Time 

Displays the total elapsed time (in seconds) from your original request 
to load complete. 

4. Do one of the following: 

 Click OK. 

The message closes and the product continues reporting response time 
statistics. 

 Click Cancel. 

The message closes and the product deactivates the Response Time 
Statistics function. 

 

Knowledge Tab  267  
 





 

Chapter 8: Keyword Search Tab 
 

The Keyword Search tab is the main interface for providing Knowledge Tools 
users with access to documents in the knowledge base to quickly resolve 
issues. From the Knowledge tab, users can: 

 Perform natural language (NLS) and keyword searches of the knowledge 
base 

 Filter and sort documents 

 Open and work with information provided by knowledge documents and 
knowledge tree documents 

Users with analyst, knowledge engineer, knowledge manager, or system 
administrator rights can access the Administration tab, which is the centralized 
console for managing content for each problem-solving model in the 
knowledge base. 

This tab has the following components: 

Menu Bar 

The menu bar on the Keyword Search tab provides access to the File, 
View, Window, and Help menus. 

Knowledge Search pane 

The Knowledge Search pane contains controls with which you can specify 
criteria for and initiate a basic or advanced search of the knowledge base. 
The pane occupies the entire Keyword Search tab until you perform a 
search, then it displays above the Knowledge Document List pane when 
you click Show Filter. Click Show Filter to display the search fields; click 
Hide Filter to close the Knowledge Search pane. When you click Search, 
the Knowledge Document List pane opens and lists documents that match 
your search criteria. 

Knowledge Document List Pane 

The Knowledge Document List pane displays documents that match the 
criteria specified in the Knowledge Search pane, or documents for the 
selected scoreboard item. Use the Knowledge Document List pane to 
browse the list of documents and to select documents with which to work. 
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Windows 
The Keyword Search tab provides access to a number of panes and windows to 
help you perform rapid knowledge base searches to quickly resolve issues. 
Typically, a window opens when you select a command from a menu or click a 
button in another window. For example, when you select Preferences from the 
View menu, the Preferences window opens. 

Add File window 

The Add File window opens when you do either of the following: 

 Right-click a folder or repository in the Repositories list from the 
Administration tab and select Add File from the shortcut menu 

 Right-click a folder or repository in the Repositories list on the 
Attachments tab on the Update Knowledge Document window and select 
Add File from the shortcut menu 

Use the Add File window to specify the location and name of a file to upload to 
the attachment library. When you click Upload, the product puts the specified 
file in the folder or repository you selected. 

This window contains the following fields: 

File 

Defines the location and name of a file to upload to the attachment library. 
If you click the Browse button, a standard Windows Choose File window 
opens so you can choose the file to upload. 

Example: C:\mydirectory\myfile.doc 

Name 

Enter an internal name that you can use to track the file. 

Description 

Enter an internal description of the file, for example, what the file is for, 
what it contains, or other descriptive text. 

This window contains the following buttons: 

Browse 

Opens a standard Windows Choose File window on which you can navigate 
to and select a file to upload. 

Upload 

Uploads the specified file to the attachment library and displays a prompt 
when the upload finishes. Click OK to close the prompt. 
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Close 

Closes the document, window, or dialog. 
 

Create New Comment window 

The Create New Comment window opens when you click Add Comment on the 
Comments tab on the Create New Document window or the Update Knowledge 
Document window. 

Use the Create New Comment window to enter a brief comment about the 
document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Defines a comment that provides information about the document. This 
field is required. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the comment and opens the View Comment window. 

Create New/Update/Detail Document Windows 

The Create New, Update, and Detail Document windows open when you do 
any of the following: 

 Right-click a category name in the Category pane of the Knowledge 
Categories pane on the Knowledge or Administration tab and select Create 
Knowledge Document or Create Knowledge Tree Document from the 
shortcut menu 

 Right-click a document title in the Knowledge Document List pane of the 
Knowledge Categories pane on the Knowledge or Administration tab and 
select Create Knowledge Document or Create Knowledge Tree Document 
from the shortcut menu 
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 Select a category in the Category pane of the Knowledge Categories pane 
on the Knowledge or Administration tab, then select Create Knowledge 
Document or Create Knowledge Tree Document from the File menu 

 Select New Knowledge Document or New Knowledge Tree Document from 
the File menu on the Knowledge tab (when Unicenter KT is installed) or 
the Keyword Search tab (when Unicenter KT is not installed). 

 Click Save on the Create New Document window 

 Right-click a document title in the Knowledge Categories pane on the 
Knowledge or Administration tab and select Open from the shortcut menu 

 Click a document title in the Knowledge Categories pane on the Knowledge 
or Administration tab 

 Right-click a document title in the Knowledge Document List pane on the 
Keyword Search tab and select Edit from the shortcut menu 

 Click Edit from the Knowledge Document window 

 Right-click a document title in the Knowledge Document List pane and 
select Edit from the shortcut menu 

Use the Create New Document window to define the initial content of a new 
knowledge document. 

Important! Make sure you use significant searchable words when filling in the 
Title, Summary, Problem and Resolution text fields, not just noise words. If 
you use only noise words, your document will become inaccessible after it is 
saved and indexed. 

Use the Update Knowledge Document window to update the content, 
attributes, permissions, category and document relationships, attachments, 
comments, and notifications for a document and to review the document's 
history. 

Note: The Update Knowledge Document window appears as the Detail 
Document window, without specifically stating the term update. Use the 
notebook pages to update the document. 

These windows include the Unicenter Service Desk banner, which may contain 
a menu bar, search fields, and other controls to help you work with 
information in Unicenter Service Desk. 

These windows contain one or more of the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 
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 Attachments 

 Comments 

 Notifications 

 History 

These windows contain some or all of the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Assign to Category Owner 

This check box lets you indicate whether to assign the new document to a 
category owner. Click the check box to assign the new document to a 
category owner, or click again to un-check. This field in enabled on the 
Create New Document window only. 

Title 

Defines a short, descriptive name for the document. For knowledge tree 
documents, the value in the Title box also defines the name of the primary 
node in the knowledge tree. 

Summary 

Defines a summary that briefly describes the problem associated with the 
document. Use the Problem box to describe the problem in detail. 

Problem 

Defines the full description of the problem associated with the document. 

NLS search type is based on this field. 
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Resolution 

Defines the description of how to resolve the problem. Click Edit Resolution 
to open the HTML Editor so you can create or update the resolution. This 
field only displays when you are creating or updating a knowledge 
document. 

Quick View 

Specifies to display content in the associated field as it will appear at 
runtime. This field only displays when you are creating or updating a 
knowledge document. 

HTML Source 

Specifies to display content in the associated field as editable HTML source 
code. Select this option to make simple changes directly to the HTML code. 
This field only displays when you are creating or updating a knowledge 
document. 

Notes 

Defines additional information about the document. The contents of this 
field are available only to analysts. 

Depending on the approval process task with which the document is currently 
associated, these windows may contain the following buttons: 

Edit 

Opens the Create/Update Document window so you can modify document 
contents and attributes. The edit window will only open if you are a user 
with write permission to the document. If you do not have write 
permission to the document, the read-only view window will open instead. 

Forward 

Opens the Forward Document window so you can assign the document to 
the analyst who will complete the next task in the approval process. When 
you click OK to forward the document, the Forward Document and Update 
Knowledge Document windows close and the Knowledge Document Detail 
window opens. The Forward button displays for all approval process tasks 
except the last (which is, by default, Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Publish 

Opens the Knowledge Document Detail window and makes the document 
available for viewing. 
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Note: System administrators can use the Publish button at any time to 
bypass the approval process and immediately publish a document. 
Analysts working on a document can use the Publish button if the 
document is at the last stage of the approval process and ready to be 
published. 

Reject 

Opens the Reject Document window so you can reject the document, 
reassigning it to the previous assignee. When you click OK to reject the 
document, the Reject Document and Update Knowledge Document 
windows close and the Knowledge Document Detail window opens. The 
Reject button displays for all approval process tasks except the first (which 
is, by default, Create Document. 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Unpublish 

Changes the status of the document from "Published" to draft (or the 
appropriate custom status), and removes the document from the 
knowledge base availability. This button only displays when a document's 
status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

Cancel 

Discards changes and opens view mode. 

Design Tree 

Opens the DT Builder so you can create the knowledge tree structure to 
associate with the document. This button only displays when you are 
creating or updating a knowledge tree document. 

Edit Resolution 

Opens the HTML Editor so you can use plain text or HTML elements to 
design a resolution for the problem that the knowledge document 
addresses. This button only displays when you are creating or updating a 
knowledge document. 
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Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves changes to the current document. 

Note: The Save button is only available on the Update/Create Document 
window if you have write access to the document. A document is read-only 
when it is published (as per Administrative option) or retired, or when the 
document's permissions preclude you from changing it. 

Spell Check All Fields 

Checks the content of the Title, Summary, Problem, Resolution, and Notes 
fields. If the text of any of the fields contains a spelling error (that is, a 
word that does not exist in the product dictionary), the Spell Check Results 
window opens. The window shows the contents of all non-empty fields, 
separated by headers of the form --TITLE--, --SUMMMARY-- and so on, 
with the first misspelled word highlighted. 

 

Date Helper window 

The Date Helper window opens when you click  on a window or dialog on 
which you must specify a date and time. 

Use the Date Helper window to select when an event defined by the window or 
dialog from which you accessed the Date Help window occurs. 

This window contains the following fields: 

Month 

Specifies the month during which an event occurs. 

Default: The month during which the Date Helper window opened. 

Year 

Specifies the year during which an event occurs. 

Limits: The year must be in the range 1994 to 2013. 

Default: The year during which the Date Helper window opened. 

Calendar 

Displays the days of the selected month and year. Click a day to select it. 

Default: The day during which the Date Helper window opened. 

24-Hour 

Specifies how to display the values in the Hour list. 

 Select the 24-Hour check box to display values in the Hour list using 
24-hour time format. 
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Example: 15. 

Clear the 24-Hour check box to display values in the Hour list using 
12-hour time format. 

Example: 3 pm. 

Default: The check box is cleared. 

Hour 

Specifies the hour during which an event occurs. 

Default: The hour during which the Date Helper window opened. 

Minute 

Specifies the minute during which an event occurs. 

Default: The minute during which the Date Helper window opened. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Next 

Sets the Month value to the month that follows the current selection and 
refreshes the Calendar control to display the days of the newly selected 
month. 

OK 

Closes the Date Helper window and sets the value of the field from which 
you accessed the window to the selected date and time. 

Prev 

Sets the Month value to the month that precedes the current selection and 
refreshes the Calendar control to display the days of the newly selected 
month. 
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Event for Document View window 

The Event for Document window opens when you right-click an Event on the 
History tab of the Update Knowledge Document window and select View from 
the shortcut menu. The fields on this window are read-only. 

Use the Event for Document window to view the detail of the selected event. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Event 

Displays the name of the selected event. 

Event Detail 

Displays the detail information for the selected event. 

Time Stamp 

Displays the date and time (in mm/dd/yyyy hh:mm am/pm format) at 
which the selected event occurred. 

Example: 08/23/2004 04:13 am 

Knowledge Document Window 

The Knowledge Document window opens when you do either of the following: 

 Click a Knowledge Document icon or title on: 

 The Knowledge Document List on the Knowledge tab. 

 The Knowledge Document List of the Knowledge Documents nodes of 
the Scoreboard on the Knowledge Tools tab. 

 Right-click a knowledge document title in the Knowledge Categories pane 
on the Administration tab, then select Document View from the shortcut 
menu 

 Right-click a knowledge document title in the Knowledge Document List on 
the Knowledge tab and select View from the shortcut menu. 

 Click a Knowledge Document link, for example, under the Top Solutions 
section. 

 Click a Knowledge Document link, for example, under the Top Solutions 
section of Customer or Employee user interface 

 Click a Knowledge Document icon or title in Activities tab of a Request or 
an Issue of KT Log Solution type 
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 Click a Knowledge Document icon or title after search on the Knowledge 
tab of a Request or an Issue 

Use the Knowledge Document window to view and interact with a knowledge 
document. 

Note: To create a new document or update an existing document, see Create 
New/Update/Detail Document Windows (see page 271). 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Documents contain a variety of information organized to optimize user access. 
Documents created using the default Built In - Knowledge Document template 
are divided into two areas: 

 The left side of the document (the document body) contains information 
about the problem the document addresses, the suggested resolution for 
the problem, and links to related resources. In addition to the document 
title, specific information displayed may include the following: 

Summary 

Displays a brief description of the problem associated with the document. 

Problem 

Displays the full description of the problem associated with the document. 

Resolution 

Displays the description of how to resolve the problem. 

See Also 

Displays links to other documents in the knowledge base that are related 
to the current document. Click a link under See Also to open the 
associated document in a new window. 

Attachments 

Displays links to files attached to the document as supplemental 
information. When you click a link, the attached file opens in an 
appropriate application. 

Related Categories 

Displays links to categories that are related to the document. Click a link 
under Related Categories to list the documents that reside in the linked 
category and its subcategories in the Knowledge Document List pane. 

Related Tickets 

Lists any tickets related to this document. 
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Properties 

Displays the properties specified in the document template. By default, the 
numeric Document ID and the date on which the document was created 
are displayed. 

Comments 

Displays comments added by document users through the Comment box 
on the document. Each comment displays with the name and email 
address of the contact who entered it and the date the comment was 
entered. 

 The right side of the document contains menus, page option links, solution 
survey fields, and comment fields. 

Page Options 

Displays commands for interacting with the document. Use the Page 
Options commands to edit, email, bookmark, print, close, and subscribe to 
the current document. You can also create a new request or create a new 
request based on the document being viewed, depending on how you 
accessed this window. 

 The Solution Survey and Comments are two boxes that let you rate and 
comment upon the document: 

Solution Survey 

Defines feedback regarding the effectiveness of the document in answering 
your question and lets you open an issue or request. The product uses 
your feedback to calculate the document's FAQ rating. 

Comment 

Defines comments to add to the document. For example, you might add a 
comment that clarifies the document's resolution. Comments you add 
display under the Comments heading in the document body. 

Note: Documents created using a customized template may contain different 
information. 
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Forward Document window 

The Forward Document window opens when you click Forward on the Update 
Knowledge Document window. 

Use the Forward Document window to move a document to the next stage of 
the approval process and to assign the document to an analyst for that stage. 
You can also specify an optional comment for the document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Next Task 

Displays the approval process task to which the document will be 
forwarded. This field is read-only. 

Next Status 

Displays the approval process status to which the document will be 
forwarded. The default statuses are: 

Draft 

The document has been created, and possibly assigned to an analyst 
for review and modification, but is not currently available in the 
knowledge base (that is, it is not published). 

Published 

The document is available in the knowledge base and those users or 
groups with access can view it. 

Retired 

The document has been removed from the knowledge base, either 
manually or as the result of the expiration date passing, and is no 
longer available. 

This field is read-only. 

Next Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. Select the name of the contact to assign 
the document to, or click  to open the Contact Search window so you can 
locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 
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Comment 

Defines a comment that provides information about the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm forwarding the document to the next approval 
process task. When you click OK, the Forward Document window closes. 
The forwarded document appears in the specified assignee's Inbox in the 
Knowledge Documents folder on the Service Desk tab. 

Knowledge Document Detail window 

The Knowledge Document Detail window opens when you do any of the 
following: 

 Click Cancel on the Update Knowledge Document window 

 Click Publish on the Update Knowledge Document window, then click OK to 
confirm publishing 

 Click OK on the Forward Document window, then click OK to confirm 
forwarding 

 Click OK on the Reject Document window, then click OK to confirm 
rejection 

Use the Knowledge Document Detail window to review the content and 
attributes defined for a document, to unpublish a document, or to preview a 
document as users will see it at runtime. 

This window contains the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 

 Notifications 

 History 
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This window contains the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

This window contains the following buttons: 

Edit 

Opens the Update Knowledge Document window so you can modify 
document contents and attributes. This command only displays for the 
document owner, for system administrators, and when the document 
status is "Unpublished." 

Unpublish 

Changes the status of the document from "Published" to "Unpublished", 
and removes the document from the knowledge base availability. This 
button only displays when a document's status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 

 

Keyword Search Tab  283  
 



Windows 
 

Email Document window 

The Email Document window opens when you click Email on the Page Options 
menu when viewing a document. 

Use the Email Document window to email a link to the document or a copy of 
the document to specified recipients. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Your Name 

Defines the name (in "last name, first name" format) of the user to 
identify as sender of the email. 

Default: Your name (as specified to the product). 

Your Email 

Defines the email address of the email sender. 

Default: The email address associated with your user account. 

Send To 

Defines the email addresses of contacts to whom you want to send the 
document or link. Enter one or more email addresses, or click  to open 
the Contact Search window so you can search for and select contacts. Use 
semicolons (;) to separate multiple email addresses. 

Subject 

Defines a subject for the email. 

Default: The document's type (Knowledge Document or Knowledge Tree 
Document) and ID. 

Personal Message 

Defines a text message to accompany the document or link you are 
sending. 

Send Document 

Specifies how the product should attach the document to your email. 
Select one of the following options: 

In HTML 

The product inserts the document in the body of the email in HTML 
format. Recipients can view the document directly in the email. 
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Link Only 

The product inserts a URL link in the email. Recipients must click the 
link to display the document in a web browser. 

Default: In HTML. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Closes the Email Document window and sends the email to the specified 
recipients. 

Knowledge Document List pane 

The Knowledge Document List pane displays documents that match the criteria 
specified in the Knowledge Search pane, or documents for the selected 
scoreboard item. Use the Knowledge Document List pane to browse the list of 
documents and to select documents with which to work. 

This pane contains the following columns: 

Title 

By default, displays the title and summary information defined for each 
document in the result set. When you click the document title, the 
document opens. When you right-click the document, the Knowledge 
Document List shortcut menu opens. 

Attributes 

Displays the attributes defined for each document in the result set. By 
default, the Attributes column includes the Document ID and Modify Date 
attributes. 

If the Knowledge Document List pane contains more documents than can 
display on a single page, you can use the following browse links at the top of 
the pane to navigate the list: 

<< 

Displays the first page of documents. 

< 

Displays the previous page of documents. 

> 

Displays the next page of documents. 
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>> 

Displays the last page of documents. 

List All 

Displays all of the documents in a single scrollable list. 

An indicator at the top of the Knowledge Document List pane displays your 
current position and the total number of documents in the list. 

Knowledge Search pane 

The Knowledge Search pane contains controls with which you can specify 
criteria for and initiate a basic or advanced search of the knowledge base. The 
pane occupies the entire Keyword Search tab until you perform a search, then 
it displays above the Knowledge Document List pane when you click Show 
Filter. Click Show Filter to display the search fields; click Hide Filter to close 
the Knowledge Search pane. When you click Search, the Knowledge Document 
List pane opens and lists documents that match your search criteria. 

Advanced search options allow overriding the Knowledge Search Document 
Settings on the Preferences window. 

This pane contains the following fields: 

Keywords for Advanced Search 

Defines a space-delimited list of words or a phrase by which to filter 
documents retrieved. When you click Search, the product returns only 
documents that contain the specified keywords. 

Whole words with % wild cards 

Search text should contain at least two letters before percent sign, for 
example, 'xy%'; leading percent as in '%xy' is prohibited. Words 
beginning with search text should contain more than one letter. One 
digit is allowed. 

Search In 

Specifies which document fields to search for specified keywords. When you 
click Search, the product returns only documents that contain the specified 
keywords in the fields specified by the selected Search In check boxes. Select 
any combination of the following check boxes: 

 Problem 

 Resolution 

 Summary 

 Title 
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These check boxes only display when Keyword Search is the selected 
search type. If you select Natural Language Search from the Search Type 
list, the Search In check boxes do not display and the product only 
searches the Problem fields of documents. 

Search Type 

Specifies the type of search to perform. Select one of the following 
options: 

Keyword Search 

Select this option to search for the specified keywords in the Title, 
Summary, Problem, and Resolution fields of documents. Use the 
Search In check boxes to exclude one or more of these fields. 

Natural Language Search 

Select this option to search for the specified text only in the Problem 
fields. Natural Language Search (NLS) allows you to perform a search 
using natural language, which compares the pattern of words 
contained in the query with the patterns of words contained in the 
Problem field of knowledge base documents. 

Default: Keyword Search. 

Match Type 

Specifies the method for text matching during the search. Select one of 
the following options: 

Any of the Words (OR) 

A match occurs when the product finds any of the specified words in a 
document. 

All of the Words (AND) 

A match occurs only when the product finds all of the specified words 
in a document. 

Default: Any of the Words (OR). 

Match Type 

Specifies the method by which the product searches documents. Select 
one of the following options: 

Whole words 

The search retrieves only documents that contain the entire words 
entered. 

Words beginning with... 

The search retrieves documents that contain the entire words entered 
or words that begin with the words entered. For example, a search for 
the word "print" also returns documents containing the words "printer" 
or "printing". 
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The Match list setting overrides the default set on the Preferences window 
and is only available when you specify keywords or phrases for which to 
search. 

Default: Whole words. 

Order By 

Specifies a criterion by which to sort search results. Select one of the 
following options: 

Relevance 

Sorts documents by their relevance to the specified search criteria 
(expressed as EXCELLENT, GOOD, and so on). Documents with the 
highest relevance (EXCELLENT) are listed first. 

Hits 

Sorts documents by the number of times users have accessed them, 
with the most frequently accessed documents listed first. 

Solution Count 

Sorts documents by the number of issues or requests they have 
resolved, as reported by users. Documents with the highest solution 
counts are listed first. 

Modify Date 

Sorts documents by the date on which they were last modified, with 
the most recently modified documents listed first. 

Owner 

Defines the name of the owner by which to filter documents retrieved. Do 
one of the following: 

 Enter the name of the owner in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select an owner. 

 Enter some or all of the owner name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Owner box. 

When you click search, the product returns only documents associated 
with the specified owner. 

288  Administrator Guide 
 



Windows 
 

Author 

Defines the author name by which to filter documents retrieved. Do one of 
the following: 

 Enter the name of the author in "last name, first name" format. 

 Click  to open the Contact Search dialog so you can locate and select 
an author. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Author box. 

When you click Search, the product returns only documents associated 
with the specified author. 

Subject Expert 

Defines the expert by which to filter documents retrieved. Do one of the 
following: 

 Enter the name of the expert in "last name, first name" format. 

 Click  to open the Contact Search dialog so you can search for and 
select an expert. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the Subject Expert box. 

When you click Search, the product returns only documents associated 
with the specified subject expert. 

Priority 

Specifies the priority level (1, 2, 3, 4, 5, or None) by which to filter 
documents retrieved. When you select no priority (that is, you leave 
<empty> as the field value), the product does not consider priority when 
filtering documents. When you click Search, the product returns only 
documents with the specified priority. 

Default: <empty>. 

Severity 

Specifies a severity level (1, 2, 3, 4, or 5) by which to filter documents 
retrieved. When you select no severity (that is, you leave <empty> as the 
field value), the product does not consider severity when filtering 
documents. When you click Search, the product returns only documents 
associated with the specified severity level. 
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Default: <empty>. 

Product 

Defines a product by which to filter documents retrieved. Enter the name 
of the product in the box, or click  to open the Product Search window so 
you can search for and select one. When you click Search, the product 
returns only documents associated with the specified product. 

Asset 

Defines the name of an asset (hardware, software, or service) by which to 
filter documents retrieved. Enter the name of the asset in the box, or click 

 to open the Asset Search window so you can search for and select one. 
When you click Search, the product returns only documents associated 
with the specified asset. 

Root Cause 

Defines a root cause (that is, the core reason for opening the ticket) by 
which to filter documents retrieved. Possible root causes might include 
Hardware Failure, Software Failure, and Network Cable. Enter the root 
cause in the box, or click  to open the Root Cause Selection window so 
you can search for and select one. When you click Search, the product 
returns only documents associated with the specified root cause. 

Impact 

Specifies the level of impact (1, 2, 3, 4, 5, or none) by which to filter 
documents retrieved. When you select no impact (that is, you leave 
<empty> as the field value), the product does not consider impact when 
filtering documents. When you click Search, the product returns only 
documents associated with the specified impact. 

Default: <empty>. 

Urgency 

Specifies an urgency level (1, 2, 3, 4, or 5) by which to filter documents 
retrieved. When you select no urgency level (that is, you leave <empty> 
as the field value), the product does not consider urgency when filtering 
documents. When you click Search, the product returns only documents 
associated with the specified urgency level. 

Default: <empty>. 

Title 

Defines a document title by which to filter documents retrieved. When you 
click Search, the product returns only documents with the specified title. 

Summary 

Defines a document summary by which to filter documents retrieved. 
When you click Search, the product returns only documents with the 
specified summary. 
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Additional Search Arguments 

Defines additional criteria by which to search. This field only displays when 
you click a More link in the Knowledge Search pane. 

This pane contains the following buttons: 

Clear Filter 

Returns all filter fields on the pane or window to their default values. 

Search 

Initiates a search for items that match the specified criteria. When you 
specify no criteria, the product returns all appropriate items (for example, 
folders/documents, contacts, templates, noise words, or permission 
groups). 

Show/Hide Filter 

Displays or hides fields with which you can filter a search for items on the 
current window, pane, or dialog. 

Knowledge Tree Document window 

The Knowledge Tree Document window opens when you do any of the 
following: 

 Right-click a knowledge tree document title in the Knowledge Categories 
pane, then select Document View from the shortcut menu 

 Click a knowledge tree document title in the Knowledge Document List on 
the Knowledge tab 

 Right-click a knowledge tree document title in the Knowledge Document 
List on the Knowledge tab, then select View from the shortcut menu. 

Use the Knowledge Tree Document window to view and interact with a 
knowledge tree document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Documents contain a variety of information organized to optimize user access. 
Documents created using the default Built In - Knowledge Tree Document 
template are divided into three areas: 

 The left pane contains a dynamic map of the document. The bottom entry 
in the map indicates the current location in the document. Use the map in 
the left pane as necessary to navigate to previously viewed branches of 
the knowledge tree document. 
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 The right pane contains the knowledge tree document, a menu, and two 
boxes that let you rate and comment upon it the document. This pane 
contains the following components: 

Document View 

Displays the document as a knowledge tree. In this mode, the window 
contains information about the problem the document addresses, the 
suggested resolution for the problem, and links to related resources. 
To view the document as a knowledge tree, click the Display button 
under the Resolution heading. 

Tree Navigation 

Provides navigation to nodes in the knowledge tree that you have 
already viewed. The following links may be available: 

Tree Description-Displays a description of the purpose of the 
knowledge tree document, if one was defined. 

Start Over-Returns to the first page of the document. 

Prev-Returns to the previous page of the document. 

Next-Returns to the next page of the document. 

Last-Returns to the last viewed page of the document. 

Page Options menu 

Displays commands for interacting with the document. Use the Page 
Options commands to edit, email, bookmark, print, close, and 
subscribe to the current document. You can also create a new request 
or create a new request based on the document being viewed, 
depending on how you accessed this window. 

Solution Survey 

Defines feedback regarding the effectiveness of the document in 
answering your question and lets you open an issue or request. The 
product uses your feedback to calculate the document's FAQ rating. 

Comment 

Defines comments to add to the document. For example, you might 
add a comment that clarifies the document's resolution. Comments 
you add display under the Comments heading in the document body. 

Note: Documents created using a customized template may contain different 
information. 
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Preferences Window 

The Preferences Settings window opens when you do either of the following: 

 Select Preferences from the View menu 

 Click Edit on the Preferences Detail window 

Use the Preferences window to set default Knowledge Tools behaviors. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Avoid Popups 

Specifies whether to reduce the number of new browser windows opened 
by displaying new forms in the main browser window whenever possible. 

 Select the check box to minimize the number of new browser windows 
opened. 

 Clear the check box to open new browser windows according to the 
properties set in the form definition. 

Default: Cleared. 

Note: If this option is selected, the Back to List button will be activated, 
and can be used to navigate from detail forms back to the previously 
displayed list window. The Back to List button will appear in the upper 
right-hand side of the window. 

Display Score Count 

Specifies whether you want to display the score count left-justified. 

Default: Cleared. 

Keep Log Reader Window 

Specifies whether to keep the Log Reader window open when you select 
the Close All Popups command from the Window menu and after you log 
off of Knowledge Tools. This setting has no effect when the Log Reader 
window is not open. 

 Select the check box to keep the Log Reader window open. 

 Clear the check box to close the Log Reader window when you select 
the Close All Popups command or log off of Knowledge Tools. 

Default: Selected. 

Preserve Popup Size 

Specifies whether to open new popup windows with the same dimensions 
as the most recently resized popup window. 

Keyword Search Tab  293  
 



Windows 
 

 Select the check box to use the new dimensions for new popup 
windows. 

 Clear the check box to open new popup windows with default 
dimensions. 

Default: Selected. 

Note: If you set Preserve Popup Size to on (checked), and you maximize a 
popup window, subsequent popup windows may cover any other Service 
Desk window you may have open. However, new popup windows will 
appear slightly off the screen, to the right and lower. This is because there 
is a 10 pixel (left and top) offset for popups - so that they do not 
completely overlay the currently displayed window. It is recommended 
that you do not maximize popup windows when using the Preserve Popup 
Size option. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Using Screen Reader 

Selecting this preference modifies Service Desk behavior for optimal use 
with a screen reader for blind and limited vision users. You must log off 
and log back on again after changing this preference. From the Service 
Desk Help menu, select the item "Screen Reader Usage", for an overview 
of using Service Desk with a screen reader. 

Search Type 

Specifies the default type of search to perform. Select one of the following 
options: 

Keyword Search 

Select this option to search for the specified keywords in the Title, 
Summary, Problem, and Resolution fields of documents. 

Natural Language Search 

Select this option to search for the specified keywords in the Problem 
fields of documents. 

The Search Type field displayed when you click Show Filter in the 
Knowledge Document List pane overrides this setting. 

Default: Keyword Search. 
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Match Type 

Specifies the default method for text matching during a search. Select one 
of the following options: 

Any of the Words (OR) 

A match occurs if the product finds any of the words specified in the 
Keywords for Advanced Search box in a document. 

All of the Words (AND) 

A match occurs only if the product finds all of the words specified in 
the Keywords for Advanced Search box in a document. 

Exact Phrase 

A match occurs only if the product finds the exact phrase specified in 
the Keywords for Advanced Search box in a document. 

The Match Type field displayed when you click Show Filter in the 
Knowledge Document List pane overrides this setting. 

Default: Any of the Words (OR). 

Match 

Specifies the default method by which the product searches documents. 
Select one of the following options: 

Whole words 

The search retrieves only documents that contain the entire words 
entered. 

Words beginning with... 

The search retrieves documents that contain the entire words entered 
or words that begin with the words entered. For example, a search for 
the word "print" also returns documents containing the words "printer" 
or "printing". 

The Match field displayed when you click Show Filter in the Knowledge 
Document List pane overrides this setting. 

Default: Whole words. 

Order By 

Specifies the default property by which to sort documents retrieved. The 
Order By field displayed when you click Show Filter in the Knowledge 
Document List pane overrides this setting. 

Default: Relevance. 

Keyword Search Tab  295  
 



Windows 
 

Search In 

Specifies which document fields to search for specified keywords. When you 
click Search, the product returns only documents that contain the specified 
keywords in the fields specified by the selected Search In check boxes. Select 
any combination of the following check boxes: 

 Problem 

 Resolution 

 Summary 

 Title 

These check boxes only display when Keyword Search is the selected search 
type. If you select Natural Language Search from the Search Type list, the 
Search In check boxes do not display and the product only searches the 
Problem fields of documents. 

Default: All check boxes are selected. 

Documents Per Page (Knowledge Document List Settings) 

Specifies the number of documents (25 or 50) to display on each page of 
the Knowledge Document List pane. 

Default: 25. 

Show Document List Details 

Specifies whether detailed information displays in the Knowledge 
Document List pane on the Knowledge tab. 

Select the check box to display the following default information: 

 Title 

 Summary 

 Document ID 

 Modify Date 

Clear the check box to display only the document title. 

Default: The check box is selected. 

Documents Per Page (Knowledge Categories Document List Settings) 

Specifies the number of documents (25 or 50) to display on each page of 
the Knowledge Document List pane. 

Default: 25. 

Attributes to be shown in list 

Displays two lists with which you can define the properties that display for 
each document in the Knowledge Document List pane on the Knowledge 
Categories pane of the Administration tab. 
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 To display a property in the Knowledge Document List pane, select it 
from the Available List and use the > (Select Item) button to move it 
to the Selected list. 

 To move all of the properties from the Available list to the Selected 
list, click >> (Select All Available Items). 

 To remove a property from the Knowledge Document List pane, select 
it from the Selected list and use the < (Remove Item from Selected 
List) button to move it to the Available list. 

 To move all of the the properties from the Selected list to the Available 
list, click << (Remove All Items from Selected List). 

To select multiple items in either the Available or Selected list, hold down 
the Ctrl key while you click each item you want to select or hold down the 
Shift key while you click the first and last items in a series. 

Default: DOC ID, Owner, Assignee, Modify Date, and Document Status 
display in the Selected list. 

Note: Choosing attributes different than the Preference default may 
impact performance. If you believe that extra display columns are needed, 
contact the system administration and ask them to use the Web Screen 
Painter utility to modify the default page columns for the Document List 
form. 

Active Zone 

From the drop down list, select the active zone for your Global Knowledge 
Tools environment, for example, your organization's Intranet. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves and applies the specified settings, closes the current window, and 
opens the Preferences Detail window (see page 298). 
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Preferences Detail window 

The Preferences Detail window opens when you click Save or Cancel on the 
Preferences window. 

Use the Preferences Detail window to review default Knowledge Tools 
behaviors. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Avoid Popups 

When selected, will reduce the number of new browser windows opened by 
displaying new forms in the main browser window whenever possible. 

Note: If this option is selected, the Back to List button will be activated, 
and can be used to navigate from detail forms back to the previously 
displayed list window. The Back to List button will appear in the upper 
right-hand side of the window. 

Display Score Count 

Displays the score count as left-justified.. 

Keep Log Reader Window 

Displays whether the product will keep the Log Reader window open when 
you select the Close All Popups command from the Window menu and 
after you log off of Unicenter SD. This setting has no effect when the Log 
Reader window is not open. 

Preserve Popup Size 

Displays whether the product will open new popup windows with the same 
dimensions as the most recently resized popup window. 

Note: If you set Preserve Popup Size to on (checked), and you maximize a 
popup window, subsequent popup windows may cover any other Service 
Desk window you may have open. However, new popup windows will 
appear slightly off the screen, to the right and lower. This is because there 
is a 10 pixel (left and top) offset for popups - so that they do not 
completely overlay the currently displayed window. It is recommended 
that you do not maximize popup windows when using the Preserve Popup 
Size option. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 
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Using Screen Reader 

Selecting this preference modifies Service Desk behavior for optimal 
use with a screen reader for blind and limited vision users. You must 
log off and log back on again after changing this preference. From the 
Service Desk Help menu, select the item "Screen Reader Usage", for 
an overview of using Service Desk with a screen reader. 

Search Type 

"Using" indicates the type of search to perform. Select either Keyword 
Search or Natural Language Search. 

Match Type 

Displays the default method for text matching during a search. Possible 
values are Any of the Words (OR), All of the Words (AND), and Exact 
Phrase. 

Match 

Displays the default method by which the product searches documents, 
either Whole Words or Words Beginning With. 

Order By 

Displays the default property by which the product will sort documents 
retrieved. 

Mouseover Menus 

When this box is checked, a menu will display when the mouse pointer is 
over its link. A mouse click is not required. This setting requires that you 
to reload any active forms for it to take effect. 

Search In 

Displays which document fields the product will search for specified 
keywords. These check boxes only display when Keyword Search is the 
selected search type. 

Documents Per Page (Knowledge Document List Settings) 

Displays the number of documents (10, 25, or 50) that the product will 
display on each page of the Knowledge Document List pane. 

Show Document List Details 

Displays whether the Knowledge Document List pane on the Knowledge 
tab includes detailed information. If the check box is selected, the 
following default information displays: 

 Title 

 Summary 

 Document ID 

 Modify Date 
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If the check box is cleared, on the document title displays. 

Documents Per Page (Knowledge Categories Document List Settings) 

Displays the number of documents (10, 25, or 50) that the product will 
display on each page of the Knowledge Document List pane. 

Attributes to be shown in list 

Displays the properties listed for each document in the Knowledge 
Document List pane of the Knowledge Categories pane on the 
Administration tab. 

Note: Choosing attributes different than the Preference default may 
impact performance. If you believe that extra display columns are needed, 
contact the system administration and ask them to use the Web Screen 
Painter utility to modify the default page columns for the Document List 
form. 

Active Zone 

From the drop down list, select the active zone for your Global Knowledge 
Tools environment, for example, your organization's Intranet. 

This window contains the following buttons: 

Edit 

Opens the Preferences window so you can modify preferences. 
 

Preview Window (User View) 

The Preview window opens when you do either of the following: 

 Click User View on the Update Knowledge Document window 

 Click User View on the Knowledge Document Detail window 

 Right-click a Document in the Document List in the Knowledge Categories 
window under the Administration tab, and select User View 

Use the Preview window to view the current document as it will display to 
users at runtime. This enables you to verify your design before you publish the 
document. The fields on this window are read-only. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

Use the Print command in the Page Options menu on the upper right side of 
the Preview window to opens a standard Windows Print dialog so you can 
specify options for printing the contents of the current document. 
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Reject Document window 

The Reject Document window opens when you click Reject on the Update 
Knowledge Document window. 

Use the Reject Document window to move a document to a previous approval 
process task and assign an analyst to the document for that task. When 
multiple previous tasks exist, system administrators can choose the approval 
process task to which the document will revert. Assignees without 
administrator privileges can reject the document back to the previous task in 
the approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Previous Tasks 

Lists approval process tasks to which the document can revert. This field 
only displays if the current assignee has administrator privileges and there 
are multiple previous tasks in the approval process. 
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For each task, the Previous Tasks list displays the assignee who completed 
the task and the date on which the document was forwarded. When you 
click a task name to select the task to which to reject the document, the 
Reject Document window refreshes so you can specify an assignee and 
enter a comment. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm rejecting the document to a previous approval 
process task. When you click OK, the Reject Document window closes and 
the rejected document appears in the specified assignee's Inbox in the 
Knowledge Document folder on the Service Desk tab. 

The Spell Check Results window opens when you check spelling or click the 
Spelling button. The spell checker scans the header or body information and 
displays each unrecognized word in the Spell Check Results window. Use the 
window to specify what action to take on such words. When you correct or 
otherwise act upon a word, the product moves to the next unrecognized word, 
and so on until it has scanned the entire header or body. 

You can use the Spell Check Results window to do the following: 

 Correct the spelling of a specific occurrence of the unrecognized word in 
the template header or body 

 Correct the spelling of all occurrences of the unrecognized word in the 
template header or body 

 Select a word to replace the unrecognized word 

 Ignore a specific occurrence of the unrecognized word in the template 
header or body 
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 Ignore all occurrences of the unrecognized word in the template header or 
body 

This window contains the following fields: 

Not in Dictionary 

Displays the word that the product has identified as misspelled (that is, 
not in the product dictionary). 

Limits: This field is read-only. 

Change To 

Displays the word in the product dictionary that is the closest in spelling to 
the unrecognized word or the current selection from the Suggestions list. 

You can accept the spelling of the replacement as presented or type an 
alternate spelling in the Change To box, then do one of the following: 

 Click Change. The product changes the current occurrence of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

 Click Change All. The product changes all occurrences of the word 
displayed in the Not in Dictionary field to the word displayed in the 
Change To box. 

Suggestions 

Specifies words that are close in spelling to the unrecognized word. When 
you select a word from the list, it displays in the Change To box. 

Context 

Displays the unrecognized word in the context in which it is used in the 
template. 

Editing the text in the Context box has no effect on the template's 
contents. 

This window contains the following buttons: 

Change 

Changes the current occurrence of the word in the Not in Dictionary field 
to the word in the Change To box. 

Change All 

Changes all instances of the word in the Not in Dictionary field to the word 
in the Change To box. 

Close 

Closes the document, window, or dialog. 
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Ignore 

Disregards the current instance of the unrecognized word and advances to 
the next unrecognized word. If there are no additional unrecognized 
words, the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 

Ignore All 

Disregards all instances of the unrecognized word and advances to the 
next unrecognized word. If there are no additional unrecognized words, 
the Spell Check Results window closes and the product displays an 
informational message. Click OK to close the message. 

Unpublish Document window 

The Unpublish Document window opens when you do either of the following: 

 Click Unpublish on the Update Knowledge Document window 

 Click Unpublish on the Knowledge Document Detail window 

Use the Unpublish Document window to remove the document from the 
knowledge base so it is no longer available to users. If you have administrator 
privileges, you can use the Unpublish Document window to retire the 
document (that is, remove it from the knowledge base and the approval 
process) or select the approval process task to which the document will revert. 
If you do not have administrator privileges, the document reverts to the 
previous task in the approval process. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 
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This field is read-only. 

Previous Tasks 

Lists approval process tasks to which the document can revert. This field 
only displays if the current assignee has administrator privileges and there 
are multiple previous tasks in the approval process. 

For each task, the Previous Tasks list displays the default assignee for the 
task. When you click a task name to select the task to which to unpublish 
the document, the Unpublish Document window refreshes so you can 
specify an assignee and enter a comment. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 

Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm unpublishing the document to a previous approval 
process task. When you click OK, the Unpublish Document window closes 
and the unpublished document appears in the specified assignee's Inbox in 
the Knowledge Documents folder on the Service Desk tab. 

Retire this Document 

Prompts you to confirm retiring the selected document. When you click 
OK, the Unpublish Document window closes and the product removes the 
document from the knowledge base and the approval process. 
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Unretire Document window 

The Unretire Document window opens when you click Unretire on the Update 
Knowledge Document window. 

Use the Unretire Document window to return a retired document to the 
knowledge base and workflow. If you are a system administrator, you can 
republish the document or (when multiple tasks exist) choose the approval 
process task to which the document will return. Assignees without 
administrator privileges can return the document to the previous task in the 
approval process. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

Title 

Displays the title of the document. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Previous Task 

Displays the approval process task to which the document will revert. The 
Previous Task field displays under the following circumstances: 

 When the window first displays and the current assignee does not have 
administrator privileges or there is only one previous task. If the 
current assignee has administrator privileges and there are multiple 
previous tasks, the Previous Tasks list displays instead. 

 When you select the task to which to assign the document and the 
window refreshes so you can specify an assignee and enter a 
comment. 

This field is read-only. 

Assignee 

Specifies a contact to have responsibility for the document for the duration 
of the next approval process task. This field displays after you select a 
task to which to assign the document. Select the name of the contact to 
assign the document to, or click  to open the Contact Search window so 
you can locate and select one. 

Default: The contact assigned the task in the approval process template 
associated with the document. 
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Comment 

Defines a comment that provides information about the document. This 
field displays after you select a task to which to assign the document. 

This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

OK 

Prompts you to confirm unretiring the document to the selected approval 
process task. When you click OK, the Unretire Document window closes 
and the document appears in the specified assignee's Inbox in the 
Knowledge Documents folder on the Service Desk tab. 

Publish this Document 

Unretires and publishes the document. When you click Publish this 
Document, the product prompts you to confirm the action. Click OK to 
close the message and the Unretire Document window, and republish the 
document. 

Update Comment window 

The Update Comment window opens when you do any of the following: 

 Click Edit on the View Comment window 

 Click a comment on the Comments tab of the Update Knowledge 
Document window 

 Right-click a comment on the Comments tab of the Update Knowledge 
Document window, then select Edit from the shortcut menu 

Use the Update Comment window to edit a comment associated with the 
current document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Defines a comment that provides information about the document. This 
field is required. 
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This window contains the following buttons: 

Cancel 

Discards changes and opens view mode. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the comment and opens the View Comment window. 

The Update Knowledge Document window opens when you do any of the 
following: 

 Click Save on the Create New Document window 

 Right-click a document title in the Knowledge Categories pane on the 
Administration tab and select Open from the shortcut menu 

 Click a document title in the Knowledge Categories pane on the 
Administration tab 

 Right-click a document title in the Knowledge Document List pane on the 
Keyword Search tab and select Edit from the shortcut menu 

Use the Update Knowledge Document window to update the content, 
attributes, permissions, category and document relationships, attachments, 
comments, and notifications for a document and to review the document's 
history. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following tabs: 

 Content 

 Attributes 

 Permissions 

 Categories 

 Attachments 

 Comments 

 Notifications 

 History 
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This window contains the following fields: 

ID 

Displays the ID number that the product assigned the document at 
creation. This field is read-only and for new documents, contains no value 
until you save the document. 

Indexing Status 

Possible statuses include Pending and Indexed. This field is read-only and 
for new documents, contains no value until you save the document. 

Current Task 

Displays the approval process task with which the document is currently 
associated. This field is read-only. 

Current Status 

Displays the approval process status with which the document is currently 
associated. This field is read-only. 

Depending on the approval process task with which the document is currently 
associated, this window may contain the following buttons: 

Cancel 

Discards changes, closes the current window, and opens the Knowledge 
Document Detail window. 

Forward 

Opens the Forward Document window so you can assign the document to 
the analyst who will complete the next task in the approval process. When 
you click OK to forward the document, the Forward Document and Update 
Knowledge Document windows close and the Knowledge Document Detail 
window opens. The Forward button displays for all approval process tasks 
except the last (which is, by default, Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Publish 

Opens the Knowledge Document Detail window and makes the document 
available for viewing. 

Note: System administrators can use the Publish button at any time to 
bypass the approval process and immediately publish a document. 
Analysts working on a document can use the Publish button if the 
document is at the last stage of the approval process and ready to be 
published. 

Keyword Search Tab  309  
 



Windows 
 

Reject 

Opens the Reject Document window so you can reject the document, 
reassigning it to the previous owner and task. When you click OK to reject 
the document, the Reject Document and Update Knowledge Document 
windows close and the Knowledge Document Detail window opens. The 
Reject button displays for all approval process tasks except the first (which 
is, by default, Create Document) and the last (which is, by default, 
Publish). 

Note: This button only displays when the approval process contains 
multiple tasks and the final task has not been performed. The system 
administrator can add as many tasks as appropriate to the approval 
process. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves changes to the current document and (as appropriate) notifies 
analysts of the changes. 

Note: The Save button is only available on the Update/Create Document 
window if you have write access to the document. A document is read-only 
when it is published (as per Administrative option) or retired, or when the 
document's permissions preclude you from changing it. 

Unpublish 

Changes the status of the document from "Published" to "Unpublished", 
and removes the document from the knowledge base availability. This 
button only displays when a document's status is "Published". 

If you are a system administrator, the Unpublish button opens the 
Unpublish Document window so you can retire the unpublished document 
or associate it with a new owner and the approval process task specified 
on the Administration tab. If you are a non-administrative user, the 
product associates the document with the approval process task specified 
on the Administration tab when you unpublish it. 

User View 

Opens the Preview window, which presents the document as it will appear 
when a user displays it. 
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Update Notification window 

The Update Notification window opens when you do either of the following: 

 Right-click an alternate email address or a user name on the Notifications 
tab of the Update Knowledge Document window and select Edit from the 
shortcut menu 

 Click Edit on the View Notification window 

Use the Update Notification window to edit the user name or alternate email 
address associated with a document notification. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following fields: 

User Name 

Defines the name of the contact to notify of activity associated with the 
current document. Do one of the following: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select a contact. 

 Enter some or all of the contact name and click  to open the Contact 
List window so you can select from entries that match the characters 
you entered. For example, if you enter "Pa", the Contact List window 
lists all contacts whose last name begins with "Pa". If only one contact 
matches the characters you entered, the product inserts the contact 
name in the User Name box. 

Alternate Email 

Defines an alternate email address to which to send notifications in 
addition to the address associated with the specified contact. 

This window contains the following buttons: 

Cancel 

Discards changes, closes the current window or dialog, and opens the View 
Notification window. 

Reset 

Returns all fields on the window or dialog to their default values. 

Save 

Saves the notification and opens the View Notification window. 
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View Comment window 

The Comment for Document Detail window opens when you do any of the 
following: 

 Click Save on the Create New Comment window 

 Click Save on the Update Comment window 

 Click Cancel on the Update Comment window 

 Right-click a comment on the Comments tab of the Update Knowledge 
Document window and select View from the shortcut menu 

Use the View Comment window to review a comment you added or edited for 
a document. 

This window includes the Unicenter Service Desk banner, which may contain a 
menu bar, search fields, and other controls to help you work with information 
in Unicenter Service Desk. 

This window contains the following field: 

Comment 

Displays a comment that provides information about the document you are 
editing, forwarding, rejecting, publishing, unpublishing, or unretiring. This 
field is read-only. 

This window contains the following buttons: 

Close 

Closes the document, window, or dialog. 

Edit 

Opens the Update Comment window so you can modify the comment. 
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View Notification window 

The View Notification window opens when you do any of the following: 

 Click Save on the Create New Notification window 

 Click Save on the Update Notification window 

 Click Cancel on the Update Notification window 

Use the View Notification window to review a new or updated notification. 

This window contains the following fields: 

User Name 

Displays the name of the contact or group to notify. 

Alternate Email 

Displays the alternate email address defined for the contact, if one exists. 

This window contains the following buttons: 

Close 

Closes the document, window, or dialog. 

Edit 

Opens the Update Notification window so you can edit the selected 
notification. 

 

Windows window 

The Windows window opens when you select List All Windows from the 
Window menu on the Knowledge tab. 

Use the Windows window to view a list of windows that Knowledge Tools 
currently has open and to navigate directly to a specific open window. 

To move focus (that is, navigate) to a specific window, click its name on the 
Windows window. 

This window contains the following buttons: 

Close Window 

Closes the current window. 

Refresh 

Updates the list of open windows. 
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Menus 
The menu bar on the Keyword Search tab contains the following menus: 

 File (see page 314) 

 View (see page 315) 

 Window (see page 316) 

 Help (see page 316) 

Note: Some windows and dialogs contain menu bars with window-specific 
commands. For information about window- or dialog-specific menu bars, see 
the appropriate topics in this help system. 

The Keyword Search tab also includes shortcut menus that open when you 
right-click an item in the Knowledge Document List pane. For example, if you 
right-click a document in the Knowledge Document List pane, the Knowledge 
Document List shortcut menu opens. 

 

File menu 

The commands on the File menu let you print the current window or create a 
knowledge document or knowledge tree document. 

This menu contains one or more of the following commands: 

New Knowledge Document 

Opens the Create New Document window so you can define the content 
and attributes of a new knowledge document in the selected category. 

New Knowledge Tree Document 

Opens the Create New Document window so you can define the content 
and attributes of a new knowledge tree document in the selected category. 

Print Form 

Opens a standard Windows Print dialog so you can specify options for 
printing the contents of the current document, pane, window, or dialog. 

In addition, the File menu on the Knowledge Categories window has the 
additional commands to help you manage documents and document 
categories. 
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View menu 

The commands on the View menu let you view response time statistics for 
Knowledge Tools, set preferences, and refresh the Knowledge Document List 
pane. 

This menu contains one or more of the following commands: 

Knowledge Categories 

Opens the Knowledge Categories pane which is used to manage content 
for each problem-solving model in the knowledge base. From the 
Knowledge Categories pane, users with system administrator or knowledge 
manager rights can: 

 Create, publish, and maintain knowledge documents and knowledge 
tree documents 

 Manage the knowledge category structure to make document access 
easier 

Knowledge Report Card 

The Knowledge Report Card provides feedback to analysts, knowledge 
engineers, knowledge managers, and system administrators about which 
knowledge documents are most effective. See Knowledge Report Card for 
more information. 

Response Time Statistics 

Activates response time statistics reporting. Until you deactivate the 
function, a prompt reports Knowledge Tools response times when you 
perform an action. This command only displays when the function is not 
active. 

Preferences 

Opens the Preferences window so you can specify default preferences for 
various product components. 

Refresh 

Updates the current window to include the latest changes. 
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Window menu 

The commands on the Window menu let you manage which windows and 
dialogs display on your screen. This menu contains one or more of the 
following commands: 

Close All Popups 

Closes all currently open Knowledge Tools windows except the main 
window. 

List All Windows 

Opens the Windows window, which lists all currently open Knowledge Tools 
windows. Click a window name to move focus to the selected window. 

View Main Page 

Moves focus to the main Knowledge Tools window. This command only 
displays on windows other than the main Knowledge Tools window. 

Help menu 

This menu contains one or more of the following commands: 

Knowledge Tools Help 

Opens a window that provides online help information about the main interface 
window. The Contents, Index, and Search tabs appear on the left, allowing you 
to navigate the help system. 

Help on This Window 

Opens a window that provides online help information about the currently 
active Knowledge Tools pane or window. 

Power User Tips 

Opens a window that provides help information such as keyboard shortcuts for 
expert Knowledge Tools users. 

Screen Reader Usage 

This Help menu item opens a window explaining how to use a Screen Reader 
with Knowledge Tools. 

Support for Knowledge Tools 

Opens the CA support web site for Knowledge Tools. 
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Operations Info 

Typically, this Help menu command displays a window showing information 
about your  product installation, such as hours of operation and contact 
information. 

The information displayed on this window is contained in the file: 

$NX_ROOT/bopcfg/www/htmpl/web/analyst/about.htmpl. 

If you want to customize this file for your installation, please copy it to: 
$NX_ROOT/site/mods/www/htmpl/web/analyst/about.htmpl 

- and then make the required changes. 

About Knowledge Tools 

Opens the About window, which provides information about this version of the 
product, third party notices, technical support information, and system 
information. Click Done to close the About window. 

 

Procedures 
The following topics provide procedures for using the Keyword Search tab to 
work with knowledge documents and knowledge tree documents in the 
knowledge base. 

 

Add a Category Link to a Document 

To add a category link to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Right-click the category to link to the document, then select Link this 
Category from the shortcut menu. 

The product adds the selected category path to the Category Links list and 
to the current document. At runtime, the link displays in the document 
under the "Related Categories" heading. 
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Add a Comment to a Document You are Editing 

To add a comment to a document you are editing, follow these steps: 

1. Open the document for editing. 

2. Click the Comments tab. 

3. Click Add Comment. 

The Create New Comment window opens. 

4. Enter a brief comment in the Comment box. 

5. Click Save. 

The Create New Comment window closes and the View Comment window 
opens so you can review your comment. 

6. Do one of the following: 

 Click Close Window. 

The View Comment window closes. Select Refresh from the View menu 
to refresh the Comments tab. 

 Click Edit. 

The View Comment window closes and the Update Comment window 
opens so you can change the comment. 

 

Add a Comment to a Document You are Viewing 

To add a comment to a document you are viewing, follow these steps: 

1. View the document. 

2. Locate the Comment box on the document window. 

3. Enter your user name (that is, the ID with which you log into the product) 
in the Name box. 

4. Enter your email address in the Email box. 

5. Enter your feedback in the Comment box. 

6. Click Submit. 

The product displays an informational message and the Comment box 
becomes read-only. When you next access the document, your user ID, 
email address, and comment display under the Comments heading. 
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Add a Contact to the Notification List 

You can specify contacts to notify by email of events such as changes in a 
document's content or status. To add a contact to a document's notification 
list, follow these steps: 

1. Open the document for editing. 

2. Click the Notifications tab. 

3. Click Add Notification. 

The Create New Notification window opens. 

4. Do one of the following to define the contact to notify in the User Name 
box: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select a contact. 

 Enter one or more characters of the contact name and click  to open 
the Contact List window so you can select from entries that match the 
characters you entered. For example, if you enter "Pa", the Contact 
List window lists all contacts whose last name begins with "Pa". If only 
one entry matches the characters you typed, the product automatically 
enters that name in the field. 

5. (Optional) Enter an alternate email address to which to send notifications 
in addition to the address associated with the specified contact in the 
Alternate Email box. 

6. Click Save. 

The Create New Notification window closes and the View Notification 
window opens so you can review your settings. 

7. Do one of the following: 

 Click Close Window. 

The View Notification window closes. Select Refresh from the View 
menu to refresh the Notifications tab. 

 Click Edit. 

The View Notification window closes and the Update Notification 
window opens so you can change the user name or alternate email 
address. 
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Add a Document Link to a Document 

To add a document link to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Select the category that contains the document for which you want to add 
a link from the Categories list. 

The Documents list refreshes to display the ID numbers and titles of 
documents in the selected category. 

4. Right-click the ID number of the document to link, then select Link this 
Document from the shortcut menu. 

The product adds the selected document to the Document Links list and to 
the current document. At runtime, the link displays in the document under 
the "See Also" heading. 

 

Add a URL Link to a Document 

To add a URL link to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Type the fully-qualified URL (for example, http://www.ca.com) in the 
field provided, then click Add URL Link. 

The Attachments list refreshes to include the URL. At runtime, the link 
displays in the document under the "Attachments" heading. When a user 
clicks the link, the associated resource opens for viewing in a separate 
browser window. 
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Attach a File to a Document 

To add a file attachment to a document, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Navigate to the folder that contains the file you want to attach in the 
Repositories list. 

The Files list refreshes to display the ID numbers and names of files in the 
selected folder. 

(Optional) Right-click the ID number of a file, then select View from the 
shortcut menu to open the selected file in an appropriate program so you 
can preview it before attaching it to the document. 

4. Right-click the ID number of the file to attach, then select Attach this File 
from the shortcut menu. 

The Attachments list refreshes to list the path and name of the file 
attachment. At runtime, file attachments are typically listed under the 
"Attachments" heading in the document. When a user clicks the link to a 
file attachment, the attachment opens for viewing in an appropriate 
program. 

Check Spelling in a Document 

To check spelling in a document, follow these steps: 

1. Open the document for editing. 

2. Click the Spell Check button. 

Note: The Spelling button is only available for the Resolution section when 
the HTML Source option is selected. 

The product scans the document and opens the Spell Check Results 
window. 

 If the product encounters no unrecognized words, it closes the Spell 
Check Results window. The spelling check is complete. 

 If the product encounters unrecognized words, it displays the first 
unrecognized word in the Not in Dictionary field on the Spell Check 
Results window. Continue with Step 3. 

3. Do one of the following: 

 Enter a replacement for the unrecognized word in the Change To box. 

 Select one of the suggested replacements for the unrecognized word 
from the Suggestions list. 

 Continue with Step 4 without specifying an alternative to the 
unrecognized word. 
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4. Do one of the following: 

 Click Change to replace the current occurrence of the unrecognized 
word with the word you entered in the Change To box or selected from 
the Suggestions list. 

 Click Change All to replace all occurrences of the unrecognized word 
with the word you entered in the Change To box or selected from the 
Suggestions list. 

 Click Ignore to leave the current occurrence of the unrecognized word 
unchanged. 

 Click Ignore All to leave all occurrences of the unrecognized word 
unchanged. 

The Spell Check Results window displays the next unrecognized word. If 
there are no more unrecognized words in the document, the Spell Check 
Results window closes. 

Complete the Solution Survey for a Document 

You can use the Solution Survey box in a document to open an issue or 
request and to provide information that the product uses to calculate the 
document's FAQ rating. 

To complete the solution survey for the currently open document, follow these 
steps: 

1. (Optional) Select an option in the Solution Survey box to open an issue or 
request. 

2. Select one of the following options in the Solution Survey box to rate the 
effectiveness of the current document in addressing your problem: 

Very helpful 

Indicates that the document solved the problem or provided all of the 
information necessary to solve the problem. 

Somewhat helpful 

Indicates that the document provided most of the information 
necessary to solve the problem. 

Not helpful at all 

Indicates that the document provided very little or none of the 
information necessary to solve the problem. 

3. Click Submit. 

The document refreshes and the Solution Survey box becomes read-only. 
If you selected an option other than No in Step 1, the Create New Request 
window opens. 

322  Administrator Guide 
 



Procedures 
 

Note: If the document helped you solve your problem or answer your question 
and you do not want to complete the solution survey, click the Yes (Close) 
button. The product closes the document and adds it to the solution count 
used to calculate FAQ ratings. 

 

Create a Knowledge Document 

To create a knowledge document, follow these steps: 

1. Select New Knowledge Document from the File menu on the Keyword 
Search tab. 

The Create New Document window opens. 

Complete the fields in the Content tab as appropriate. 

2. Click Edit Resolution. 

The HTML Editor opens. 

3. Use the HTML Editor to design the body (that is, the resolution) of the 
document, then click OK to save the resolution and close the HTML Editor. 

4. (Optional) Click Spell Check to check spelling in the content you entered. 

5. Click Save. 

The Create New Document window closes and the Update Knowledge 
Document window opens. 

6. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

7. Complete the fields on the remaining tabs on the Update Knowledge 
Document window as appropriate. 

8. Click Save when you finish editing the document. 

9. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 
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Create a Knowledge Tree Document 

To create a knowledge tree document, follow these steps: 

1. Select New Knowledge Tree Document from the File menu on the Keyword 
Search tab. 

The Create New Document window opens. 

Complete the fields in the Content tab as appropriate. 

2. (Optional) Click Spell Check to check spelling in the content you entered. 

3. Click Save. 

4. The Create New Document window closes and the Update Knowledge 
Document window opens. 

5. Click Design Tree. 

The DT Builder opens. 

6. Create the knowledge tree, then click Save and Close to save the tree 
design and close the DT Builder. 

7. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

8. Complete the fields on the remaining tabs on the Update Knowledge 
Document window as appropriate. 

9. Click Save when you finish editing the document. 

10. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 
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Delete a Comment from a Document 

To delete a comment from a document, follow these steps: 

1. Open the document for editing. 

2. Click the Comments tab. 

3. Right-click the comment, then select Delete from the shortcut menu. 

An informational message displays. 

4. Click OK. 

The informational message closes and the product deletes the contact 
from the Comment list. 

 

Delete a Contact from the Notification List 

To delete a contact from a document's notification list, follow these steps: 

1. Open the document for editing. 

2. Click the Notifications tab. 

3. Right-click the user name or alternate email of the contact to delete, then 
select Delete from the shortcut menu. 

An informational message displays. 

4. Click OK. 

The informational message closes and the product deletes the contact 
from the notification list. 

 

Delete a File Attachment from a Document 

To remove an attachment from a document, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Right-click the file to remove from the document in the Attachments list, 
then select Remove from the shortcut menu. 

A confirmation message displays. 

4. Click OK. 

The confirmation message closes and the product removes the selected 
attachment from the Attachments list and the document. 
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Edit a Comment in a Document 

To edit a comment associated with a document, follow these steps: 

1. Open the document for editing. 

2. Click the Comments tab. 

3. Right-click the comment to edit, then select Edit from the shortcut menu. 

The Update Comment window opens. 

4. Edit the comment as appropriate, then click Save. 

The Update Comment window closes and the View Comment window 
opens so you can review your changes. 

5. Do one of the following: 

 Click Close Window. 

The View Comment window closes and the Comments tab refreshes. 

 Click Edit. 

The View Comment window closes and the Update Comment window 
opens so you can change the comment definition. 

Edit a Contact in the Notification List 

To edit a contact in a document's notification list, follow these steps: 

1. Open the document for editing. 

2. Click the Notifications tab. 

3. Right-click the alternate email address or the user name of the contact to 
edit in the Document Notification List, then select Edit from the shortcut 
menu. 

The Update Notification window opens. 

(Optional) Do one of the following to define the contact to notify in the 
User Name box: 

 Enter the name of the contact in "last name, first name" format. 

 Click  to open the Contact Search window so you can locate and 
select a contact. 

 Enter one or more characters of the contact name and click  to open 
the Contact List window so you can select from entries that match the 
characters you entered. For example, if you enter "Pa", the Contact 
List window lists all contacts whose last name begins with "Pa". If only 
one entry matches the characters you typed, the product automatically 
enters that name in the field. 
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4. (Optional) Enter an alternate email address to which to send notifications 
in addition to the address associated with the specified contact in the 
Alternate Email box. 

5. Click Save. 

The Update Notification window closes and the View Notification window 
opens so you can review your settings. 

6. Do one of the following: 

 Click Close Window. 

The View Notification window closes and the Notifications tab 
refreshes. 

 Click Edit. 

The View Notification window closes and the Update Notification 
window opens so you can change the user name or alternate email 
address. 

Edit a Document from the Keyword Search Tab 

To edit a document, follow these steps: 

1. (Optional) Use the Knowledge Search pane to specify criteria with which to 
search for the document to edit. 

2. Click Search. 

The Knowledge Search pane closes and the Knowledge Document List 
pane displays documents that match your search criteria. If you specified 
no search criteria, the Knowledge Document List pane lists all documents 
in the knowledge base. 

3. Right-click the title of the document to edit, then select Edit from the 
shortcut menu. 

The Update Knowledge Document window opens. 

Note: If the document has been published, you may need to unpublish it 
before making changes. 

4. (Optional) Complete or change the fields on the various tabs as 
appropriate. 

5. (Optional) Do one of the following, as appropriate: 

 For a knowledge document, click Edit Resolution on the Content tab to 
open the HTML Editor so you can modify the body (that is, the 
resolution) of the document. Click OK to save your changes and close 
the HTML Editor. 

 For a knowledge tree document, click Design Tree on the Content tab 
to open the DT Builder so you can edit the knowledge tree. Click Save 
and Close to save the tree design and close the DT Builder. 
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6. (Optional) Click Spell Check to check spelling in the content you entered. 

7. (Optional) Click User View to open the Preview window, which presents the 
document as it will appear when a user displays it. Click  to close the 
Preview window when you finish reviewing the document. 

8. Click Save when you finish editing the document. 

The product saves your changes. 

9. Do one of the following: 

 Click Forward to advance the document to the next approval process 
task. 

 Click Publish to put the document in the knowledge base and make it 
available to users with the appropriate permissions. 

 Click Cancel to close the Update Knowledge Document window and 
open the Knowledge Document Detail window. 

 

Filter the Knowledge Document List 

To specify criteria by which to determine which documents display in the 
Knowledge Document List pane, follow these steps: 

1. If the Knowledge Search pane is not displayed, click Show Filter. 

The Knowledge Search pane opens. 

2. Complete fields in the Knowledge Search pane as appropriate. 

The more criteria you specify, the fewer results will return when you apply 
the filter. 

3. Click Search. 

The Knowledge Search pane closes and the Knowledge Document List 
pane displays your filtered results. 
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Forward a Document 

When you complete an approval process task for a document that is not yet at 
the last stage of the approval process, you can forward it to the next task. 

To forward a document to the next approval process task, follow these steps: 

1. Open the document for editing. 

2. Click Forward on the Update Knowledge Document window. 

Note: The Forward button is only available if the document is not at the 
final stage of the approval process. 

The Forward Document window opens. 

3. (Optional) Specify a contact to have responsibility for the document for the 
duration of the next approval process task. Do one of the following: 

4. Select the name of the contact to assign the document to, or click  to 
open the Contact Search window so you can locate and select one. 

If you do not select an alternate assignee, the product associates the 
document with the assignee defined in the approval process template. 

5. (Optional) Enter a brief comment for the document in the Comment box. 

6. Click OK. 

A confirmation message displays. 

7. Click OK. 

The confirmation message and the Forward Document window close, and 
the product forwards the document to the next approval process task and 
assignee. 

Open a Document from the Keyword Search Tab 

To open a document from the Keyword Search tab, follow these steps: 

1. (Optional) Use the Knowledge Search pane to specify criteria with which to 
search for the document to edit. 

2. Click Search. 

The Knowledge Search pane closes and the Knowledge Document List 
pane displays documents that match your search criteria. If you specified 
no search criteria, the Knowledge Document List pane lists all documents 
in the knowledge base. 

3. Do one of the following: 

 To open the document for editing, right-click its title in the Knowledge 
Document List pane and select Edit from the shortcut menu. 
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The selected document opens in the Update Knowledge Document 
window. 

 To open the document as it will display to users at runtime, click its 
title in the Knowledge Document List pane. 

The selected document opens in the Knowledge Document window or 
the Knowledge Tree Document window, as appropriate. 

Open an Item from the Unicenter Service Desk Banner 

To open a specific item from the Unicenter Service Desk banner, follow these 
steps: 

1. Select the type of item for which to search from the Search Type list on 
the right side of the banner. 

You can select one of the following items: 

Request 

 Change 

 Issue 

 Knowledge (when Unicenter KT is installed) 

 Document by ID (when Unicenter KT is installed) 

 User by ID 

 User by Phone 

 User by Name 

2. Enter the information by which to search for the selected item in the 
Search Criterion box to the left of the Go button. 

For example: 

 If you selected Request, Change, or Issue, enter the product-defined 
identification number for the selected ticket type. 

 If you select Knowledge, enter the keyword to search for in the 
document knowledge base. 

 If you selected Document by ID, enter the product-defined document 
identification number. This feature is only available when Unicenter 
Knowledge Tools is installed. 

 If you selected User by ID, enter the name with which the user logs on 
to Knowledge Tools. 

 If you selected User by Phone, enter the user's primary telephone 
number. 

 If you selected User by Name, enter the user's name in "last name, 
first name" format. 
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3. Click Go. 

The product searches for and displays the item that matches your specified 
criterion. For example: 

 If you selected Request, Change, or Issue, the product displays the 
Detail window for the matching ticket. 

 If you selected Knowledge, the product will retrieve all documents 
containing the keyword(s) that you entered in a document list. 

 If you selected Document by ID, the product displays the Knowledge 
Document window or the Knowledge Tree Document window for the 
matching document. 

 If you selected User by ID, User by Phone, or User by Name, the 
product displays the Contact Information window for the matching 
contact. 

 

Preview a Document 

To preview a document as it will display to users at runtime so you can verify 
content and design before you publish the document, follow these steps: 

1. Do one of the following, as appropriate: 

 On the Knowledge tab or the Keyword Search tab, click on the title of 
the document to view it in the User View. 

 On the Administration tab, click the title of the document. 

The document opens Update Knowledge Document window. 

2. Click User View. 

The document opens in the Preview window. 

3. (Optional) Select Print from the Page Options menu on the right side of the 
document to open a standard Windows Print dialog so you can print the 
document. 

4. Click . 

The Preview window closes. 
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Print a Document 

To print a document, follow these steps: 

1. Do one of the following, as appropriate: 

 On the Knowledge tab or the Keyword Search tab, click the title of the 
document in the Knowledge Document List pane. 

 On the Administration tab, right-click the title of the document in the 
Knowledge Categories pane, then select User View from the shortcut 
menu. 

The document opens. 

2. Click Print on the Page Options menu. 

A standard Windows Print dialog opens. 

3. Specify the appropriate print settings, then click Print. 

The Print dialog closes and the document prints. 
 

Publish a Document 

When you are ready to add a document to the knowledge base, you can 
“publish” it from the Update Knowledge Document window. Analysts and 
knowledge engineers can publish documents when they are at the last stage of 
the approval process. Knowledge managers and system administrators can 
publish documents at any stage of the approval process. 

To publish a document, follow these steps: 

1. Open the document for editing. 

2. Click Publish. 

A confirmation message displays. 

3. Click OK. 

The confirmation message and the Update Knowledge Document window 
close, and the Knowledge Document Detail window opens. The product 
adds the document to the knowledge base. 
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Remove a Category Link from a Document 

To remove a category link, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Right-click the category link to remove in the Category Links list, then 
select Remove this Category from the shortcut menu. 

Note: You cannot remove the link to the primary category. 

The product removes the selected category link from the Category Links 
list and the document. 

 

Remove a Document Link from a Document 

To remove a document link, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

3. Right-click the document link to remove in the Document Links list, then 
select Remove this Link from the shortcut menu. 

The product removes the selected document link from the Document Links 
list and the document. 

 

Remove a URL Link from a Document 

To remove a document link, follow these steps: 

1. Open the document for editing. 

2. Click the Attachments tab. 

3. Right-click the URL link to remove in the Attachments list, then select 
Remove from the shortcut menu. 

An informational message displays. 

4. Click OK. 

The informational message closes and the product removes the selected 
document link from the Attachments list and the document. 
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Retire a Document 

When a published document reaches its expiration date, the product typically 
retires it (that is, removes the document from the knowledge base and the 
approval process). 

To retire a document before its expiration date, follow these steps: 

1. Open the document for editing. 

2. Click Unpublish. 

The Unpublish Document window opens. 

3. Click Retire This Document. 

A confirmation message displays. 

4. Click OK. 

The confirmation message and the Unpublish Document window close, and 
the product removes the document from the knowledge base and the 
workflow. 

 

Send a Document in Email 

To email the current document to one or more recipients, follow these steps: 

1. View the document. 

2. Click Email on the Page Options menu. 

The Email Document window opens. 

3. Complete the fields on the Email Document window as appropriate. 

4. Click OK. 

The Email Document window closes and the product sends your email to 
the specified recipients. 
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Set the Primary Category for a Document 

To specify a document's primary category, follow these steps: 

1. Open the document for editing. 

2. Click the Categories tab. 

The Primary Category field at the top of the tab displays the current 
primary category path. for example, TOP>Email. 

3. (Optional) If the Category Links list does not display the category you 
want to set as primary, right-click the category in the Categories list and 
select Link this Category from the shortcut menu. 

The product adds the selected category path to the Category Links list and 
to the current document. 

4. Right-click the name of the category to set as the document's primary 
category in the Category Links list, then select Set as Primary Category 
from the shortcut menu. 

A confirmation message displays. 

5. Click OK. 

The confirmation message closes, and the Primary Category field refreshes 
to display the updated information. 

Unpublish a Document 

After a document has been published, a system administrator or a user with 
full permissions can unpublish it, thereby removing it from the knowledge base 
and returning it to the approval process. 

To unpublish a document, follow these steps: 

1. Open the document for editing. 

2. Click Unpublish. 

The Unpublish Document window opens. 

3. Do one of the following, as appropriate: 

 If you are a system administrator, you can retire the document, 
thereby removing it from the knowledge base and the approval 
process. To do so, click Retire this Document. A confirmation message 
displays. 
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 If you are a system administrator and there are multiple approval 
process tasks to which the document might revert, you can select the 
task to which to assign the document, select an assignee, and 
(optionally) enter a comment: 

– Click the name of a previous task to which to assign the 
unpublished document. The Unpublish Document window 
refreshes. 

– Select the name of a contact to assign the document to from the 
Assignee list, or click  to open the Contact Search dialog so you 
can locate and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

 If you are a knowledge engineer or analyst, you can choose an 
assignee for the task and (optionally) enter a comment: 

– Select the name of a contact to assign the document to from the 
Assignee list, or click  to open the Contact Search dialog so you 
can locate and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

4. Click OK. 

The confirmation message and the Unpublish Document window close, and 
the product retires the document or assigns it to the specified task and 
owner, as appropriate. 

Unretire a Document 

When a published document reaches its expiration date, the product typically 
retires it (that is, removes the document from the knowledge base and the 
approval process). A system administrator or a user with full permissions can 
unretire or republish the document to return it to the approval process and the 
knowledge base. 

To unretire a document, follow these steps: 

1. Open the document for editing. 

2. Click Unretire. 

The Unretire Document window opens. 

3. Do one of the following, as appropriate: 

 If you are a system administrator, you can republish the document. To 
do so, click Publish this Document. A confirmation message displays. 

336  Administrator Guide 
 



Procedures 
 

 If you are a system administrator and there are multiple approval 
process tasks to which the document might revert, you can choose the 
task to which to assign the document, choose an assignee, and 
(optionally) enter a comment: 

– Click the name of a previous task to which to assign the unretired 
document. The Unretire Document window refreshes. 

– Select the name of a contact to assign as the owner for the 
document from the Assignee list, or click  to open the Assignee 
List dialog so you can search for and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

 If you are a knowledge engineer or analyst, you can choose an 
assignee for the task and (optionally) enter a comment: 

– Select the name of a contact to assign as the owner for the 
document from the Assignee list, or click  to open the Assignee 
List dialog so you can search for and select one. 

– (Optional) Enter a brief comment in the Comment box. 

– Click OK. A confirmation message displays. 

4. Click OK. 

The confirmation message and the Unretire Document window close, and 
the product assigns the document to the specified task and owner and 
returns the document to the knowledge base and the workflow. 

 

View a Document from the Knowledge Tab or the Keyword Search Tab 

To view a document as it displays to users at runtime, click its title in the 
Knowledge Document List. The selected document opens in the Knowledge 
Document window or the Knowledge Tree Document window, as appropriate. 
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View Document History 

To view the history of a document, follow these steps: 

1. Open the document for editing. 

2. Click the History tab. 

The History tab displays all actions performed on the current document, 
with the most recent actions listed first. The information on the History tab 
is read-only. 

3. (Optional) Click Show Filter to display controls with which you can specify 
criteria for filtering the list of events displayed on the History tab. When 
you specify filtering criteria and click Search, the Event List refreshes to 
display only events that match your criteria. 
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